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Before You Begin 

Installation 

The Synapse Essentials and Synapse Suite bundles include the core OpenEx TTank data server and 

several OpenEx client applications.  These are installed along with the Synapse installation. Always 

install TDT Drivers first. 

Hardware Requirements 

The OpenEx supports all System 3 processors, however RX or RZ High Performance Processors and 

Optibit PC Interface are recommended for most applications. 

See the System 3 Installation Guide for hardware installation and set-up instructions. 

OpenEx Componenets 

OpenScope is a user-customizable display and analysis application. OpenScope can display stored 

data dynamically during the course of an experiment or the entire experiment can be re-played later as 

if the data were just being acquired. 

OpenBrowser is a data export and viewing application that accesses stored data. Data can be selected, 

previewed, and exported to a standard ASCII file format or formats for Plexon's Offline Sorter or 

NeuroExplorer. 

TTank is the OpenExs database server and can store and provide data to many applications in real-

time during an experiment or offline for post-hoc analysis of data. Synapse provides acquired data and 

instructions about storage to TTank. Data is stored in files on the computer where TTank is running. 

Client applications such as OpenScope and OpenBrowser request data from the tank and present it to 

the user in the desired format.   

Tank Monitor provides quick and easy access to the TTank data server. Users can view information 

about TTank activity or perform basic maintenance such as adding or removing tanks.  

OpenController (available only with Synapse Suite) is a visual interface that allows users to control 

experimental parameters (such as filter settings, threshold settings for unit activity, and stimulus 

presentation variables) and access acquired data and parameter values in real-time. OpenController 

accesses the hardware through Synapse. 

Add on Clients are also available to round out functionality, including tools for data analysis, such as 

OpenExplorer and OpenSorter, and for data export, such as OpenBridge.  

Organization of the Supplement 

This supplement provides in-depth information about the OpenEx client applications that are a part of 

the Synapse Essentials and Synapse Suite packagaes. 



OpenEx Supplement for Synapse Users 

6 

In this supplement you will find: 

Reference Guides 

A reference is provided for each client component of OpenEx. Reference guides include step-by-step 

instructions for basic tasks, and detailed references for windows, menus, dialog boxes, and settings.  

Tips, Tricks, and Technical Information 

If you can't find it anywhere else, maybe you can find it here. The tips, tricks, and technical 

information section provides answers to commonly asked questions and revisits important OpenEx 

concepts. 

Glossary 

Defines important OpenEx terms. 
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OpenScope Reference 

In the OpenScope Reference you will find: 

A reference guide to the OpenScope Workspace and the basics of adding and modifying plots. 

Plot Types 

Step-by-step guides to creating each of the seven available plot types. 

Plot Settings Reference 

Reference covering many of the available plot settings. 
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About OpenScope 

OpenScope is a flexible display application for visualization of data stored in the DataTank format. A 

wide variety of plot types and settings provide you the ability to view the desired data in the most 

useful way. 

OpenScope provides eight customizable plot types including: pile, scroll, raster, XY, feature, chart, 

histogram, and activity. A single OpenScope file can include a variety of multi-view and single 

channel plot types to display different types of data. For even greater flexibility, several OpenScope 

windows, each viewing data from a different data tank, can be opened simultaneously. 

As part of the Synapse suite, OpenScope can be used on any computer with local or network access to 

the data tank. This provides users the ability to share information across a network. 

Getting started with OpenScope begins with selecting data. If you launch OpenScope from Synapse, 

this is done automatically based on what is selected at the time. If you launch OpenScope directly, you 

will need to browse to locate the data tank. Once the data tank has been identified plots can quickly be 

added and customized to meet a variety of research needs.  

About Adding Plots 

The Auto-Generated Multi-Plot  

An auto-generated multi-plot can be added by dragging a Block from the Block list to the grid. The 

multi-plot will contain a plot for each data event (or Store) found in the block. Users can make limited 

modifications to suit their needs. 

Individual Plots  

Individual plots can be added to the grid area by dragging a data event to the grid or by using the Add 

Plot command on the Edit menu. Either option provides several plot types to choose from. When a plot 

is added using the Add Plot command the data source must be defined. Other settings, such as Source 

Channel, Scaling, and Appearance use default values until the settings are modified. See the Plot Types 

section, page 22 for step-by-step instructions for adding specific plot types. 

Copy and Past Plots 

After one or more plots have been created they can be copied and pasted or pasted as a new type. This 

method works well when several similar plots are needed. Copied plots can be modified quickly to 

produce a complete set of plots. Multiple plots can also be copied and pasted from other existing files. 

Note: Before plots can be added a tank must be available and selected in the Tank Select window. If 

no tanks are available in the Tank Select window, you’ll need to browse for the data tank. 

About Plot Settings 

Plots can be modified using the Setup Properties dialog box. When plots are grouped, setting changes 

can be made to all plots in the group. 

Plot settings are grouped into parameter groups. The available settings are similar for each plot type. 

Settings unique to a plot type can generally be found under the Common and Behavior parameter 

groups. 
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Plot Setting Parameter Groups: 

Common The most commonly changed settings for the selected plot type. Related 

settings are grouped by color. The settings found in this group can also be 

found in the other parameter groups. There is a Common parameter group 

for each plot type: pile, scroll, histogram, raster, XY, feature, chart, and 

activity. 

Data Source Settings to identify the data source as well as to control source channel, 

sorting code, and the data source definition. Additional settings to identify 

a second data source are available in the XY Plot Data Source group. 

Multi View Settings to enable and control display of multi-channel viewing. When 

multi view is not enabled plots show results from a single channel, or sort, 

or all channels, or sorts, displayed together. 

Behavior Settings unique to the plot type. 

Pile Pile depth. 

Scroll How many sections will be displayed before scrolling. 

Histogram The event used for time, time values for refreshing, time span, and bin 

width. 

Raster The event used for time, time values for refreshing, and time span. 

XY Plot Time span to be displayed on the x-axis. 

Feature The minimum number of cloud points to be displayed. 

Chart Time span to be displayed on the x-axis. 

Activity Minimum and maximum values and corresponding color selections. 

Refresh Control Settings to control how and when the plot is refreshed. 

Scaling Settings to control plot scaling including the Auto Scale feature. Auto 

Scale can be disabled (None), set to scale at all times to ensure all values 

can be shown on the plot (Active), or set to scale only during the first 3 

seconds (Smart). 

X-Axis Setup Settings to control labels, unit name, unit factor, and offset for the x-axis. 

The X-Axis Units Factor defines the scalar of the default number of points. 

Y-Axis Setup Settings to control labels, unit name, unit factor, and offset for the y-axis. 

The Y-Axis Units Factor defines the scalar of the default number of points. 
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Appearance Settings to control the plot appearance, such as title, title position, font 

size, and multi-channel grid. 

When you title a plot, the Plot Auto Title check box must be cleared before 

the change can be applied. 

Margins Settings to control the plot margins. 

Colors Settings to control the color of chart elements. Category Coloring can be 

set to use the trace color to draw the plot (None), to automatically select 

the color for each channel (By Channel), or to automatically select the 

color for each sort code (By SortCode). 

Filtering Settings to enable or disable an FIR filter algorithm and to set parameters 

for the filter. 

For more information about plot settings, see the Plot Settings Reference, page 44.  

Using Epochs with OpenScope 

OpenScope uses epochs to organize and display data. Epochs are stored events that are associated with 

a block's timeline. 

Epochs serve two main functions: 

➢ To display data in groups so that each group is associated with a particular event. 

➢ To change or refresh the plot in response to changes in an event. 

Plot settings related to epoch events can be found in the Refresh Control and Behavior parameter 

groups in a plot's property settings dialog box. 

Refresh Control: All plots have refresh control settings that allow the user to define a refresh epoch. 

When a refresh epoch event is defined the plot will be refreshed based on the epoch value according to 

the settings in the Refresh Control parameter group. To learn more about the settings see Refresh 

Control Parameter settings, page 53. 

Behavior: Histogram and raster plots use a time reference epoch event to sort and display data and to 

determine what data is plotted according to settings in the Behavior parameter group. To learn more 

about the settings see Histogram Behavior Parameter settings or Raster Behavior Parameter settings, 

page 55. 

The Refresh Control and Behavior settings can be used independently or in combination. Because 

different epoch events can be selected for the Refresh Control and Behavior, the data can be refreshed 

by a value that is independent of the time reference epoch. This behavior allows users to develop 

several graphs each associated with a unique event. Data can then be compared across event 

parameters. 
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Raster Plots with Different Behavior Settings 

The OpenScope plots show two raster plots that differ in their behavior. The top plot displays all the 

data and the bottom plot displays only data in events that have the value 2000. The difference between 

the two plots is how the behavior settings use epoch events. In the bottom plot the behavior of the plot 

is controlled by setting limits on the range of epoch events that are displayed. 

Using Refresh Control Settings 

Refresh Control settings determine when displayed data is removed from the display. Epoch events can 

be used to control what set of data is shown on screen. For example, a pile plot can be set to remove 

old data and show only new data each time the epoch event changes. This would allow users to 

examine spike patterns that are associated with an event, such as a single stimulus event. 

To view data for a single event value at a time: 

1. In the plot's Refresh Control parameter group settings, in the Refresh Epoch Name box, 

select the desired epoch event. 

2. Enter the high and low epoch values for the range over which the plot should refresh in the 

Strobe Epoch Low Range and Strobe Epoch High Range boxes. 

3. Select the Refresh on Change check box. If Refresh on Change is not selected old data is 

removed and new data is displayed on each epoch within the boundary conditions set by 

Strobe Epoch Low Range and Strobe Epoch High Range. 

In many cases the user might want to refresh on a particular event. For example, if an experiment calls 

for ten presentations of the same stimulus; after the last stimulus, the stimulus can be updated. If the 

stimulus number is included as an epoch then the plot can be refreshed when the stimulus number 

reaches a certain value. 

Using Behavior Settings in Raster and Histogram Plots 

Behavior settings determine how data is displayed, and what data is displayed, in a plot. When an 

epoch event is defined for a Raster or Histogram plot only the data associated with the epoch's scalar 

values will be displayed. For example, if a user wants to display only signal responses that occur when 
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a particular stimulus is presented, such as a 9 kHz tone, the plot behavior can be set so that a new raster 

pattern is displayed only when this event occurs.  

Workspace Basics 

About the OpenScope Workspace 

The OpenScope workspace includes four collapsible sub-windows and a main grid area where plots 

can be displayed. A menu bar and a toolbar are provided for easy access to commands. 

 

 

 

 

Tank Select 
Window 

 

 

 

 

 

Control 
Window 

 

 
Grid Area 

 

 
Time Control Window  Messages Window 

Using the Tank Select Window 

The Tank Select window allows you to identify the data to be plotted. Before you can plot data the 

tank containing the data must be selected. Users can create plots by dragging a data event to the grid 

area. 

The window is divided into three areas: TANK, BLOCK, and EVENT. Clicking an object in any area 

selects the object. Right-clicking an area displays a shortcut menu that includes common commands. 

The TANK area lists tanks that have been added to the OpenEx 

registry. The Details view displays the name and path for each tank. 

Click a tank to select it. 
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The BLOCK area displays the blocks available in the tank selected in 

the Tank area. The Details view displays a name, date, and starting 

time, duration, stop time, owner, and memo area for each block of data 

in the selected tank. Click a block to select it. 

The EVENT area displays information about events for the block 

selected in the BLOCK area. Click an event to select it. Drag an event 

to the grid to create a plot using that data. 

The Select Tank window is accessed from the Data Source command on the File menu and can be used 

as an alternative means of selecting data for animation when the Tank Select window (Tank Navigator) 

is not displayed.  

Controlling Data Visualization 

The Control Window provides controls for animating stored data or tracking data as it is acquired. 

Both methods utilize data stored in the tank; however, tracking ensures that the most recently stored 

data is being viewed.  

A control is also provided for selecting the speed at which tank data is displayed during animation. 

Animation of the block of data selected in the Tank Select window begins at the time stamp indicated 

in the Time Control window. The animation then returns to the beginning of the block and plays in a 

loop until a new block is selected. When tracking data animation speed settings and block selection are 

not needed and are unavailable. 

 

The Animate button toggles plot animation on and off. 

The Track button toggles tracking on and off. 

The Animation Speed control scrolls right or left through a list of 

animation speed choices. 

Animation Speed choices include: 

1/8 1/4 1/2 Normal x2 x4 x8 

Using Setup Properties Dialog Boxes 

The appearance and behavior of each plot can be modified using the Setup Properties dialog box. The 

Setup Properties dialog box contains all of the customizable settings for a selected plot. 
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To open the Setup Properties dialog box for a plot: 

➢ Double-click the plot in the grid area of OpenScope. 

 

While all Setup Properties dialog boxes look and behave in a similar fashion, the settings available 

depend upon the plot being modified. 

Plot settings are grouped into parameter groups. The Setup Properties dialog box opens with the most 

commonly used settings for the selected plot displayed. 

To display the settings available in another group: 

➢ Click the Parameter Group value box and select the group from the list. 

 

Source Settings 

When settings, such as Source Name, must be set using the name of an event a  Browse button is 

located to the right of the value box. Clicking the Browse button opens an Event Selection window. 



OpenEx Supplement for Synapse Users 

16 

 

In the Event Selection window, a list of available events in the current block is displayed. Events are 

organized in rows. The EvID (event ID) or Tank Code (for secondary tags) is preceded by an icon to 

indicate the type of event, such as snippet or continuous waveform. Epoch events are marked with the 

Epoch icon .  

Using the Time Control Window 

The Time Control window provides a timeline and vertical line indicator that moves as data is 

animated. The Time Control Window can also be used to move to a particular time or event.  

 

Epochs, or indexed events, are also added to the window. The Time Control window gives a precise 

description of when data was collected. 

Timeline by Time Stamps 

 

 
The current time stamp. 

 

Moves the indicator back by time stamps. 

 

Moves the indicator forward by time stamps. 
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Scale Controls 

 
Expands scale in small steps. 

 
Shrinks scale in small steps. 

 
Expands scale in large steps. 

 
Shrinks scale in large steps. 

Timeline by Events 

 

 

The name of event displayed on corresponding line. 

 

Moves the indicator back by events. 

 

Moves the indicator forward by events. 

 

The current event value. 

Using the Select Tank Window 

The Select Tank window is accessed from the Data Source command on the File menu and can be used 

as an alternative means of selecting data for animation when the Tank Select window (Tank Navigator) 

is not displayed.  

Detailed information about the data is displayed in the three interdependent areas of the window and 

commands for each area are available from a shortcut menu (right-click). The TANK area lists tanks 

that have been added to the OpenEx registry (tanks created in Synapse are not added to the registry) or 

that have been identified by browsing. Selecting a Tank displays its blocks and events  in the 

corresponding areas. The BLOCK area also provides access to the block information entered at the 

time the block was acquired. Block notes for a selected block can be accessed using the Information 

command on the BLOCK area shortcut menu. 
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OK Button 

The OK button updates OpenScope to use the selected Tank and Block for data animation. 

Cancel Button 

The Cancel button closes the Select Tank window without updating the selected Tank and Block in 

OpenScope. 

Note: Changes such as erasing tank data or erasing blocks are NOT canceled. 

Server Button 

The Server button displays the Select Server window allowing users to view, add, remove, or test 

servers. The shortcut menu is displayed by right-clicking the SERVER area. 
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Shortcut Menus 

The following context sensitive menus are available by right-clicking the corresponding area of the 

Select Tank window. 

TANK Shortcut Menu 

Browse for Tank Browse for folder 

Create New Tank Opens the Select Tank file dialog box so that a tank can be added.  

Register Tank Adds the selected tank to the OpenEx registry. 

UnRegister tank Removes the selected tank from the OpenEx registry. The tank can 

still be used on the local machine. 

Test Tank Tests the connection to the server and opens and closes the tank file. 

Reset Tank Resets the selected tank file. This option returns the tank file to a state 

in which data can be read from or written to the tank. 

Show Full Path Toggles detail view on and off. In details view the path to the tank is 

displayed. 

Refresh Tank List Refreshes the Tank box display. 

Show Legacy Tanks Displays registered legacy format tanks in the tank list. 

Find Legacy Tanks Opens the Select Tank File dialog box and allows users to browse for 

tanks stored in the legacy format by showing files with a .tbk file 

extension. 

BLOCK Shortcut Menu 

There is no shortcut menu for the BLOCK area. 

EVENT Shortcut Menu  

Refresh Updates the EVENT area to reflect recent changes to Tank, block, or 

event information. 

Details Toggles Details view on or off. Details view includes: event ID (Store 

name), event type (such as stream, snip, or strobe), data format (such 

as float, integer, or double), nSize (number of samples per acquired 

event), Fs (sampling frequency), and the time stamp value of the first 

event. 
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The Toolbar and Menus 

The OpenScope Toolbar 

The toolbar provides buttons for the most common commands. 

 
New Opens a new OpenScope file. 

 
Open Opens an existing OpenScope file. 

 
Save Saves the current OpenScope file. 

 
Cut Cuts the selected plot or plots. 

 
Copy Copies the selected plot or plots. 

 
Paste Pastes the most recently cut or copied plot or plots. 

 
Paste New Type Pastes a new plot type from the most recently cut or copied 

plot. 

 
About Displays version and copyright information for OpenScope. 

OpenScope File Menu 

New Opens a new OpenScope file. 

Open Opens the Open dialog box so that an existing OpenScope file can be 

opened. 

Save Saves the current OpenScope file with the current name. If the file has 

not previously been saved the Save As dialog box opens. 

Save As Opens the Save As dialog box so that the OpenScope file can be saved 

with a new name. 

Data Source Opens the Tank Select dialog box. This Tank Select dialog box is similar 

to the Tank Select window and allows the user to select data, add or 

remove tanks, view block information, and erase blocks. 

Recent Files The third section of the File menu lists recently used files. Clicking a file 

name opens the file. 

Exit Closes the OpenScope application. 
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OpenScope Edit Menu 

Cut Cuts the selected plot or plots. 

Copy Copies the selected plot or plots. 

Paste Pastes the most recently cut or copied plot or plots. 

Paste Special Pastes a new plot type using the data source from the most recently cut 

or copied plot. 

Add Plot Opens a sub menu of plot types. Clicking a plot type adds a blank plot of 

that type to the grid area. 

Remove Selected 

Plot 

Removes the selected plot. 

Group Groups selected plots so that they can be labeled and moved together. 

Ungroup Ungroups plots in a selected group. 

Preferences Opens the Setup Preferences dialog box. This dialog box can be used to 

customize the appearance of the grid area. 

OpenScope Control Menu 

Animate Animates plots with data in the block selected in the Tank Select 

window. 

Track Active Animates plots with tracked data. 

Halt Stops animation or tracking. 

OpenScope View Menu 

Toolbar Toggles the toolbar between displayed and hidden. 

Status Bar Toggles the status bar between displayed and hidden. 

Tank Navigator Toggles the Tank Select window between displayed and hidden. 

Time Navigator Toggles the Time Control window between displayed and hidden. 

Control Window Toggles the Control window between displayed and hidden. 

Message Window Toggles the Message Window between displayed and hidden. 

Notes Window Opens the List of Epoch Notes window and enables data annotation. 
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Verbose Messaging Toggles verbose messaging on and off. 

Video Viewer Toggles open/close the Video Viewer window. 

Select Video Source Selects souce of video for VideoViewer. 

Customize Toolbars Opens the Customize dialog box. The Customize dialog box allows you 

to customize the appearance of the menu bar and toolbar. 

OpenScope Help Menu 

About OpenScope Displays version and copyright information for OpenScope. 

Plot Types 

Selecting Data 

Before you can plot data, the tank and block within the tank must be selected in the Tank Select 

window of OpenScope. 

To select data from a tank: 

1. Click the tank name in the TANK area of the Tank Select window. 

2. Click the block name in the BLOCK area of the Tank Select window. The events contained 

in the selected block will be displayed in the EVENT area. 

Note: Most tanks created in Synapse do not show up in the Tank Select window until you have first 

browsed to them. You can add them to the “registry” to make them appear automatically, but their can 

only be a limited number of registered tanks. 

After data is selected, plots can be created using the selected data. 

Creating the Auto-Generated Multi-Plot 

The easiest way to quickly view data is using the basic multi-plot.  

To generate the multi-plot: 

➢ Drag a Block from the Block list to the grid.  

The mulit-plot is comprised of the most common plot type for each Store in the data. 

Creating Pile Plots 

Pile plots are designed to visualize small data buffers (<500) for quick recognition of differences in 

waveform properties. Pile plots are commonly used when extracellular recordings from neurons are 

examined to separate out single-unit activity. Users can use pile plots to view time stamped buffers, 

called snippets, or synchronized buffers. In a pile plot, the Y-axis is signal intensity such as voltage or 
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dB and the X-axis is the record size in samples. Waveforms are layered over one another and centered 

along the X-axis. As the buffers pile up differences in the shape of the waveforms can easily be 

distinguished. 

To quickly create a pile plot for a single channel of the selected data: 

1. Drag a data event from the Tank select window to the grid area. 

 

The Select Plot Type box opens. 

 

 

2. Click Pile. 

 

The pile plot is added to the grid area and the Setup Properties dialog box opens with the most 

commonly used settings for the pile plot displayed. 

 

Settings groups include: 

Common - pg. 58                               

Data Source - pg. 59 

Behavior - pg. 55 

Multi View - pg. 53 

Refresh Control - pg. 53 

Scaling - pg. 54 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54                              

Colors - pg. 52                             

Filtering - pg. 53 
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3. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

4. In the Source Channel box, enter the desired channel number.  

5. In the Pile Depth box, enter the minimum number of wave forms to be displayed. The plot 

will be refreshed when the number of traces reaches twice the minimum. 

6. Click OK. 

 

The pile plot is configured for viewing a single channel of data. The plot can be positioned 

and resized using the mouse. When you animate or track data the plot will look similar to this: 

 

 

After a single channel pile plot has been created, the settings can be quickly modified for multi-

channel viewing.  

To modify a pile plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Source Channel box, enter 0 to ensure that all channels are available for viewing. 

3. Select the Multi View Enabled check box. 

4. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

5. In the Num Columns box, enter the number of columns to display. 

6. Click OK.  

 

When you animate or track data the plot will look similar to this: 

 

 

After a multi-channel pile plot has been created, the settings can be quickly modified for viewing a 

range of channels.  

To modify a pile plot to view a range of channels: 

1. Double-click the plot to display the Setup Properties dialog box. 
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2. Enter the total number of channels of data to be viewed in the Num Views box. 

3. By default channels will be displayed beginning with channel 1. To display multiple channels 

beginning with another channel, modify the index offset. 

4. To modify the index offset value, click the Parameter Group box, and click Multi View. 

5. In the View Index Offset box, enter the number of channels to offset. 

 

 
 

For example, to begin viewing from channel 6, enter an Index Offset value of 5. The plot will 

begin with channel 6 and display the next sequential channels to equal the number entered in 

the Num Views box. 

6. Click OK. 

 

When you animate or track data the plot will look similar to this: 

 

 

Creating Scroll Plots 

Scroll plots provide a useful means of looking at continuous data. Data is presented in segments called 

scrolls. Looking at one scroll after another gives an effect similar to an oscilloscope or EKG. In a scroll 

plot the Y-axis is voltage and the X-axis is the record size. 

To quickly create a scroll plot for single channel of the selected data: 

1. Drag a data event from the Tank Select window to the grid area. 

 

The Select Plot Type box opens. 
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2. Click Scroll. 

3. The scroll plot is added to the grid area and the Setup Properties dialog box opens with the 

most commonly used settings for the scroll plot displayed. 

 

Settings groups include: 

Common - pg. 58                            

Data Source - pg. 59 

Behavior - pg. 56 

Multi View - pg. 53 

Refresh Control - pg. 53 

Scaling - pg. 54 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54                               

Colors - pg. 52                              

4. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

5. In the Source Channel box, enter the desired channel number.  

6. Enter the desired number of scrolls, or data segments, to be displayed. 

7. Click OK. 
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The scroll plot is configured for viewing a single channel. The plot can be positioned and 

resized using the mouse. When you animate or track data the plot will look something like 

this: 

 

 

After a single channel scroll plot has been created, the settings can be quickly modified for multi-

channel viewing.  

To modify a scroll plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Source Channel box, enter 0 to ensure that all channels are available for viewing. 

3. Enter the desired number of scrolls, or data segments, to be displayed. 

4. Select the Multi View Enabled check box. 

5. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

6. In the Num Columns box, enter the number of columns to display. Leave this value set to 1 

to see one channel per row. 

7. Click OK. 

After a multi-channel scroll plot has been created, the settings can be quickly modified for viewing a 

range of channels.  

To modify a scroll plot to view a range of channels: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Num Views box, enter the total number of channels of data to be viewed. 

 

By default channels will be displayed beginning with channel 1. To display multiple channels 

beginning with another channel, modify the index offset. 

3. To modify the index offset value, click the Parameter Group box, and click Multi View. 

4. In the View Index Offset box, enter the number of channels to offset. 

 

For example, to begin viewing from channel 5, enter an Index Offset value of 4. The plot will 

begin with channel 5 and display the next sequential channels to equal the number entered in 

the Num Views box. 

5. Click OK. 
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When you animate or track data the plot will look like similar to this: 

 

 

Creating Histograms 

Histograms use time stamped values from a variety of data Stores for graphic presentation. The most 

common of these are snippets, but lists and even scalars can be included as long as a time stamp is part 

of the acquired value. Users set up the bin size (size of time divisions for sorting the time stamps) and 

the parameters for refreshing the plot. 

A common plot in neurophysiology is the peristimulus histogram, or PSTH. This plot shows the 

distribution of spike times after a stimulus has been presented. Another plot might show spike times 

for a particular epoch event such as a signal of particular intensity and a final plot might compare spike 

patterns across channels over the entire experiment. 

Histogram plots in OpenScope show the distribution of waveform time stamps over a set time span. 

Histogram plots can show additive changes over a set time scale or they can be refreshed over a set 

range. In addition, the plots can refresh (start from zero) at each epoch or on changes in an epoch (such 

as a change in the intensity of a stimulus). 

This view provides a good visual representation of how waveform time stamps are distributed from the 

start of a stimulus. 

To quickly create a histogram plot of for a single channel of the selected data: 

1. Drag a data event from the Tank Select window to the grid area. The Select Plot Type box 

opens. 
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2. Click Histogram. 

 

The histogram plot is added to the grid area and the Setup Properties dialog box opens with 

the most commonly used settings for the histogram plot displayed. 

 

Settings groups include: 

Common - pg. 57                           

Data Source - pg. 59 

Behavior - pg. 55 

Multi View - pg. 53 

Refresh Control - pg. 53 

Scaling - pg. 54 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54                               

Colors - pg. 52                              

3. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

4. In the Source Channel box, enter the desired channel number. Channel selection is affected 

by the Index value on the Devices page and by the Store Chan Offset value on the Stores 

page. 

5. In the TimeRef Epoc Name box, select an epoch, or indexed, event. This must be selected to 

update the histogram. 

6. In the Time Span box, enter the desired time span. This might be set to the length of a 

stimulus, for example. In the Time Span box the time span can be fixed by the user or left set 

to 0 to respect the TRef duration. If the epoch is a stimulus this will allow you to see how 

waveform times are distributed from the start of the stimulus. 

7. In the Bin Width box, enter the bin width. The bin width should relate to the distribution 

pattern of the time stamped signals. For a PSTH this might mean that the bin width should be 

a couple of milliseconds, for patterns of evoked potentials it could be much larger. 

8. Click OK. 

The histogram plot is configured for viewing a single channel. The plot can be positioned and resized 

using the mouse. When you animate or track data the plot will look similar to this: 

 

 



OpenEx Supplement for Synapse Users 

30 

After a single channel histogram plot has been created, the settings can be quickly modified for multi-

channel viewing.  

To modify a histogram plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. Enter 0 in the Source Channel box to ensure that all channels are available for viewing. 

3. Select the Multi View Enabled check box. 

4. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

5. In the Num Columns box, enter the number of columns to display. Depending on the design 

of your experiment you might want to view a pattern that is representative of the physical or 

logical distribution of the channels. For example, if you had electrodes placed in a 4 x 4 grid 

around the head then it would be useful to see that pattern in OpenScope. Similarly, if you had 

electrodes in a linear pattern you might want to have either 1 column or 16 columns. 

6. Click OK. 

 

When you animate or track data the plot will look similar to this: 

 

 

After a multi-channel histogram plot has been created, the settings can be quickly modified for viewing 

a range of channels.  

To modify a histogram plot to view a range of channels: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Num Views box, enter the total number of channels of data to be viewed. 

 

By default channels will be displayed beginning with channel 1. To display multiple channels 

beginning with another channel, modify the index offset. 

3. To modify the index offset value, click the Parameter Group box, and click Multi View. 

4. In the View Index Offset box, enter the number of channels to offset. 
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For example, to begin viewing from channel 5, enter an Index Offset value of 4. The plot will 

begin with channel 5 and display the next sequential channels to equal the number entered in 

the Num Views box. 

5. Click OK. 

After a multi channel histogram plot has been created, the settings can be quickly modified to view by 

sort code.  

To modify a multi-channel histogram plot to view by sort code: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. Click the Parameter Group box, and click Multi View. 

3. In the View By box, select Sort Code from the drop down list. 

4. Update the Num Views and View Index Offset values as needed. 

5. Click OK. 

Creating Raster Plots 

Raster plots provide a useful means of looking at time stamped values or waveforms that are not 

continuous, such as snippets. The time stamps of the snippets are represented by dots plotted in rows. 

Each row represents an epoch, or indexed, event. In a raster plot the Y-axis is indexed event values and 

the X-axis is time stamp values. 

This view provides a good visual representation of when snippets occurred for an indexed event. 

Raster plots are an excellent way of detecting subtle changes in the timing of waveforms across 

channels. 

To quickly create a raster plot for a single channel of the selected data: 

1. Drag a data event from the Tank Select window to the grid area.  

 

The Select Plot Type box opens. 
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2. Click Raster. 

3. The raster plot is added to the grid area and the Setup Properties dialog box opens with the 

most commonly used settings for the raster plot displayed. 

 

Settings groups include: 

Common - pg. 58                           

Data Source - pg. 59 

Behavior - pg. 55 

Multi View - pg. 53 

Refresh Control - pg. 53 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54                               

Colors - pg. 52                              

4. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

5. In the Source Channel box, enter the desired channel number.  

6. In the Raster Rows box, enter the desired number of rows to be displayed. 

7. In the TimeRef Epoc Name box, select an epoch, or indexed, event. This will define the Y-

Axis. 
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8. In the Time Span box, enter a time stamp value for the maximum value of the X-axis. This 

value should usually be the time span of the indexed event, according to the time stamp. 

9. Click OK. 

The raster plot is configured for viewing a single channel. The plot can be positioned and resized using 

the mouse. When you animate or track data the plot will look like this: 

 

To modify a raster plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Source Channel box, enter 0 to ensure that all channels are available for viewing. 

3. In the Raster Rows box, enter the desired number of rows to be displayed. Enter 1 to view 

one row per channel for a clear comparison across channels for a single event value. 

4. Select the Multi View Enabled check box. 

5. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

6. In the Num Columns box, enter the number of columns to display. 

7. Click OK. 

To modify a raster plot to view a range of channels: 

1. Double-click the plot to display the Setup Plot dialog box. 

2. In the Num Views box, enter the total number of channels of data to be viewed. 

3. By default channels will be displayed beginning with channel 1. To display multiple channels 

beginning with another channel, modify the index offset. 

4. To modify the index offset value, click the Parameter Group box, and click Multi View. 

5. In the View Index Offset box, enter the number of channels to offset. 

6. For example, to begin viewing from channel 5, enter an Index Offset value of 4. The plot will 

begin with channel 5 and display the next sequential channels to equal the number entered in 

the Num Views box. 

7. Click OK. 

To modify a multi-channel raster plot to view by sort code: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. Click the Parameter Group box, and click Multi View. 

3. In the View By box, select Sort Code from the drop down list. 
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4. Update the Num Views and View Index Offset values as needed. 

5. Click OK. 

Creating XY Plots 

XY plots provide a useful means of looking changes in two continuously varying values. In 

OpenScope, the Y-axis and the X-axis are selected from available data events. The XY plot can be 

used to plot positional information such as XY coordinates for an animal moving in a tank or it can be 

used to plot data from an eye or head tracker. 

This type of plot can also be used when the study subject needs to be in a specific position for accurate 

data acquisition. The XY plot can help the user to quickly determine if there were any significant 

changes in the subject’s position such as the head position relative to the position of a sound or visual 

stimulus. 

To quickly create an XY plot for a single channel of the selected data: 

1. Drag a data event from the Tank Select window to the grid area. 

 

The Select Plot Type box opens. 

 

 

2. Click XY.  

 

The XY plot is added to the grid area and the Setup Properties dialog box opens with the most 

commonly used settings for the feature plot displayed. 
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Settings groups include: 

Common - pg. 59                            

Data Source - pg. 59 

Behavior - pg. 56 

Multi View - pg. 53                      

Scaling - pg. 54 

Refresh Control - pg. 53 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54                            

Colors - pg. 52                              

3. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

4. In the Source Channel box, enter the desired channel number.  

5. Click the Source Name X-Axis box to select the desired data event for the X-axis. An event 

selection box opens. 

6. Click the desired data event to select it, and click OK. 

7. In the Cloud Points box, enter the minimum number of points to be displayed. The plot will 

refresh when the plot reaches twice the value set. 

8. Click OK. 

The XY plot is configured for viewing a single channel of data. The plot can be positioned and resized 

using the mouse. 

After a single channel XY plot has been created, the settings can be quickly modified for multi-channel 

viewing.  

To modify a XY plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Source Channel box, enter 0 to ensure that all channels are available for viewing. 

3. Select the Multi View Enabled check box. 

4. In the Num Views box, enter the total number of channels of data to be viewed. 

5. By default channels will be displayed beginning with channel 1.To display multiple channels 

beginning with another channel, modify the index offset. 

6. To modify the index offset value, click the Parameter Group value box, and click Multi 

View. 

7. In the View Index Offset box, enter the number of channels to offset. 

8. For example, to begin viewing from channel 5, enter an Index Offset value of 4. The plot will 

begin with channel 5 and display the next sequential channels to equal the number entered in 

the Num Views box. 

9. Click OK. 
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Creating Feature Plots 

Feature plots compare two waveform properties, such as the first and second peak voltages of two 

candidate spikes. They are ideal for determining how many unique waveforms are present in a signal. 

In OpenScope the feature plot has been designed for examining patterns of spike waveforms. The plot 

works best when viewing time stamped waveforms that are not continuous. In OpenEx this type of 

data is also called snippet data. Although other waveforms can be viewed, plotting complex waveforms 

with many points will require intensive amounts of computer time. 

While the default feature of the Y-axis is the voltage of the second peak and the X-axis is the voltage 

of the first peak, the X-axis and Y-axis features can be selected from a drop down list in the Setup 

Properties dialog box. By generating multiple feature plots, each with different XY characteristics, it is 

possible to differentiate several spike types. This information can then be used to do offline or online 

spike sorting. 

To quickly create a feature plot for a single channel of the selected data: 

1. Drag a data event from the Tank Select window to the grid area. 

 

The Select Plot Type box opens. 

 

 

2. Click Feature.  

 

The feature plot is added to the grid area and the Setup Properties dialog box opens with the 

most commonly used settings for the feature plot displayed. 
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Settings groups include: 

Common - pg. 57                            

Data Source - pg. 59 

Behavior - pg. 55                             

Multi View - pg. 53                    

Refresh Control - pg. 53                     

Scaling - pg. 54 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54                              

Colors - pg. 52                                 

Filtering - pg. 53                   

3. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

4. In the Source Channel box, enter the desired channel number.  

5. In the Cloud Points box, enter the minimum number of points to be displayed. The plot will 

refresh when the plot reaches twice the value set. 

6. If desired, select an X-axis and/or Y-axis feature from the drop down menus in the 

corresponding value box. Select from Total Amplitude, Peak 1, Peak 2, Peak to Peak Time, or 

Area. 

7. By default, Category Coloring is set to By SortCode and a different color will automatically 

be assigned to each sort code. When data is not associated with a sort code it will be assigned 

a gray color. If sort codes are not present in the data, change this setting to None to display 

data points in a brighter color for easier viewing. 

8. Click OK. 

The feature plot is configured for viewing a single channel of data. The plot can be positioned and 

resized using the mouse. 

After a single channel feature plot has been created, the settings can be quickly modified for multi-

channel viewing.  

To modify a feature plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Source Channel box, enter 0 to ensure that all channels are available for viewing. 

3. Select the Multi View Enabled check box. 

4. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

5. In the Num Columns box, enter the number of columns to display. 

6. By default, Category Coloring is set to By SortCode and a different color will automatically 

be assigned to each sort code. When data is not associated with a sort code it will be assigned 

a gray color. If sort codes are not present in the data, change this setting to By Channel to 

display data points in brighter colors for easier viewing. 

7. Click OK. 
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After a multi channel feature plot has been created, the settings can be quickly modified for viewing a 

range of channels.  

To modify a scroll plot to view a range of channels: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Num Views box, enter the total number of channels of data to be viewed. 

 

By default channels will be displayed beginning with channel 1.To display multiple channels 

beginning with another channel, modify the index offset. 

3. To modify the index offset value, click the Parameter Group value box, and click Multi 

View. 

4. In the View Index Offset box, enter the number of channels to offset. 

 

 
 

For example, to begin viewing from channel 5, enter an Index Offset value of 4. The plot will 

begin with channel 5 and display the next sequential channels to equal the number entered in 

the Num Views box. 

5. Click OK. 

Creating Chart Plots 

Chart plots are an excellent way of graphing time stamped waveform data such as spike snippets. 

Unlike raster plots that only show the position of the time stamp over a narrow range in the block, the 

chart plot shows the snippet waveform and its exact position in the block of data. 

In a chart plot the Y-axis is voltage and the X-axis is time in seconds. When the scale of the X-axis is 

contracted the position of a snippet along the X-axis clearly identifies when in time the snippets 

occurred and patterns of occurrence over time are emphasized. As the scale of the X-axis is expanded 

the shape of the waveform becomes more visible. 

To quickly create a chart plot for single channel of the selected data: 

1. Drag a data event from the Tank Select window to the grid area. 

 

The Select Plot Type box opens. 
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2. Click Chart. 

 

The chart plot is added to the grid area and the Setup Properties dialog box opens with the 

most commonly used settings for the chart plot displayed. 

 

Settings groups include: 

Common - pg. 57                            

Data Source - pg. 59 

Behavior - pg. 55                             

Multi View - pg. 53                    

Refresh Control - pg. 53                     

Scaling - pg. 54 

X-Axis Setup - pg. 54 

Y-Axis Setup - pg. 54 

Colors - pg. 52                                            

3. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

4. In the Source Channel box, enter the desired channel number.  

5. Enter the desired Time Span in seconds, to be displayed on the X-axis. 

6. Click OK. 

The chart plot is configured for viewing a single channel. The plot can be positioned and resized using 

the mouse. When you animate or track data the plot will look like this: 
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To quickly expand the X-axis scale and view a snippet waveform, hold down the SHIFT key, point to 

the snippet, and drag to the right. 

After a single channel chart plot has been created, the settings can be quickly modified for multi-

channel viewing.  

To modify a chart plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. In the Source Channel box, enter 0 to ensure that all channels are available for viewing. 

3. Enter the desired Time Span in second, to be displayed on the X-axis. 

 

Selecting a shorter time span will improve animation performance for multiple channels. 

When viewing the chart, the time span can be shortened or expanded by pressing and holding 

the SHIFT key, and dragging right or left with the mouse. 

4. Select the Multi View Enabled check box. 

5. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

6. In the Num Columns box, enter the number of columns to display. Leave this value set to 1 

to see one channel per row. 

7. Click OK. 

When you animate or track data the plot will look like similar to this: 

 

After a multi-channel chart plot has been created, the settings can be quickly modified for viewing a 

range of channels.  

To modify a chart plot to view a range of channels: 

1. Double-click the plot to display the Setup Properties dialog box. 
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2. In the Num Views box, enter the total number of channels of data to be viewed. 

3. By default channels will be displayed beginning with channel 1. To display multiple channels 

beginning with another channel, modify the index offset.  

 

To modify the index offset value, click the Parameter Group box, and click Multi View. 

4. In the View Index Offset box, enter the number of channels to offset. 

 

For example, to begin viewing from channel 5, enter an Index Offset value of 4. The plot will 

begin with channel 5 and display the next sequential channels to equal the number entered in 

the Num Views box. 

5. Click OK. 

Creating Activity Plots 

Activity plots are used to view the amount of spike (or other) activity occurring on a given channel or 

group of channels. Activity plots make it easy to view spike counts or to compare spike rates between 

acquisition channels. Activity plots use time stamped values from a variety of data Stores for graphic 

presentation. The most common of these are snippets, but lists and even buffers can be included as 

long as a time stamp is part of the acquired value. Users define the minimum and maximum value to be 

displayed, assign a color to minimum and maximum, and choose a parameter for refreshing the plot. 

As the plot is animated the color of an activity cell varies in intensity across a range corresponding to 

the minimum and maximum defined values. 

To quickly create an activity plot for combined data for all channels of the selected data: 

1. Drag a data event from the Tank Select window to the grid area. 

 

The Select Plot Type box opens. 

 

 

2. Click Activity. 

 

The activity plot is added to the grid area and the Setup Properties dialog box opens with the 

most commonly used settings for the activity plot displayed. 
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Settings groups include: 

Common - pg. 56                          

Data Source - pg. 59 

Behavior - pg. 54                             

Multi View - pg. 53                    

Refresh Control - pg. 53                      

Colors - pg. 52                                          

3. Related settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

4. In the Refresh Epoch Name box, select an epoch, or indexed, event. This must be selected to 

update the plot. 

5. In the Max Value box enter a number at least as large as the maximum activity (number of 

spikes) anticipated. 

6. Click OK. 

The Activity plot is configured for viewing combined data for all channels. The plot can be positioned 

and resized using the mouse. When you animate or track data the plot will look similar to this: 

 

Combined Data Activity Plot 
with Activity Near Minimum Value 

  

Combined Data Activity Plot 
with Activity Near Maximum Value 

After a combined data activity plot has been created, the settings can be quickly modified for multi-

channel viewing.  

To modify an activity plot to view multiple channels of data: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. Select the Multi View Enabled check box. 
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3. In the Num Views box, enter the total number of views required to see all available channels 

of data in the multi view. This number will typically be the number of channels of data 

acquired. By default channels will be displayed beginning with channel 1. 

4. In the Num Columns box, enter the number of columns to display. Depending on the design 

of your experiment you might want to view a pattern that is representative of the physical or 

logical distribution of the channels. For example, if you had electrodes placed in a 4 x 4 grid 

around the head then it would be useful to see that pattern in OpenScope. Similarly, if you had 

electrodes in a linear pattern you might want to have either 1 column or 16 columns. 

5. Click OK. 

When you animate or track data the plot will look similar to this: 

 

After a multi channel activity plot has been created, settings can be modified to view by sort code.  

To modify a multi-channel activity plot to view by sort code: 

1. Double-click the plot to display the Setup Properties dialog box. 

2. Click the Parameter Group box, and click Multi View. 

3. In the View By box, select Sort Code from the drop down list. 

4. Update the Num Views and View Index Offset values as needed. 

5. Click OK. 

Using the Video Viewer 

The Video Viewer provides synched playback of AVI files while reviewing data in OpenScope. 

To add the viewer to the OpenScope display: 

➢ Click the View menu then click Video Viewer.  

When you select a new block that includes an epoch store with the name VidN (where N is any number 

0-9) or CamN, OpenEx attempts to find a properly named AVI in the block folder. The AVI file name 

must include the correct block name and store name, e.g. DemoTank2_Block-1_Vid0.avi or 

DemoTank2_Block-1_Cam0.avi. This is the default naming scheme for AVIs recorded on the RV2 or 

USB Camera HAL in Synapse. If a matching AVI is not found locally, OpenScope will attempt to find 

it on an RV2 on the network. When AVI files are found, OpenScope will open them in (up to 8) video 

viewer windows, one for each video found.  A subtitle file containing video timestamps is also opened 

and timestamps are overlayed on the video window. 

The example window below shows a video recorded for demonstration purposes. The video and plot 

are synchronized with the timeline during animation. 
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Note for RV2 users: The AVIs should be stored with the rest of their respective block files whenever 

possible. This allows the RV2 to continue recording video data while the user reviews previously 

recorded AVIs. It also removes any network communication delays. The RV2 file structure makes it 

easy to merge entire tanks of AVIs directly into the locally stored tank. 

When the AVI is not found locally, the Select Video Source dialog shows all available RV2s on the 

local network. You can choose a specific RV2 and check the ‘Use as default and do not show this 

dialog’ option so that RV2 is always used for network playback.   

To change the default RV2: 

➢ Click the View menu then click Select Video Source. 

Epoch Annotation 

Epoch Annotation allows user to add notes to a block of data. An epoch store is selected for data 

marking and storage and an index integer is associated with each note text string. When a note is 

placed in the data, the corresponding integer value is associated with the timestamp for the 

corresponding epoch event and is stored with the epoch data in the tank. The list of notes and the text 

string for each are automatically saved into a *.tnt file in the block directory.  

The annotation tools are part of OpenScope’s multi-plot—the only plot type that supports annotation. 

The plot is comprised of the most common plot type for each data Store. The multi-plot must be added 

to the workspace and data must be loaded to the plot before the annotation tools are available.  

To generate the multi-plot: 

➢ Drag a Block from the Block list to the grid.  
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The multi-plot is generated and may be viewed by manually advancing the data or by 

animating the data.  

To enter annotation mode: 

➢ Click the View menu and click Notes Window.  

 

 
 

 
 

The List of Epoch Notes window opens.  

 

The List of Epoch Notes window is a floating window and can be moved as needed. It must remain 

open while working with the animation tools. When the window is open and data has been loaded to 

the plot, a shortcut menu (right-click) is available in the data area of an epoch store in the plot.  
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To load data to the plot: 

➢ Click the Animate button then click the button again to stop animation.  

 

If there is only one epoch store in the dataset, a red arrow appears next to the epoch’s name in 

the plot.  

The Tick epoch, a simple timing marker, is present in all datasets and is a convenient epoch for 

annotation.   

If there is more than one epoch in the dataset, the epoch to be used for annotation can be selected from 

the shortcut menu. 

To specify the note epoch: 

1. Right-click the data area of the plot for the desired epoch.  

 

 

2. Click Set Note Epoch on the shortcut menu. 

 

 
 

A red arrow appears next to the epoch’s name in the plot. 

Viewing Data to be Annotated 

Users can preview or view the data to be annotated either by using OpenScope tools to animate the 

data or by stepping through the data one timespan (visible screen) at a time.   

To step through the data: 

➢ Press the right arrow key on the keyboard to jump forward in the data one full timespan.  

➢ Press the left arrow key on the keyboard to jump back in the data one full timespan.  

This technique works in both manual or animated mode. 

Creating a Note 

New notes strings can be created in the List of Epoch Notes window or as a note is set directly in the 

data plot.  
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Note: The Note Epoch must be specified before creating notes, see above. 

If one or more of the notes to be used is known, they can be created before the annotation begins.  

To create a new note without setting a note in the data: 

1. In the List of Epoch Notes window, click the Add button or double-click the blank note field. 

an Epoch Notes: Add new note window opens. 

2. In the Note field, type a text string.  

 

 
 

The note string can be multi-line. After the note is added, the line breaks are represented with 

a pipe ‘|’ character in the Notes description and in the corresponding text file.  

3. Click the Add button.  

 

 
 

An Index integer is associated with the new note string and it is added to the list of epoch notes. The 

text string is automatically appended to a *.tnt text file in the block directory.  

To create a new note while setting the note in the data: 

Note: Data must be loaded to the plot before the annotation shortcut menu is available.  

1. Right-click to the right of the desired location in the epoch data and click Set Note on the 

shortcut menu. Note: The annotation algorithm locates the most recent event (looking 

backward in time) and associates the note with it. 
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2. In the Note field, type a text string.   

 

 

3. Click the Set button. 

 

 
 

An Index integer is associated with the new note and set in the data at the time/position of the 

most recent instance of the Epoch event. The integer is displayed a white numeral above the 

data on the right side of the time bar and its value is stored with the epoch data in the tank.  

 

 
 

The newly added note is highlighted in red in the List of Epoch Notes window and the text 

string for the new note it is appended to a *.tnt text file in the block directory.  

 

Users can continue to add notes in the List of Epoch Notes window until all the desired notes 

have been added and/or add notes on-the-fly using the annotation shortcut menu.  

To set an existing Note Index in the data. 

1. Right-click to the right of the desired location in the epoch data and click Set Note on the 

shortcut menu.  
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2. In the Epoch Notes: set note window, select an integer from the Note Index drop-down menu. 

 

 

3. Click the Set button. 

4. Users can step through the data using the right and left arrow keys, to continue annotating, or 

use OpenScope animation. 

Rapid Annotation With Keypad  

Users can quickly annotate data by pressing number keys (1-9) either while the plot is animating or 

while frozen.  The arrow keys can be used to move back and forth on the timeline in both modes.  A 

time delay can be set so that notes will be set at some time before the position of the white vertical 

time bar.  The red arrow at the top of the plot indicates the timestamp relative to the solid white bar 

where a new note will be recorded when the keypad number is pressed. 

Warning!: New notes added will overwrite any note already set at the same event timestamp. 

To set a note delay: 

➢ Right-click the data at the timestamp where you want the top red arrow to display and choose 

Set Note Delay to move the arrow to that location.  Once the delay is set, it will be used for all 

notes set during animation. 

 

 

➢   

To annotate: 

Before annotating data, ensure that the List of Epoch Notes window is open, the Note Epoch has been 

set, and the necessary notes have been created. 

1. In the List of Epoch Notes window, select the Record Mode box at the top left of the 

window.  
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2. Click the Animate button in the OpenScope controls to animate the data 

 

or 

 

3. Press the arrow keys to move to the desired location.   

4. Press the number key corresponding to the integer Note Index for the desired note.   

5. The note is added, indicated by a white number in the display and that note is highlighted red 

in the notes list. 

6. Continue adding notes until annotation is complete. 

When in animation mode, users can use OpenScope controls to speed-up or stop animation. 

Important: It is recommended that users do NOT use the plot’s Play and Pause button during 

annotation. The Pause button freezes the plot, but animation continues in the background. Pressing the 

Play button re-starts the plot at the current point according to the animation, NOT where the plot was 

frozen. If more than one time span of data has passed, this can lead to overlooking some sections of the 

data. 

Reviewing and/or Revising Annotated Data 

Users can review and revise data as needed. There are a few extra tools that can help in this process.  

To locate existing notes: 

➢ Note that pre-existing notes are highlighted in blue in the List of Epochs Notes window.  

 

This is true when stepping through the data or animating data. It can speed up a search for 

existing notes or be useful in avoiding overwriting existing notes during animation. 

To remove a single note: 

➢ Right-click the desired note marker in the plot and click Remove Note on the shortcut menu.  

To remove all notes in the block: 

➢ Right-click the data area for the Note Epoch and click Remove Block Notes on the shortcut 

menu.  
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To quickly set the note epoch for a previously annotated block: 

➢ Click the Find First Note button in the List of Epoch Notes window. OpenSorter searches the 

current block for the first note, and then performs ‘Set Note Epoch’ on that epoch event. 

Useful for reviewing previously annotated when epoch used for sorting is not known. 

To save a list of all note indices in the block, along with their time stamp, to a text file: 

➢ Click the Save button in the List of Epoch Notes window.  The data is saved to a text file 

(*.nxt) that can be loaded back into the block later, if necessary. 

 

 

To load a previously saved (*.nxt)  list of notes into the block: 

1. Click the Load button in the List of Epoch Notes window. The Load saved notes window 

opens.  

2. Browse to and load an existing .nxt file.  

Warning! This overwrites the current note data for the block. 

To import an existing Notes list: 

➢ Click the Import button in the List of Epoch Notes window. The Import tnt file from window 

is opened. Users can browse to and load an existing *.tnt file from another block. The list of 

note strings are imported into the current block list. This makes it easier to have a consistent 

note list across multiple blocks. 

Filling in Notes 

When a note is added, it marks a single event or a change in state at a particular time. When users want 

every event to be marked with the current state (such as asleep or awake) the Fill In option can greatly 

speed up annotation. It allows users to add notes when the state changes, then go back and fill in every 

subsequent event, until the next state change, with that note index. This is useful when the user wants 

all epoch events—from the time of the note until the next change—to be returned when later filtering 

the data. 

To fill in (add notes to all events in the store): 

1. Begin with a block of data that has the state changes annotated. It is a good idea to back-up 

the notes data at this point, in case you need to revert to this point later. Click the Save button 

in the List of Epochs Notes window to save the notes.  
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2. Click the Fill In button in the List of Epochs Notes window.  

 

 
 

A note is added to any epoch event that does not already have a note associated with it. For 

each event, the previous (or most recent) note index is used.  

Plot Settings Reference 

About the Plot Settings Reference 

The Plot Settings Reference corresponds to a parameter group in the properties dialog box. 

How To Find These Settings 

Settings in this reference are available in the properties dialog boxes. 

To open the properties dialog box for a plot: 

➢ Double-click the plot in the grid area of OpenScope. 

Colors Parameter Group 

Category Coloring: Set how the trace colors will be applied. 

➢ None: The color set in the Trace Color value box will be applied to all traces. 

➢ By Channel: The color of traces will be automatically assigned by channel. 

➢ By Sortcode: The color of traces will be automatically assigned by sortcode. 

Trace (or Dot) Color: Select the trace color from a color palette. This selected color is only used if 

Category Coloring is set to None. 

Plot Border Color: Select the plot border color from a color palette. 

Foreground Color: Select the foreground color from a color palette. 
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Background Color: Select the trace color from a color palette. 

Font Color: Select the font color from a color palette. 

MultiChannel Grid Color: Select the multi-channel grid color from a color palette. 

Filtering Parameter Group 

Filter On: Select the check box to enable an FIR filter algorithm using FIR parameters provided in 

CoefB0-B4. Clear the check box to disable the filter. 

CoefB0 - 4: Type a coefficient. 

Multi View Parameter Group 

Multi-View Enabled: Select the check box to view each channel, or sort code, of data in an individual 

plot. 

Num Views: Set the number of channels or sorts to view in a multi-view plot. If data contains more 

than 16 channels or sorts the value must be increased to show all data. 

Num Columns: Set the number of columns in which multi-view plots are arranged. 

View By: Channel or Sort. Sorts are generated in the RPvdsEx circuit. 

View Index Offset: Starting channel or sort is the View Index Offset value +1. 

For example: To begin viewing data with channel 3, set the View Index Offset value at 2. 

Show View Index: Index is Channel or Sort Code and is determined by the View By value.  

Refresh Control Parameter Group 

Refresh Epoch Name: Define the refresh epoch, or indexed event. Click the value box to view a list 

of events. Valid choices are preceded by an  epoch event icon. When a refresh epoch event is defined 

the plot will be refreshed based on the epoch value according to the settings in the Refresh Control 

parameter group.  

Strobe Epoch Low Range: Set the low value for a range in which the plot will be refreshed according 

to the defined refresh epoch. Leave at the default value of 0 if a range will not be used. 

If the scalar value read from the tank for the defined refresh epoch event is greater than the Strobe 

Epoch Low Range value then the plot is refreshed. If not, new data is added along with older data. 

Strobe Epoch High Range: Set the high value for a range in which the plot will be refreshed 

according to the defined refresh epoch. Leave at the default value of -1 if a range will not be used. 

If the scalar value read from the tank for the defined refresh epoch event is less than the Strobe Epoch 

High Range value then the plot is refreshed. If not, new data is added along with older data. 

Refresh on Change: Select the check box to refresh the plot when the scalar value associated with the 

defined refresh epoch changes. 

This setting can be used with the range settings to create a range in which the plot will be refreshed on 

change.  

Refresh Period: Set a time value for the refresh period in seconds. 
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Scaling Parameter Group 

X / Y-Axis Range: Type a value to set the range for the X / Y - axis. 

X / Y-Axis Symmetry: Select the check box to ensure that a symmetrical X/Y-axis range will be 

displayed. This is ideal for signals that are expected to be symmetrical. 

Auto Scale: The plot can be set to automatically scale during animation to ensure that the data can 

always be viewed in a convenient scale. 

➢ None: Auto Scale is turned off. 

➢ Active: The scale of the plot is automatically adjusted to ensure all values can be shown on 

the plot. 

➢ Smart: The scale of the plot is automatically adjusted to ensure values can be shown on the 

plot only during the first 3 seconds. 

Up-Scale Hist.: When Auto Scale is used, this value sets the number of points above the Y-axis range 

that the signal must reach before scaling will occur. 

Down-Scale Hist.: When Auto Scale is used, this value sets the number of points below half of the Y-

axis range a signal must fall before scaling will occur.  

X-Axis Setup Parameter Group 

Show X Labels: Select the check box to display a unit label for the x-axis. Clear the check box to hide 

the x-axis label. 

X-Axis Unit: Set name for units that will appear as part of the plot label. 

X-Axis Units Factor: Define a multiplication factor to convert x-axis units to valid value for the units 

label. 

X-Axis Offset: Define the starting value for the x-axis. 

Y-Axis Setup Parameter Group 

Show Y Labels: Select the check box to display a unit label for the y-axis. Clear the check box to hide 

the y-axis label. 

Y-Axis Units: Set name for units that will appear as part of the plot label. 

Y-Axis Units Factor: Define a multiplication factor to convert y-axis units to valid value for the units 

label.  

Behavior Parameter Group 

Activity Behavior Parameters 

Color at Min: Select the color to be displayed when activity is at defined Min Value. Color for values 

between Min and Max Values are generated using a proportional mix of the defined Colors at Min and 

Max. 

Color at Max: Select the color to be displayed when activity is at defined Min Value. Color for values 

between Min and Max Values are generated using a proportional mix of the defined Colors at Min and 

Max. 
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Min Value: Enter the number of spike to be defined as the minimum value, which is represented by 

the defined Color at Min. 

Max Value: Enter the number of spike to be defined as the maximum value, which is represented by 

the defined Color at Max. 

Show Num Trace: Select the check box to display the number of events in the activity cell. Clear the 

check box to hide the number label.  

Chart Behavior Parameters  

Time Span: Set the time range, in seconds and according to the time stamp, to be displayed on the X-

axis.  

Feature Behavior Parameters  

Cloud Points: Set the minimum number of points to display. The maximum number of cloud points 

will be twice the value set. The plot will refresh when the maximum number is reached. 

X-Axis Feature: Select from a drop down list. Choices are Peak 1, Peak 2, Peak to Peak Time, and 

Area. 

Y-Axis Feature: Select from a drop down list. Choices are Peak 1, Peak 2, Peak to Peak Time, and 

Area. 

Histogram Behavior Parameters 

TimeRef Epoch Name: Defines the epoch, or indexed event, that will be used for the raster rows. 

Click the value box to view a list of events. Valid choices are preceded by an  epoch event icon.  

Respect TRef Duration: When checked the plot's X-axis scale is equal to the duration of the epoch 

event selected in the TimeRef Epoch Name setting. 

TRef Epoch Low Range: Use to set the low value for the X-axis range according to the defined 

TimeRef epoch event. As data is animated, the next data will only be displayed if the associated epoch 

event value is greater than or equal to the low range value. Leave at default value of 0 if a range will 

not be used. 

TRef Epoch High Range: Use to set the high value for the X-axis range according to the defined 

TimeRef epoch event. As data is animated, the next data will only be displayed if the associated epoch 

event value is less than or equal to the high range value. Leave at default value of -1 if a range will not 

be used. 

Time Span: Define the time span if the Respect TRef Duration check box is cleared. The X-axis will 

be equal to the value set for Time Span divided by the value set for Bin Width. 

Bin Width: Define the Bin Width. The X-axis will be equal to the value set for Time Span divided by 

the value set for Bin Width. 

Pile Behavior Parameters 

Pile Depth: Set the minimum number of traces that will be displayed. The maximum number of traces 

will be twice the value set. The plot will refresh when the maximum number is reached. 

Raster Behavior Parameters 

Raster Rows: Select the number of rows to display. 
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TimeRef Epoch Name: Defines the epoch, or indexed event, that will be used for the raster rows. 

Click the value box to view a list of events. Valid choices are preceded by an  epoch event icon.  

Respect TRef Duration: When checked the plot's X-axis scale is equal to the duration of the epoch 

event selected in the TimeRef Epoch Name setting. 

TRef Epoch Low Range: Use to set the low value for the X-axis range according to the defined 

TimeRef epoch event. As data is animated, the next data will only be displayed if the associated epoch 

event value is greater than the low range value. Leave at default value of 0 if a range will not be used. 

TRef Epoch High Range: Use to set the high value for the X-axis range according to the defined 

TimeRef epoch event. As data is animated, the next data will only be displayed if the associated epoch 

event value is less than the high range value. Leave at default value of -1 if a range will not be used. 

Time Span: Define the maximum value of the X-axis using a time stamp value if the Respect TRef 

Duration check box is cleared.  

Scroll Behavior Parameters 

Scroll Sections: Set the number of sections to display before scrolling.  

XY Behavior Parameters 

Cloud Points: Set the minimum number of points to display. The maximum number of cloud points 

will be twice the value set. The plot will refresh when the maximum number is reached. 

Common Parameter Group 

Activity Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Color at Min: Select the color to be displayed when activity is at defined Min Value. Color for values 

between Min and Max Values are generated using a proportional mix of the defined Colors at Min and 

Max. 

Color at Max: Select the color to be displayed when activity is at defined Min Value. Color for values 

between Min and Max Values are generated using a proportional mix of the defined Colors at Min and 

Max. 

Min Value: Enter the number of spike to be defined as the minimum value, which is represented by 

the defined Color at Min. 

Max Value: Enter the number of spike to be defined as the maximum value, which is represented by 

the defined Color at Max. 

Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Refresh Epoch Name: Define the refresh epoch, or indexed event. Click the value box to view a list 

of events. Valid choices are preceded by an  epoch event icon. When a refresh epoch event is defined 

the plot will be refreshed based on the epoch value according to the settings in the Refresh Control 

parameter group. 



OpenScope Reference 

57 

Chart Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Source Channel: Selects the channel for viewing. To view a single channel of data enter the desired 

channel number. To view multiple channels set to 0 and enable multi view. 

Time Span: Set the time range, in seconds and according to the time stamp, to be displayed on the X-

axis. 

Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color (None), 

one color per channel (By Channel), or one color per sort code (By SortCode). 

Feature Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Source Channel: Selects the channel for viewing. To view a single channel of data enter the desired 

channel number. To view multiple channels set to 0 and enable multi view. 

Cloud Points: Set the minimum number of points to display. The maximum number of cloud points 

will be twice the value set. The plot will refresh when the maximum number is reached. 

X-Axis Feature: Select from a drop down list. Choices are Peak 1, Peak 2, Peak to Peak Time, and 

Area. 

Y-Axis Feature: Select from a drop down list. Choices are Peak 1, Peak 2, Peak to Peak Time, and 

Area. 

Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color (None), 

one color per channel (By Channel), or one color per sort code (By SortCode). 

Histogram Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Source Channel: Selects the channel for viewing. To view a single channel of data enter the desired 

channel number. To view multiple channels set to 0 and enable multi view. 

TimeRef Epoc Name: Define the epoch, or indexed event, that will be used for the vertical bars. Click 

the value box to view a list of events. Valid choices are preceded by an  strobe/indexed event icon.  

Time Span: Define the time span. The X-axis will be equal to the value set for Time Span divided by 

the value set for Bin Width. 

Bin Width: Define the Bin Width. The X-axis will be equal to the value set for Time Span divided by 

the value set for Bin Width. 
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Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color (None), 

one color per channel (By Channel), or one color per sort code (By SortCode). 

Pile Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Source Channel: Selects the channel for viewing. To view a single channel of data enter the desired 

channel number. To view multiple channels set to 0 and enable multi view. 

Pile Depth: Set the minimum number of traces that will be displayed. The maximum number of traces 

will be twice the value set. The plot will refresh when the maximum number is reached. 

Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color (None), 

one color per channel (By Channel), or one color per sort code (By SortCode). 

Raster Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Source Channel: Selects the channel for viewing. To view a single channel of data enter the desired 

channel number. To view multiple channels set to 0 and enable multi view. 

Raster Rows: Select the number of rows to display. 

TimeRef Epoc Name: Defines the epoch, or indexed event, that will be used for the raster rows. Click 

the value box to view a list of events. Valid choices are preceded by an  strobe/indexed event icon. 

Time Span: Define the maximum value of the X-axis using a time stamp value. 

Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color (None), 

one color per channel (By Channel), or one color per sort code (By SortCode). 

Scroll Common Parameters 

Source Name: Select the data event (Store name) from the currently selected tank. 

Source Channel: Selects the channel for viewing. To view a single channel of data enter the desired 

channel number. To view multiple channels set to 0 and enable multi view. 
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Scroll Sections: Selects the number of scroll sections to display. 

Multi View Enabled: Enables multi-view for viewing multiple channels. When Multi View is 

enabled, Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. Leave this value set to 1 to see one channel 

per row. 

Confine Plotting Data In Cell Boundary: When the checkbox is selected, plot data will not cross its 

cell boundaries. When disabled, plot data can exceed the boundary. 

Plotting Margin Percentage: Select a value to increase or decrease the margin percentage for 

displaying data while multi view is enabled.   

XY Common Parameters 

Source Name Y-Axis: Define the Event ID (Store name) for the Y-Axis of the plot. Click  to 

display a list of available event IDs. 

Source Channel: Set to 0 to display all channels. Set to a valid channel number to display a single 

channel of data. 

Source Name X-Axis: Define the Event ID for the X-Axis of the plot. Click  to display a list of 

available event IDs. 

Cloud Points: Set the minimum number of cloud points to display. The maximum number of cloud 

points will be twice the value set. The plot will refresh when the maximum number is reached. 

Multi View Enabled: Enables multi view for viewing multiple channels. When multi view is enabled, 

Source Channel should be set to 0. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color (None), 

one color per channel (By Channel), or one color per sort code (By SortCode). 

Data Source Parameter Group 

Shared Data Source Parameters 

Source Name: Define the Event ID (Store Name) for the plot. Click  to display a list of available 

event IDs. 

Source Channel: Set to 0 to display all channels. Set to a valid channel number to display a single 

channel of data. 

Sorting Code: Set to 0 if a sort parameter has not been defined or will not be used. Set to a valid sort 

number to display a single sort. 

Enabled: Clear the check box to disable the data definition for the plot.  
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XY Plot Data Source Parameters 

Source Name Y-Axis: Define the Event ID (Store name) for the Y-Axis of the plot. Click  to 

display a list of available event IDs. 

Source Channel: Set to 0 to display all channels. Set to a valid channel number to display a single 

channel of data. 

Sorting Code: Set to 0 if a sort parameter has not been defined or will not be used. Set to a valid sort 

number to display a single sort. 

Source Name X-Axis: Define the Event ID (Store name) for the X-Axis of the plot. Click  to 

display a list of available event IDs. 

Enabled: Clear the check box to disable the data definition for the plot. 
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OpenBrowser Reference 

In the OpenBrowser Reference you will find: 

A reference guide to the OpenBrowser Workspace and the basics of viewing and exporting data. 
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About OpenBrowser 

OpenBrowser is a data export client application for data stored in the DataTank format. When using 

OpenBrowser, data from one or more data tanks can be selected, previewed, and exported to a standard 

ASCII file format or formats compatible with NeuroExplorer™ or Plexon's Offline Sorter. When 

working in OpenBrowser there are three steps in the data export process: data selection, data browsing, 

and finally, data export. 

Data Selection 

Before data can be exported or viewed it must be selected. The desired tank, block, event, and 

associated values are selected using a spreadsheet like interface and pop-up lists.  

Data Browsing 

Data can be previewed in a table or as a scroll plot. A time control window allows users to quickly 

navigate data in the scroll plot view. Data can be viewed along with epoch data allowing the researcher 

to modify data selections and create subsets of data on the fly. 

Data Export 

OpenBrowser provides for flexible data export. Several file formats are supported and users can 

choose to export all data to a single file or to export subsets of data to separate files. 

Workspace Basics 

About the Open Browser Workspace 

OpenBrowser includes a data viewing area and two collapsible sub-windows. A menu bar and toolbar 

are provided for easy access to commands. 

 

Data Selection Table Window 

The Data Selection Table window allows users to select events from a data tank. Data is selected and 

arranged in rows based on the tank, block, event, and other associated variables. The Data Selection 

Table window also allows users to design a custom configuration file that contains all the export 

variables and information for a data row. 

Data Selection 
Table Window 

Data View 
Area 

Time Line 
Window 
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Data View Area 

The data view area displays data selected in the Data Selection Table window. Data can be displayed 

in either a scroll plot or table view. The scroll plot view displays the waveform data and event times 

for time reference epochs and can be expanded and contracted using the Time Line window. The table 

view displays data in a row and column format. In this view, data and time stamp information can be 

copied and pasted into other applications such as Microsoft Excel. A shortcut menu with Cut, Copy, 

and Paste commands is also available in this view. 

Time Line Window 

The Time Line window displays the block's timeline and allows users to move through the selected 

data using the timeline. 

Menus 

OpenBrowser File Menu 

Tank Server Opens the Select Server window. 

New Opens a new OpenBrowser file. 

Open Opens the Open dialog box so that an existing OpenBrowser file can be 

opened. 

Save Saves the current OpenBrowser file with the current name. If the file has not 

previously been saved, the Save As dialog box opens so that the file can be 

named. 

Save As Opens the Save As dialog box so that the OpenBrowser file can be saved with 

a new name. 

Export 

Current Row 

Exports the currently selected row. 

Export 

Selected Rows 

Exports multiple selected rows. Several adjacent rows can be selected by 

holding down the SHIFT key and clicking the row numbers. Non-adjacent 

rows can be selected by holding down the CTRL key and clicking the row 

numbers. 

Export All 

Rows 

Exports all rows containing data. 

Recently Used 

Files 

The fourth section of the File menu lists recently used files. Clicking a file 

name opens the file. 

Exit Closes the OpenBrowser application. 

 

OpenBrowser Edit Menu 

Undo Reverses the last action taken in the Data Selection Table window. 
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Cut Cuts the selected row(s) in the Data Selection Table or cuts selected data from 

the Data Table view. 

Copy Copies the selected row(s) in the Data Selection Table or copies selected data 

in the Data Table view. 

Paste Pastes the most recently cut or copied row(s) in the Data Selection Table or 

pastes data in the Data Table view. 

Delete Rows Deletes the selected row(s) in the Data Selection Table. If no row is selected 

the last row is deleted. 

Insert Rows Inserts a row above the currently selected row in the Data Selection Table. If 

no row is selected the row is added to the bottom of the table. 

 

OpenBrowser View Menu 

Toolbar Toggles the toolbar between displayed and hidden. 

Status Bar Toggles the status bar between displayed and hidden. 

Data View Table Toggles the Data View window between Table view and Scroll Plot view. 

Data Selection 

Table 

Toggles the Data Selection Table window between displayed and hidden. 

Time Line Toggles the Time Line window between displayed and hidden. 

OpenBrowser Help Menu 

About OpenBrowser Displays version and copyright information for OpenBrowser. 

 

Data Selection 

About the Data Selection Table Window 

The Data Selection Table arranges information in rows and columns. The first three rows define the 

configuration properties for exporting the data and are separated from the data selection rows by a 

header row. The data selection rows determine what data is available for export and display. Each row 

can export data from a single tank, block, and event. To export data from multiple tanks, blocks, or 

events; a new row of data must be added. 
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Tref: Check Boxes (Row 1) 

This row allows users to select an epoch to be used as a time reference. When the check box in this 

row is selected for an epoch, the time stamp of the event is based on its position relative to the last 

epoch as opposed to the start of the block. This is particularly useful if the data is to be exported to 

NeuroExplorer™ or Plexon's Offline Sorter. 

Show: Check Boxes (Row 3) 

Selecting a check box in this row includes the associated column information, such as the TANK, 

BLOCK, CHAN, SORT name and the associated TIME (time stamp), when the data is exported or 

viewed in the Table view. 

Multi-File: Check Box (Cell A3) 

If the Multi-File check box is selected when data is exported then the data in each row will be saved to 

a separate file. 

Header Cells (Row 4) 

This row displays the header names associated with a data tank. The first seven header names 

(columns C - I) are standard for all tanks and cannot be changed. The cells under each column header 

are used to access the associated variable type. Cells in columns J and greater can be used to select 

epoch header names. 

Column Header Function 

TANK Select the tank for data access. 

BLOCK Select the block number. 

EVENT Select the associated Store. 

TIME Select time stamp values. 

CHAN Enter a channel number or range of channels. Leaving this column blank 

includes all channels. 

SORT Enter a sort code, or range of sort codes, associated with a snippet event. 

DATA Not implemented at this time. 

... Allows the user to select epoch variables to use as time stamp reference 

markers. 

A row must be selected before an epoch can be selected. Right-click an 

empty header cell to add an epoch. 

Data Selection Cells (Rows 5 and Greater) 

Users can fill multiple rows with data export information. For example, an experiment might consist of 



OpenBrowser Reference 

67 

a single block of data with multiple events. An OpenBrowser export file would consist of a series of 

export rows each with different events and possible channels within an event. This allows a user to 

configure an OpenBrowser file to organize how the data is exported. 

Exp. Config Buttons (Column A) 

Clicking the Exp. Config button for a row displays a dialog box that allows users to select how the data 

in that row is exported. 

Refresh! Buttons (Column B) 

Clicking the Refresh! button for a row refreshes the View area with data for the selected row. 

Using the Data Selection Table Window 

The Data Selection Table can be used to select data and to prepare data for export. 

Selecting Data 

To use the Data Selection Table window; select the tank, block number, then event information for the 

data to be viewed or exported. These three pieces of information must be selected in order, that is, the 

tank must be selected before the block can be selected and the block must be selected before the event 

can be selected. Each piece of information can be added by right-clicking the cell under the appropriate 

column heading and then double-clicking the desired tank, block, or event from the list in the selection 

window. 

When selecting a tank, right-click in the cell under the Tank heading to bring up the Select Tank 

dialog. To select a tank, single-click a tank in the list or click the Open Existing Tank icon to browse to 

the desired tank folder.  

Note: Clicking OK out of this dialog selects the tank and also closes the Select Tank dialog.   

Epochs can be added to the table in the empty header cells (indicated by ellipses) and a single epoch 

can be used as a time reference by selecting the Tref check box for the epoch column. See Using 

Epochs as a Time Reference. 

Once the first data selection row has been configured in the Data Selection Table, additional rows with 

the same configuration can be added by copying and pasting the row to a blank row.  

After the row has been copied, change the block or event name as needed. To change a cell value, first 

delete the cell's current value, then right-click the cell to open a list of possible blocks or events. 

Shorthand characters can also be used to simplify setting up multiple rows. See Using Shorthand 

Characters for Data Selection, page 68 for more information. 

Tip: When using copy and paste to add multiple rows of data, configure the first row for export first. 

When it is copied and pasted the export configuration will also be included. Be sure to check one or 

more of the Append File Name By check boxes to ensure that multiple rows saved to multiple files 

will have unique names. See Data Export for more information on configuring data for export. 

Adding Rows 

To add a row click the Edit menu, and click Insert Rows. 

Deleting Rows 

To delete selected rows, click the Edit menu and click Delete Rows. To select a row click the row 

number. Use the SHIFT or CTRL keys to select multiple rows. 

Controlling the Data View Area 

After a tank, block number, and event have been associated with the row the user can click on Refresh! 

to view the data in the View area. 

Configuring Data for Export 

The Exp. Config buttons for each row provide easy access to the Data Format Export Configuration 

dialog box. After a row has been configured for export, the text on the Exp.Config button changes 
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from gray to blue. When exporting more than one row, use the Multi-File check box to determine if 

each row of data will be exported to a separate file or if all data will be exported to one single file.  

Using Shorthand Characters for Data Selection 

A series of shorthand characters can be used to speed up data selection in the Data Selection Table. 

^ 

Indicates that the value in the cell above will be used for this cell. For example, 

placing a caret in a cell in the TANK column will cause the row to acquire data 

from the tank named in the row above. 

^+ 
Used with BLOCK, CHAN, and SORT cells. It will increment the BLOCK, 

CHAN, or SORT number by one, relative to the cell above it. 

> 

Used with TIME CHAN, SORT, and epoch cells. Channels that are greater than 

the cell value are viewed and exported. For example, >3 selects channel or sort 

values greater than 3. 

< 
Used with TIME, CHAN, SORT, and epoch cells. Values that are less than the 

cell value are viewed and exported. 

: 

Used with TIME, CHAN, SORT, and epoch cells. Values in the named range are 

viewed and exported. For example, if a cell in the CHAN column contained the 

statement 3:10 then channels 3 through 10 would be viewed and exported. 

In the example below, data would be exported from tank nefw, blocks 45 and 46, and all SPKE and 

SSPK events (including all channels). Note how that ^+ is only used once for the BLOCK cell for 

SPKE in row 7. If the BLOCK cell for the SSPK event in row 8 used a ^+, the data would have come 

from block 47. 
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Using Epochs as a Time Reference 

The Data Selection Table allows users to select an epoch to be used as a time reference. Using a time 

reference epoch starts the time value at zero for each epoch and allows the time code information to be 

used to generate PSTH and other graphs in NeuroExplorer and other analysis applications. 

 

To add a time reference: 

➢ Select the Tref check box (in Row 1) for an empty epoch column. The header for an empty 

epoch column contains an ellipse. 

➢ Select a row containing data selection information for the tank, block, and event. To select a 

row click the row number. 

➢ In the Header row, right-click the cell (containing an ellipse "...") for that column. This will 

open an event selection dialog box. The available epoch events are listed (that is, available in 

the tank named in the TANK column for the currently selected row). 

➢ To select the epoch to be used as a time reference, double-click the epoch in the list. 

Additional epochs can be added to subsequent columns; however, only one time reference 

epoch can be active at a time. 

Note: A specific value or range of values can be selected using the epoch cell for a row. For example, 

entering ">1000" in an epoch cell will limit the epoch values used to those greater than 1000. A single 

value may be selected by entering a number without a modifier, such as "1000". See the Using 

Shorthand Characters, page 68 for more information. 

The active time reference determines the zero time for the time stamps. When the Show check box is 

selected for an epoch column the epoch will be included in the view area for any row that is refreshed. 

It will be displayed above the data in the scope plot view or show as a separate column in the data table 

view. 

Data Browsing 

About the Data View Area 

The Data View area allows table or graphic visualization of tank data from a selected row. To switch 

between table and scroll plot views, select or clear the Data View Table option on the View menu. 
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Scroll Plot View 

The scroll plot displays waveform or scalar data from an event as well as the associated scalar 

information from epochs. Epochs are displayed above the event data. In the scroll plot below, an epoch 

(Freq) associated with the time line is shown above the event (Snip) line. 

 

To modify which epochs are displayed, choose the Show check box for the event column in the Data 

Selection Table window. 

To move about the Scroll plot, select the marker in the Time Line window and move it to the time 

stamp or event of interest. The time range can be expanded or contracted to give additional detail about 

the waveforms using the Time Line window. 

Table View 

In table view the variables selected in the Show row of the Data Selection Table window are displayed. 

The time stamp associated with the event and any associated epochs are displayed. If Tref is selected in 

the Data Selection Table window the time stamps displayed will be relative to the start of the epoch. 

To determine which variables such as block number, tank name, time stamp, and epochs are displayed, 

choose the corresponding Show check boxes in the Data Selection Table window. 

All data can be copied and pasted from the table to a Microsoft Word document or Excel spreadsheet. 

To copy the data, select the range of cells, right-click the selected cells, and click the Copy command 

on the shortcut menu. To paste the data into another application, go to that application and press 

CTRL+V. 

In the example below the event, time stamp (in this case the spike times), channel number, and epochs 

are displayed.  
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Using the Time Line Window 

The Time Line window provides a timeline and vertical line indicator that moves as data is animated in 

the Scroll Plot view of the Data View area. The Time Line window can also be used to move to a 

particular time or event in the Data View area. Epoch events that are included in the selected data area 

are also added to the window. The Time Line window gives a precise description of when data was 

collected. 

 

Timeline by Time Stamps 

 

 
The current time stamp. 
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Moves the indicator back by time stamps. 

 

Moves the indicator forward by time stamps. 

Scale Controls 

 
Expands scale in small steps. 

 
Shrinks scale in small steps. 

 
Expands scale in large steps. 

 
Shrinks scale in large steps. 

Timeline by Events 

 

 
The name of the event displayed on the corresponding line. 

 
Moves the indicator back by events. 

 
Moves the indicator forward by events. 

 
The current event value. 

Data Export 

Exporting Tank Data 

The primary function of OpenBrowser is to export data from the tank to other data formats. 

OpenBrowser can export to several common file formats: ASCII, NEX, PLX, DDT and EDF. The 

standard ASCII format allows users to export data in a format readable by most statistical and graphic 

packages as well as Microsoft Excel spreadsheets. OpenBrowser can also export directly to the NEX 

format for import to NeuroExplorer™, the PLX and DDT (v101) formats for use with Plexon's Offline 

Sorter, or EDF (European Data Format). 

Note: The NEV export function is no longer supported. 
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Export From the File Menu 

The File menu provides the following three choices for exporting data: 

➢ Export Current Row: Exports the currently selected row. 

➢ Export Selected Rows: Exports multiple selected rows. 

➢ Export All Rows: Exports all rows containing data. 

Before data can be exported using these commands it must be selected and configured for export. Data 

is selected using the Data Selection Table window. When multiple rows of data have been selected the 

user can choose to export multiple rows to a single file or to export each row to a separate file. Single 

or Multi-File export is determined using the Multi-File check box in the Data Selection Table window. 

If exporting to multiple files, each row must be configured before the export process begins. Individual 

rows of data can be configured for export at any time using the Exp. Config buttons. If exporting to a 

single file, the export configuration can be defined during the export process. If the export 

configuration has not been completed prior to export, the Data Export Format Configuration dialog 

box will be displayed during the export process. 

Exporting From the Data Table View 

The data in the data table can be copied and pasted directly to a Microsoft Excel spreadsheet. This will 

save all the information about blocks, events, time stamps, channel, sort, and Epoch information 

displayed in the table view. It does not export the waveform data. 

Using the Data Export Format Configuration Dialog 
Box 

The Data Export Format Configuration dialog box is used to configure data for export before or during 

the export process.  

To open the Data Export Format Configuration dialog box, click the Exp. Config button for a row. The 

settings available depend on the export format selected in the File Type box in the upper left corner of 

the dialog box.  

After the export settings are configured, clicking the Save button stores the export information for 

future use and the color of the Exp. Config button text changes to blue. 

 

File Type Drop Down Menu 

ASCII Export Settings 

Column Delimiter: data is exported with the specified separators between columns. 

➢ COMMA: each value is separated by a comma. This is the default Excel importing format. 

➢ TAB: each value is separated by a tab.  

➢ RETURN: each value is separated by a return character. 
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Row Delimiter: data is exported with the specified separators between rows. 

➢ RETURN: each row is separated by a return character (most common). 

➢ TAB: each row is separated by a tab. 

➢ COMMA: each row is separated by a comma. 

Max Col Width: maximum number of columns in a row. When the maximum number is reached, a 

row delimiter is generated. To ensure the integrity of exported data when viewed in the target 

application, set the Max Col Width for that application before export. 

In applications, like Excel, that have a maximum number of columns, exceeding the application's 

maximum number of columns might cause problems when the exported data is opened in the target 

application. Problems might include truncated data display, automatically generated and undesirable 

row decimeters, and so forth. For example, if the user attempts to open an export file with more than 

248 data samples in Microsoft Excel (which is limited to 256 cells in a row), the excess samples will 

be discarded and Excel will generate a "File not loaded completely" message. Note that the reason the 

maximum number is 248 is that at least six columns out of the 256 are used for other information such 

as block, event, time stamps, and so forth. If more than six columns are used before the data columns, 

then there will be fewer columns available for data. See also Number of data subsections, below for 

more information. 

Significant Digits: number of digits saved for each value starting with the first non-zero digit. This 

parameter is applied to time stamps as well as data. 

Hide Title: hides the first row with the column descriptions.  

Raw Data Only: saves only the signal data and discards all of the other details like tank name, block 

name, event, time, sampling frequency, and number of points. 

Output File Name: allows the user to browse to and set the location and name for the output file(s). 

Append File Name By ...: appends the block, event, channel number, and/or row number of the 

exported data to the output file name. This is very useful when the Multi-File option is selected. 

Number of data subsections: used to divide the data samples into subsections. By default, each data 

set is stored in a single row with the tank name, block name, and so forth at the beginning of the row. 

Specifying subsections allows the data to be stored using several rows. Each row (or subsection) 

includes the header information such as tank name, block name, followed by a subset of data samples.  

This option is useful when loading a data file with a large number of samples. For example, if the user 

intends to work with exported data in Excel then each row must be limited to no more than 256 cells. 

A file with 300 points in each record can be exported specifying 2 subsections to create two rows 

dedicated to each record, each with 150 sample points. This would ensure that the maximum number 

of cells per row is not exceeded and creates a file with a consistent set of row headers at the beginning 

of each row. See also Max Col Width, page 74 for more information. 

Transpose output (data in columns): transposes columns to rows so that each column is a data set 

(by default, OpenEx data is saved in rows). This option can be used when exporting a data file 

containing a large number of samples for use with Microsoft Excel. By saving data in columns the user 

avoids limitations in the maximum number of cells possible in a row. 

PLX Export Specific Settings 

Export epoch events as plx strobe events: used to display epoch events as strobe events in 

NeuroExplorer™. Not used when exporting for use with Plexon's Offline Sorter. 

Gain (for spike waveform, in K): used with Scaling Factor to scale spike data for viewing in Offline 

Sorter. Recommended value is 1. Values can be from 1 to 32.  

Spike Scaling Factor (Floating Point to µV): used with Gain to scale spike data for viewing in 

Offline Sorter.  
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Gain (for continuous waveform): used with Scaling Factor to scale continuous data for viewing in 

Offline Sorter. Recommended value is 1. Values can be from 1 to 32.  

Stream Scaling Factor (Floating Point to µV): used with Gain to scale continuous data for viewing 

in Offline Sorter.  

Comment: 256 character comment line. 

Output File Name: allows the user to browse to a network or local folder and saves the file with a set 

name. 

Note: See Exporting to PLX, page 79 for detailed information on using PLX export specific settings. 

Append File Name By ...: allows the user to select to automatically add the block, event, channel 

number, and/or row number of the exported data to the saved file name. This is very useful when the 

Multi-File option is selected. 

DDT Export Settings 

Output File Name: allows the user to browse to and set the location and name for the output file(s). 

Description: optional text field that is included in DDT header. 

Scale Factor: used to scale streaming data before converting to integer values for viewing in Offline 

Sorter. 

Append File Name By ...: appends the block, event, channel number, and/or row number of the 

exported data to the output file name. This is very useful when the Multi-File option is selected. 

NEX Export Specific Settings 

Quant Factor (mV per LSB): Sets the millivolt range for the Least Significant Bit of the NEX 

format. The default value has been set to insure that the data is exported correctly. Changing the 

default settings can cause data to be read incorrectly by NeuroExplorer™. 

Scaling Factor (to convert Tank Data to µV): Not used. 

Comment: 256 character comment line. 

Append Event Name by Channel #: allows the user to select to automatically add the channel 

number to the event name.  

Output File Name: allows the user to browse to a network or local folder and saves the file with a set 

name. 

Append File Name By ...: allows the user to select to automatically add the block, event, channel 

number, and/or row number of the exported data to the saved file name. This is very useful when the 

Multi-File option is selected. 

Note: The NEV export function is no longer supported. 

NsN Export Specific Settings 

For more information regarding the NeuroShare Native (NsN) file format, refer to the NeuroShare 

website at: http://neuroshare.sourceforge.net/index.shtml 

Output File Name: specifies the path and filename for the exported *.nsn file. 

File Type Descriptor: specifies the file extension for the exported data file. This should be set to .nsn. 

Time Stamp Resolution: minimum timestamp resolution in seconds. 

Digitization Scaling Factor (in nV): not used 
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Scaling Factor (to Convert Tank Data to µV): scale factor used for buffer (type 2), snippet (type 4), 

or continuous (type 5) data. Recommended value is 1. 

Scaling Factor (to Convert Event Tank Data): scale factor used for scalar (type 1) or list (type 3) 

data. Recommended value is 1. 

File Comment: 256 character comment line. 

Min Input Signal: minimum possible value of the input signal in Volts. 

Max Input Signal: maximum possible value of the input signal in Volts. 

Units: Enter a text value to specify the recording units of measurement. 

Input Signal Resolution: minimum input step size that can be resolved. To obtain the signal 

resolution divide the voltage range by the number of bit values. E.g. for a +/- 1 Volt 16-bit ADC this 

value is 2 / 2P

16
P or 0.0000305.  

X Location: optional text information about the X coordinate of source in meters. 

Y Location: optional text information about the Y coordinate of source in meters. 

Z Location: optional text information about the Z coordinate of source in meters. 

High Freq Cutoff: high frequency cutoff in Hz of the source signal filtering. 

High Freq Order: order of the filter used for high frequency cutoff. 

High Freq Filter Type: optional text information to describe the type of filter used for high frequency 

cutoff. 

Low Freq Cutoff: low frequency cutoff in Hz of the source signal filtering. 

Low Freq Order: order of the filter used for low frequency cutoff. 

Low Freq Filter Type: optional text information that describes the type of filter used for low 

frequency cutoff. 

Probe Info: optional text information about the signal source. 

EDF Export Settings 

Output File Name: specifies the path and filename for the exported *.edf file. 

Description: optional text used to describe the data. This is included in the EDF header. 

Scale Factor: used to scale streaming data before converting to 16-bit integer values for EDF format. 

If the TDT data is stored as floating point, a scaling factor of 1e6 converts everything into round units 

of uV. If the TDT data is stored as 16-bit integers, leave the Scale Factor at 1. 

Units: enter a text value to specify the recording units of measurement after scaling. 

Clip Min: force the EDF converter to use this value instead of the minimum value in the data for the 

conversion to integer. Useful for improving signal resolution if some channels have artifact. 

Clip Max: force the EDF converter to use this value instead of the maximum value in the data for the 

conversion to integer. Useful for improving signal resolution if some channels have artifact. 

Generate Test Data: optional checkbox. When selected, the output will contain eight channels of 

recognizable test data signals (sine wave, sawtooth, pulse, noise, etc) that can be viewed in an EDF 

viewer to validate the export. 
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Exported Test Data Viewed in Polyman 

An example of the generated test data can be found in the image above. The Polyman EDF viewer 

software was used to load the data and capture this image. 

Append File Name By ...: appends the block, event, channel number, and/or row number of the 

exported data to the output file name. This is very useful when the Multi-File option is selected. 

Exporting to ASCII 

Exporting to the standard ASCII format allows users to access data in a format readable by most 

statistical and graphic packages as well as Microsoft Excel spreadsheets. When data is exported in the 

ASCII format, the first six columns always denote the block name, event, time stamp, channel, 

sampling frequency, and number of points in each record. Subsequent columns contain actual data. 

Additional columns may be added before data columns to store information such as subsections, epoch 

events. The first row contains header information (describing the data stored in each column, such as 

BLOCK, EVENT, TIME, and so forth) for each column. 

Export to Multiple Files 

1. When exporting to multiple files, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is checked. 

2. Configure each row for export. To configure a row for export: 

a. Click the Exp. Config button for the desired row. 

b. In the Data Export Format Configuration dialog box, ensure that ASCII is 

selected in the File Type box. 
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c. Name the export file. Click the  Browse button to the right of the Output File 

Name box. The Open dialog box is displayed. 

d. Browse to the desired file location.  

e. In the File Name box, type a file name and click Open. You can type individual 

names for each row/file or use the same base file name for all rows/files. If you use a 

base name be sure to use the Append File Name by check boxes. If two or more rows 

attempt to write to exactly the same file, data will be overwritten. 

f. If desired, select one or more of the Append File Name By check boxes to include 

block, channel, event, or row information in the file name. 

g. Modify any other settings as desired. 

h. Click Save. 

3. Repeat for each row to be exported. To save time, complete the export configuration during 

the data selection process. That way if you use copy and paste to add rows the export 

configuration will also be copied. Be sure to use one or more of the Append File Name By 

check boxes to ensure that each row ill have a unique file name. 

4. If exporting only selected rows, select the rows to export and click Export Selected Rows on 

the File menu. 

5. If exporting all rows, on the File menu, click Export All Rows. 

6. Review the messages in the Export Status dialog box and click OK. 

Export to a Single File 

1. When exporting to a single file, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is not checked. 

2. If exporting a single row, select the row then, on the File menu, click Export Current Row. 

3. If exporting only selected rows, select the rows to export then, on the File menu, click Export 

Selected Rows. 

4. If exporting all rows, on the File menu, click Export All Rows. 

5. In the Data Export Format Configuration dialog box, ensure that ASCII is selected in the File 

Type box. 

6. In the Output File Name box, click the  Browse button. The Open dialog box is 

displayed. 

7. Browse to the desired location for the data file.  

8. In the File Name box, type a file name and click Open. 

9. Modify any other settings as desired. 

10. Click Export. 

11. Review the messages in the Export Status dialog box and click OK. 
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Exported Data Viewed in Microsoft Excel 

Exporting to PLX 

OpenBrowser can export directly to the PLX format for use with Plexon's Offline Sorter and Wave 

Tracker. Data exported in PLX format can also be viewed with NeuroExplorer™. For researchers who 

use several different analysis packages, exporting to the PLX format eliminates the need to export data 

in several different formats. The PLX export has been streamlined to provide the user with both 

flexibility and ease of use.  

Note: Use Offline Sorter version 2.5 or greater, if possible. Earlier versions of Offline Sorter might be 

unable to import OpenEx Stream data. The latest version of Offline Sorter is available at 

http://www.plexoninc.com/Software_downloads.htm. 

When tank data is exported to PLX format it must be scaled to match the requirements of the new 

format. This is done using two parameters; a scaling factor that scales the signal to the correct range 

and a gain factor that sets the units (mV, µV). Because Offline Sorter and Wave Tracker handle 

streamed data and spike data differently, users must set separate scaling factors and gain settings for 

each type of data. Once these values have been set, OpenBrowser automatically ensures that streamed 

data and spike data are exported correctly.  

Before beginning the export process users should: 

1. Ensure that block size for each waveform is less than 256. 

 

Data that will be exported for use with Offline Sorter or Wave Tracker should have a block 

size (in the OpenEx Header) of less than 256 samples.  

2. Determine if the PLX data will be used in NeuroExplorer™. 

 

The PLX export configuration settings include an Export epoch events as plx strobe events 

check box. If the data will be viewed in NeuroExplorer™, this check box must be selected. If 

NeuroExplorer™ will not be used, the check box may be left cleared. 

3. Determine the highest absolute value in the data set. 

 

The highest value is used to calculate the scaling factor for export. It is an absolute number 

and can be approximated. An approximate value for the highest number can be determined at 

a glance when viewing the data set in the OpenBrowser preview plot. Simply refresh the data 
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then view the scale values. Because the plot scales automatically, the maximum scale value is 

a good approximation of the maximum value in the data set. 

4. Select a Gain setting. 

 

Gain is expressed as an integer from 1 to 32. The gain is used to display data in Offline Sorter 

or Wave Tracker using the correct units, such as µVs. When unit information is not important, 

the gain can be safely set to 1 to simplify the formula for determining the scaling factor. 

5. Calculate Scale Factor for Stream and/or Snippet data. 

 

The scaling factor can be determined using the following formula, where G = gain, SF = 

scaling factor, and H# = the highest absolute value in the data set. Note that when processing 

spike data, setting the gain to 1, and the scale factor to 1e6 is usually acceptable.  

 

For streamed data: SF x G = 5e6P

 
P/ H# 

 

For spike data: SF x G = 3e3 P

 
P/ H# 

To better understand how the SF * G formulas are derived, begin by considering these facts: 

➢ Data collected in OpenEx are stored as floating point values while Offline Sorter expects data 

stored as 12-bit signed integers. A 12-bit signed integer yields a maximum value of 2047.  

➢ In Offline Sorter, the maximum voltage for streamed data is 5 Volts and the maximum voltage 

for spike data is 3 Volts.  

➢ OpenEx data is typically viewed in the microvolt range (1e-6). 

➢ OpenBrower uses a user-specified scaling factor (SF) and gain (G) when exporting tank data 

to a PLX format. 

For the highest value (H#) in the tank data, the specified SF and G must yield a value that can be 

expressed within Offline Sorters dynamic range.  

For streamed data this can be expressed as:  H# * SF * 1e-6 * 2048 * G / 5 < 2048 

For spike data this can be expressed as:  H# * SF * 1e-6 * 2048 * G / 3 < 2048 

Export to Multiple Files 

1. When exporting to multiple files, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is checked. 

2. Configure each row for export. To configure a row for export: 

a. Click the Exp. Config button for the desired row. 

b. In the Data Export Format Configuration dialog box, in the File Type box, ensure 

that PLX is selected. 

c. Enter the appropriate gain and scaling factor for the data type being exported in the 

current row. 

d. Name the export file. In the Output File Name box, click the  Browse button. 

The Open dialog box is displayed. 

e. Browse to the desired file location.  

f. In the File Name box, type a file name, then click Open.  

 

You can type individual names for each row/file or use the same base file name for 

all rows/files. If you use a base name be sure to use the Append File Name by check 
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boxes. If two or more rows attempt to write to exactly the same file, data will be 

overwritten. 

g. If desired, select one or more of the Append File Name by check boxes to include 

block, channel, event, or row information in the file name. 

h. Modify any other settings as desired. 

i. Click Save. 

3. Repeat for each row to be exported.  

 

To save time, complete the export configuration during the data selection process. That way if 

you use copy and paste to add rows the export configuration will also be copied. Be sure to 

use one or more of the Append File Name by check boxes to ensure that each row ill have a 

unique file name. 

4. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

5. If exporting all rows, on the File menu, click Export All Rows. 

6. Review the messages in the Export Status dialog box and click OK. 

Export to a Single File 

Note: if exporting multiple channels to a single PLX file for use in Offline Sorter's Tetrode Mode, use 

a single row, not different rows for each channel. 

1. When exporting to a single file, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is not checked. 

2. If exporting a single row, select the row and, on the File menu, click Export Current Row. 

3. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

4. If exporting all rows, on the File menu, click Export All Rows. 

5. In the Data Export Format Configuration dialog box, in the File Type box, ensure that PLX is 

selected. 

6. Enter the gain and scaling factor for each type of data to be exported.  

 

If both streamed and snippet data are being exported to the same file, values can be specified 

for each type of data in a single export configuration dialog box. If only one type of data is 

being exported, only the gain and scaling factor for that data type will be used and the others 

will be ignored.  

 

However, keep in mind that all rows of a particular data type will be exported using the same 

gain and scaling factor. If two rows of the same data type are dissimilar they might need to be 

exported separately. 

7. In the Output File Name box, click the  Browse button. The Open dialog box is 

displayed. 

8. Browse to the desired location for the data file.  

9. In the File Name box, type a file name, then click Open. 

10. Modify any other settings as desired. 

11. Click Export. 

12. Review the messages in the Export Status dialog box and click OK. 
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Troubleshooting the Export Process 

The following table will help users identify common errors that might occur during the export process.  

Symptom Problem 

OpenBrowser crashes during export This usually indicates that an error was made in 

calculating the scaling factor 

Data seems to small or too large in Offline 

Sorter/Wave Tracker 

An error was made in calculating the scaling 

factor 

Data is displayed with the wrong units in 

Offline Sorter/Wave Tracker 

An error was made in selecting a Gain setting 

Offline Sorter/Wave Tracker displays a 

message that states that the user needs 

OfflineSorterLong.exe 

This usually indicates that the block size for 

exported data was greater than 256 samples 

Epoch events are not recognized as strobe 

events in NeuroExplorer™ 

The Export epoch events as plx strobe events 

check box was not selected during export 

Events are named incorrectly in 

NeuroExplorer™ 

The Export epoch events as plx strobe events 

check box was not selected during export 

Exporting to DDT 

OpenBrowser can export directly to DDT format version 101. A DDT data file is used to import 

streaming waveforms into Plexon’s Offline Sorter.   

When tank data is exported to DDT format it must be scaled to match the requirements of the new 

format. This is done using a scaling factor. Once this value has been set, OpenBrowser automatically 

ensures that streamed data are exported correctly.  

Before beginning the export process users should calculate the Scale Factor. To understand how the 

Scale Factor is used, begin by considering these facts: 

➢ Data collected in OpenEx are stored as floating point values while Offline Sorter expects data 

stored as 16-bit signed integers. A 16-bit signed integer yields a maximum value of 32767.  

➢ In Offline Sorter, the maximum voltage for streamed data is 5 Volts, so each bit represents 

~153uV. 

➢ OpenEx data is typically viewed in the microvolt range (1e-6). 

➢ OpenBrower uses a user-specified scaling factor (SF) when exporting tank data to DDT 

format. 

To get full resolution, where the max value of the TDT data is mapped to 5V in Offline Sorter, set 

Scale Fator to 32767/H# where H# is the largest absolute value in the tank data.  

Note that a scale factor of 1e6 is usually acceptable, where each bit represents 1uV. 

Before data can be exported it must be selected and configured for export using the Data Selection 

Table window. 
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Export to Multiple Files 

1. When exporting to multiple files, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is checked. 

2. Configure each row for export. To configure a row for export: 

a. Click the Exp. Config button for the desired row. 

b. In the Data Export Format Configuration dialog box, in the File Type box, ensure that 

DDT is selected. 

c. Name the export file. In the Output File Name box, click the  Browse button. The 

Open dialog box is displayed. 

d. Browse to the desired file location. 

e. In the File Name box, type a file name then click Open.  

 

You must type individual names for each row/file. If two or more rows attempt to write 

to exactly the same file, data will be overwritten. 

f. Modify any other settings as desired. 

g. Click Save. 

3. Repeat for each row to be exported.  

4. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

5. If exporting all rows, on the File menu, click Export All Rows. 

6. Review the messages in the Export Status dialog box and click OK. 

Export to a Single File 

1. When exporting to a single file, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is not checked. 

2. If exporting a single row, select the row and, on the File menu, click Export Current Row. 

3. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

4. If exporting all rows, on the File menu, click Export All Rows. 

5. In the Data Export Format Configuration dialog box, in the File Type box, ensure that EDF is 

selected. 

6. In the Output File Name box, click the  Browse button. The Open dialog box is 

displayed. 

7. Browse to the desired location for the data file.  

8. In the File Name box, type a file name, then click Open. 

9. Modify any other settings as desired. 

10. Click Export. 

11. Review the messages in the Export Status dialog box and click OK. 

Troubleshooting the Export Process 

The following table will help users identify common errors that might occur during the export process.  
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Symptom Problem 

Data seems to small or too large in Offline 

Sorter 

An error was made in selecting the scaling 

factor 

Data is displayed with the wrong units in 

Offline Sorter 

An error was made in selecting the scale 

factor 

Offline Sorter crashes or hangs when 

opening DDT file made by OpenBrowser 

The sampling rate of the waveforms 

exported to DDT must be higher than 1 

kHz for some versions of Offline Sorter 

Exporting to NEX 

OpenBrowser can export directly to the NeuroExplorer™ NEX format.  

Export to Multiple Files 

1. When exporting to multiple files, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is checked. 

2. Configure each row for export. To configure a row for export: 

a. Click the Exp. Config button for the desired row. 

b. In the Data Export Format Configuration dialog box, in the File Type box, ensure 

that NEX is selected. 

c. Name the export file. In the Output File Name box, click the  Browse button. 

The Open dialog box is displayed. 

d. Browse to the desired file location. 

e. In the File Name box, type a file name, then click Open.  

 

You can type individual names for each row/file or use the same base file name for 

all rows/files. If you use a base name be sure to use the Append File Name by check 

boxes. If two or more rows attempt to write to exactly the same file, data will be 

overwritten. 

f. If desired, select one or more of the Append File Name by check boxes to include 

block, channel, event, or row information in the file name. 

g. Modify any other settings as desired. 

h. Click Save. 

3. Repeat for each row to be exported. To save time, complete the export configuration during 

the data selection process. That way if you use copy and paste to add rows the export 

configuration will also be copied. Be sure to use one or more of the Append File Name by 

check boxes to ensure that each row ill have a unique file name. 

4. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

5. If exporting all rows, on the File menu, click Export All Rows. 

6. Review the messages in the Export Status dialog box and click OK. 
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Export to a Single File 

1. When exporting to a single file, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is not checked. 

2. If exporting a single row, select the row and, on the File menu, click Export Current Row. 

3. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

4. If exporting all rows, on the File menu, click Export All Rows. 

5. In the Data Export Format Configuration dialog box, in the File Type box, ensure that NEX is 

selected. 

6. In the Output File Name box, click the  Browse button. The Open dialog box is 

displayed. 

7. Browse to the desired location for the data file. 

8. In the File Name box, type a file name, then click Open. 

9. Modify any other settings as desired. 

10. Click Export. 

11. Review the messages in the Export Status dialog box and click OK. 

Exporting to EDF 

OpenBrowser can export directly to EDF format. An EDF data file consists of a header record 

followed by binary data records. More details about the EDF standard can be found online here: 

5TUhttp://www.edfplus.info/specs/edf.htmlU5T.  

 

Note: OpenBrowser does not support the EDF+ format.  

Important! The OpenBrowser Software provides similar functionality to the OpenBrowser EDF 

export. TDT reccomends using OpenBridge. 

 

Before data can be exported it must be selected and configured for export using the Data Selection 

Table window. 

Export to Multiple Files 

1. When exporting to multiple files, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is checked. 

2. Configure each row for export. To configure a row for export: 

a. Click the Exp. Config button for the desired row. 

b. In the Data Export Format Configuration dialog box, in the File Type box, ensure that 

EDF is selected. 

c. Name the export file. In the Output File Name box, click the  Browse button. The 

Open dialog box is displayed. 

d. Browse to the desired file location.  

e. In the File Name box, type a file name, then click Open.  

 

You must type individual names for each row/file. If two or more rows attempt to write 

to exactly the same file, data will be overwritten. 

http://www.edfplus.info/specs/edf.html
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f. Modify any other settings as desired. 

g. Click Save. 

3. Repeat for each row to be exported.  

4. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

5. If exporting all rows, on the File menu, click Export All Rows. 

6. Review the messages in the Export Status dialog box and click OK. 

Export to a Single File. 

1. When exporting to a single file, ensure that the Multi-File check box in cell A3 of the Data 

Selection Table window is not checked. 

2. If exporting a single row, select the row and, on the File menu, click Export Current Row. 

3. If exporting only selected rows, select the rows to export and, on the File menu, click Export 

Selected Rows. 

4. If exporting all rows, on the File menu, click Export All Rows. 

5. In the Data Export Format Configuration dialog box, in the File Type box, ensure that EDF is 

selected. 

6. In the Output File Name box, click the  Browse button. The Open dialog box is 

displayed. 

7. Browse to the desired location for the data file.  

8. In the File Name box, type a file name, then click Open. 

9. Modify any other settings as desired. 

10. Click Export. 

11. Review the messages in the Export Status dialog box and click OK. 

Single vs. Multi-File Export 

The user can determine if data will be exported to multiple files or a single file using the Multi-File 

check box in the Data Selection Table window. 

Single File Export 

If the Multi-File check box is not checked (cell A3) all data is exported to a single file. To use this 

export function the rows do not have to have been configured before the export process begins. The 

Data Export Format Configuration dialog box will be displayed during export, giving the user an 

opportunity to complete configuration. If a single row is selected and has been configured, the dialog 

box will show the output format for that row. If multiple (or all) rows have been selected the dialog 

box will display the output format for the first row.  

Note: error messages will occur if a row has no data in it. 

Multi-File Export 

If the Multi-File check box has been selected each row of data will be saved to a separate file. Each 

row can have a unique file format. Rows must be configured for export using the Data Export Format 

Configuration dialog box prior to the export process.  

When the export process begins the selected rows are immediately stored to files based on the export 

configuration format specified. If rows are not configured for export a warning message is displayed in 

the Export Status dialog, starting with the first row that could not be exported. 
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Understanding the EDF Export 

OpenBroswer’s method for exporting to EDF format is designed to maximizes resolution by using all 

16 bits available in this format. Taking a closer look at the method used, should help users understand 

how the scaling factor is applied and how to interpret the 16-bit values stored in the EDF. 

1. OpenBrowser multiplies the tank data by the scaling factor. 

2. The entire data set is scanned to find the max/min values and then stores them in the EDF file 

as the Physical Maximum and Physical Minimum values for each channel (or signal).  (See 

http://www.edfplus.info/specs/edf.html for more information on the EDF format.) 

3. The Units parameter is stored as the Physical Dimension for all channels in the EDF file. 

4. The Digital Maximum and Digital Minimum in the EDF file are always set to “32767” and 

“-32768”—the maximum resolution of the EDF data format (16-bit integers). 

5. The exporter then normalizes the data set onto the full -32768 to 32767 range, converts it to 

integers, and stores it in the EDF file.  

 

The basic equation is:  

 

EDF = -32768 + 65535 * (OriginalData*SF - PhysicalMin) / (PhysicalMax-PhysicalMin)  

 

So, if you are reading the 16-bit integer values from the EDF file, you must also read the 

physical max/min values and perform the reverse operation manually. 

 

For Example:  

 

OriginalData = (EDF + 32768)*(PhysicalMax-PhysicalMin)/65535 +PhysicalMin 

Using the physical max/min values stored in the EDF header, are essential to properly interpret the 16-

bit samples.

http://www.edfplus.info/specs/edf.html
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TTank Reference 

In the TTank Reference you will find: 

An overview of the Tank Monitor workspace. 
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About TTank 

TTank is a powerful data server that runs behind the scenes anytime you use Synapse to store or 

retrieve data. As data is acquired it is passed to the TTank data server, which indexes and stores the 

data then makes the data available to other client applications.  

Each time you configure an experiment you must specify a new or existing data tank where all data for 

that experiment will be stored in the TDT DataTank format. Synapse can acquire and store various 

types of data that may take the form of a list of scalar values, discrete waveforms (often called snippets 

or segments), or continuous waveforms (often called streamed data). For example, an experiment 

might acquire both spike waveforms and the scalar values of a stimulus variable. Each distinct type of 

data that is acquired is called a Store and is assigned a unique Store name – typically based on the 

Synapse gizmo name. All of the stores identified in the experiment are stored in a single data tank. 

Each tank is logically divided into blocks. These blocks contain all the data from a single recording 

session such as an experimental run. 

The Data Tank Files 
DataTanks and blocks are treated as folder/file structures.  Each new data tank acts as a folder that 

contains multiple block folders. The four files (.tbk, .tdx, .tev, .tsq) associated with each block are 

stored within each block folder. Tanks and blocks can be browsed and managed just as you would with 

other Windows-based folders and files. Individual blocks can be deleted or transferred between tanks 

using standard Windows Explorer methods. However, the underlying file structure for each block 

should always be maintained. If a block must be moved, move the block folder. Never move or delete 

an individual .tbk, .tdx, .tev, or .tsq file. Blocks and files are named with a consistent naming structure 

to help keep blocks intact.  

The following figure shows a Windows Explorer view of a tank folder and its corresponding blocks. 

Note the identifying tank and block icons.  

 

Registering Tanks 

If a tank will be accessed across a network, it must be added to the OpenEx registry. Tanks can be 

registered or unregistered from TankMon.  

Note: there is a limit to the number of tanks that can be registered at one time. 

About Epochs 

The data tank uses a multi-level indexed file structure that aids in rapid retrieval of desired data records 

and record types.  The DataTank format allows sorting by event type and searching for a desired record 

within a specified time interval, rather than searching from the first record in the file to the last.  Events 
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maybe marked in the data set as “epoch” events and an index of these events provides another level of 

rapidly retrieving desired records. 

The Tank Monitor Workspace 

The Tank Monitor workspace provides quick and easy access to TTank. Users can view information 

about TTank activity or perform basic maintenance such as creating new tanks and registering or 

unregistering existing tanks. The upper right corner of the workspace displays basic information about 

the tank selected in the Tank box. 

 

Server Box 

In the Server box users can select the server where data tanks can be found or created. In many cases 

the server will be on the same PC that controls the hardware devices (Local). A green arrow will 

appear to the left of the server name to indicate that it is selected. 

Commands for common tasks such as adding, testing, and removing a server are available from a 

shortcut menu by right-clicking in the Server box. 

Tank Box 

In the Tank box users can select a tank, create a new tank, and register or unregister existing tanks. 

Typically, you must browse for tanks generated in Synapse. To browse for a tank, right-click in the 

Tank window to bring up a shortcut menu. 



TTank Reference 

93 

 

Registered Tank 

Unregistered Tank 

 

 

Browse for Tank Browse for folder. 

Create New Tank Opens the Select Tank file dialog box so that a tank can be added. 

Add Data Tank. 

Register Tank Adds the selected tank to the OpenEx registry. 

UnRegister Tank Removes the selected tank from the OpenEx registry. The tank can 

still be used on the local machine. 

Test Tank Tests the connection to the server and opens and closes the tank 

file. 

Reset Tank Resets the selected tank file. 

Show Full Path Toggles detail view on and off. In details view the path to the tank 

is displayed. 

Refresh Tank List Refreshes the Tank box display. 

Opening an Existing Tank - To open an existing tank, click the Open Existing Tank icon  to 

navigate to the desired tank folder. Note: Clicking OK out of this dialog selects the tank and also 

closes the Select Tank dialog.  

Creating a New Tank - To create a new data tank, click the Create New Tank icon . This opens 

the Add Data Tank dialog. Select a path for the data tank folder and provide a unique name for the 

tank.  

Registering/Unregistering a Tank - Users can register or unregister a tank by right-clicking in the 

Tank box and selecting the appropriate option from the shortcut menu. Unregistering a tank does not 

delete the tank files however, it will no longer be listed in the Tank window. 
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Debug Box 

Select the Debug Active check box to see detailed information about tank activity. 
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OpenController Reference 
(Available in Synapse Suite Only) 

In the OpenController Reference you will find: 

A reference guide to the OpenController Workspace and the basics of adding and modifying 

controls. 

Control Types 

Step-by-step guides to creating the most common control types. 

Control Settings Reference 

An in-depth reference covering many of the control settings available from the Property Dialog 

box. 
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About OpenController 

OpenController is a visual interface for designing and implementing custom controls for Synapse 

experiments. Users  can develop controls to modify parameters or visualize data in real-time. 

OpenController includes a variety of built-in controls; such as gauges, switches, and plots. The 

controls can be roughly grouped according to OpenController's two principal tasks. 

OpenController's primary task is to allow users to control experimental parameters in real-time. 

Parameters, such as filter settings, threshold settings for unit activity, and stimulus presentation 

variables, can be modified from customizable controls. These controls, or modifiers, can send 

values to the system via parameter tags within a compiled circuit file running on a Device. 

OpenController's secondary task is to monitor the acquired data and parameters associated with it. 

Some controls read and display precise parameter values while others read and display data as 

controls or visualization tools in OpenController according to the user's design. 

About Visualization Tools 

Visualization tools are controls that allow users to visualize information that is available within 

the circuit running on a hardware device but is not necessarily stored in the data tank. For 

example, filter settings, RMS level of the signal, and the processing ability of the system can be 

visualized without being stored. The information from these tools can then be used to modify 

stimulus parameters, filter settings, and other properties of a hardware device(s). 

Visualization controls also allow users to quickly see when other controls have been changed. 

Visualization controls can receive variable values from other controls such as sliders, switch 

buttons, and data tables. This allows users to quickly view the parameter changes. 

OpenController includes several plots, similar to those available in Open Scope. For example, the 

scope/pile plot can be used to visualize data such as spike activity and streamed or decimated data. 

While OpenController plots are limited in functionality and can only be used to visualize the data 

as it is acquired, the real-time nature of these plots is a distinct advantage for real-time 

experimental control. OpenScope acquires data from the tank and may have a delay of up to 3 

seconds between acquisition and display. In OpenController the Store information is acquired 

directly from the hardware server so changes in a modifier can be viewed immediately. This 

allows a better match between stimulus presentation and data acquisition.  

About Modifiers 

Modifiers are controls that can be used to control the properties of a circuit or other controls. Most 

often modifiers are used along with visualization controls and modifications are made in response 

to data visualized from one of the available plots. Modifiers can change circuit parameters, such as 

filter settings, thresholds for spike detection, and stimulus parameters. Modifiers can also change 

properties of other controls. For example, a modifier can change what data channel is displayed by 

a visualization control. 

Parameters that may be modified using controls might or might not be saved to the tank. 

Parameters that are not stored in the tank, such as a threshold settings for spike detection, can be 

modified in real-time. Parameter variables that are stored in the tank, such as stimulus parameters, 
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can be accessed through associated parameter tags. If the tags are also associated with stored data, 

the stimulus parameters are modified through the control and saved through the Store 

automatically. 

Modifiers can also send values to other controls. For example, changing the value of a filter with a 

modifier such as a slider can also pass the new value to a visualization control such as a numeric 

display. This allows a user to monitor and modify the display properties of several controls and 

parameters through a single control. 

Understanding Targets 

A target points to the location of the data being read or the location to which a value will be 

written. This location might be an data Store, a parameter tag within a compiled circuit file 

running on a device, or another control setting. Targets are defined in the properties dialog box for 

each control. 

Types of Targets Common Uses Parameter Setting 

Store or data buffer Visualizing data in a plot  Data Target 

Parameter tag Visualizing data in a visualization control Source Target 

Writing value from a modifier control Primary Target 

Control settings Reading a value from another control Source Target 

Writing a value to another control Primary Target 

Note: The attenuation for a PA5 attenuator device can also be selected and set as a target. 

In some controls the Alternate Target parameter can be used to write a value to multiple targets 

(such as parameter tags and visualization controls). 

Selecting Targets 

The target can be selected using the Select Target dialog box. The properties dialog box can be 

displayed by double-clicking the control. 
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The Select Target dialog box can be opened by clicking the  Browse button in the Source 

Target, Primary Target, or Alternate Target boxes in the property settings. In the Select Target 

dialog box, the user can browse through the hierarchy to find the target then click to select it. 

Finally, the selected target can be entered in the property settings by clicking OK. 

Using the Master Channel Parameter 

The Primary Target or Alternate Target can also be the Master Channel parameter. This special 

type of parameter is used to modify the Target channel parameter for a group of controls.  

When used this parameter updates all controls in the same OpenController instance where the 

Target Channel = -1. 

Controlling the Experimental 
Protocol 

OpenController allows user to directly access the Synapse modes (Record, Preview, Standby and 

ldle). A special control called the Master Mode control can be configured to change the Synapse 

mode when the control set is run or stopped in OpenController Run! mode. 

 

The Master Mode control allows the user to tie OpenController's run and stop states to protocol 

mode settings. The run state can be configured to automatically change the protocol mode to 

Record, Preview, or Standby. The stop state can be configured to automatically change the 

protocol mode to Standby or Idle. 

Using the Master Mode control to control the experimental protocol from an OpenController 

control set allows the user greater flexibility during an experiment. For example, the Stop state 

could be linked to Standby mode. In Standby mode the protocol continues to run but no data is 

stored to the tank. The Run state could be linked to Record mode so that when adjustments to the 

control settings are complete and the control is run, recording will resume. 
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If multiple OpenController clients are open the Synapse mode can be updated from any client. 

This ensures that the most recently applied settings are always in effect. 

Master Mode Control Settings 

In the Common parameters group there are drop-down menus for Mode on Run and Mode on 

Stop. These settings allow the user to choose which protocol mode will be selected when the 

control set is run or stopped. 

Mode on Run 

None: The Master Mode control does not change the mode on run. Use this if you want another 

control to determine when to record data. 

Standby: The mode is set to Standby on run. In standby mode the circuit will load and run and 

controls can modify and read data from parameter tags. 

Preview: The mode is set to Preview on run. In Preview mode users can visualize data from 

Stores; however, the Store data is not saved to the tank. Use this mode to look at the data before 

running through an experimental protocol. 

Record: The mode is set to Record on run. In Record mode data is saved to the tank. 

Mode on Stop 

None: The Master Mode control does not change the mode on stop. Use this if you want another 

control to determine the mode on stop. 

Standby: The mode is set to Standby on stop. This allows the circuit to continue running without 

storing data. This is useful to make sure that the proper settings are defined before stimulus 

presentation or data acquisition occurs. 

Idle: The mode is set to Idle on stop. This halts the processing chain on the devices.   

Using Multiple Control Sets 

Use caution when using multiple control clients. If two clients attempt to access the same device 

parameter, it can lead to corruption of the memory map or unreliable data. For example, two 

clients which include a control with the potential to modify the same parameter might be open, but 

only one would be active. Using the Master Mode Control in conjunction with window property 

settings for the Run and Stop buttons give the user the ability to accomplish this. 

Workspace Basics 

About the OpenController Workspace 

The OpenController workspace includes a main grid or display area where multiple controls can 

be added and arranged into a customized control set. The OpenController workspace includes two 

modes: Design mode and Run! mode. Users can toggle between modes using a Toggle Mode 

button on the toolbar. 
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In Design mode users can add, configure, and modify controls. 

 

 
In Run! mode users can use controls for real-time monitoring and control of an ongoing 

experiment. 

 

A menu bar is available in Design mode and toolbars are also provided in both modes for easy 

access to commands. 

Using Design Mode 

Design mode allows users to add and customize groups of controls that will function together in a 

single OpenController configuration file. A menu bar, toolbar, and shortcut menus are available 

for easy access to commands. 

In Design mode the main window is a grid area where controls can be added, sized, and organized 

to create a control set. Controls can be added from the Control menu. 
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Once added, controls can be manipulated similarly to many Windows objects. Users can drag a 

control to move it or drag a control's border to resize it. Note: if controls are deleted in error, Undo 

Last Delete  on the Edit menu (or Ctrl+Z) can be used to restore them. 

 

 

Using Properties Dialog Boxes 

The appearance and behavior of each control can be modified using the properties dialog box. The 

properties dialog box contains all of the customizable settings for a selected control. 

To open the properties dialog box for a control: 

➢ Double-click the control in the grid area of OpenController's Design mode. 
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While all properties dialog boxes look and behave in a similar fashion, the settings available 

depend upon the control being modified. 

Control settings are grouped into parameter groups. The properties dialog box opens with the most 

commonly used settings for the selected control displayed. To display the settings available in 

another group, click the Parameter Group value box at the top of the dialog box and select the 

group from the list. 

 

Target Settings 

When settings, such as Source Target, must be set using the name of a target a  Browse button 

is located to the right of the value box. Clicking the Browse button opens the Select Target dialog 

box. 
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In the Select Target dialog box, a list of available targets in the current experiment is displayed. 

Using the Select Target Dialog Box 

Possible targets are displayed in an expandable hierarchy. Potential targets are grouped into the 

four types: devices, stores, controls and master parameters. Each level of the hierarchy can be 

collapsed or expanded by clicking the expand (+) or collapse (-) symbol to the left of the level. 

Devices 

Under devices, possible targets are grouped by device and are further divided into scalars or 

buffers. The data type of a target is indicated by the color of the target's icon. The user must 

select a target of an appropriate type for the data that will be read. Target names for targets 

found under a Device in the hierarchy include the device name (much like a path to the target). If 

devices are named sequentially (such as: Amp1, Amp2, Amp3) users can select the same target 

across multiple devices by modifying the target name to replace the number found in the last 

position of a device name with an asterisk (*) (such as: Amp*.HPfreq). 

Scalars 

 float Blue 

 integer Teal 

 logic (i.e. 0,1) Green 

Buffers 

 data pink  

 coefficients purple  

Channel Number 
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Scalars and buffers that are followed by a tilde (~) include multiple channels. The user can expand 

them to show and select the channels. Users can select the multi-channel target (such as sEA~) 

rather than a single channel in some cases (such as using multi-view plots). 

Note: coefficients are typically used in spike sorting and filter coefficients. 

Stores 

The Store type corresponds to the data construct type and is indicated by its icon. 

 
Scalar Type 1: Triggered Scalar 

 
Buffer Type 2: Data Buffer 

 
List Type 3: Data List 

 
Snippet Type 4: Signal Snippets 

 
Stream Type 5: Continuous Waveform 

Controls 

Under controls the possible targets are grouped first by control name , then by the setting group 

. Control names correspond to the value in the My Name setting and the groups correspond to 

the parameter groups in the property setting dialog box for that control. The value type for a 

setting is indicated by its icon. The user must select a target of an appropriate type for the 

data that will be read. 

 whole number 

 integer number 

 check box 

 Color 

 drop down list 

Master Parameters 

Under Master Parameters there are three standard targets: master channel, master sort code, and 

master device. These targets allow the user to update key groups of parameter tags with a single 

control. 

 
master channel Note: updates all controls in the same OpenController instance 

where the Target Channel = -1. Appears as @Channel in the 

target parameter in the parameters dialog box. 

 
master sort code Not Implemented 
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master device Not Implemented 

Using Run! Mode 

Run! mode initializes the control client application (OpenController) and allows it to access the 

memory map of the hardware. Because several control sets can be open at a time, it is important to 

ensure that only one or two are accessing the memory map. When multiple OpenController 

windows modify the same parameters, such as stimulus frequencies, the memory map can become 

corrupted. For each parameter tag only one modifier control should be active and running.  

Note: this does not apply to visualization controls. 

In Run! mode the control set can have several states. Understanding and using these states 

correctly can help the user avoid memory map corruption.  

Running and active: 

By default, controls are loaded and active when the user places OpenController in Run! mode. The 

state of the OpenController configuration can then be controlled using the Run and Stop buttons 

on the toolbar. When the controls are running and active the frames around each control's borders 

are gray. 

 

Control set is running. 

In Standby mode, the controls will appear to be running and active (gray borders) but data is not 

read and updated. This may result in blank plot screens in the running and active state. 

Running with one or more controls inactive: 

When the Synapse is not open or its status is idle, the targets will not be found and a yellow border 

appears around the control. In the following example, the target for the SSPK plot can not be 

found because Synapse is Idle. 
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Control set is running and Synapse is Idle. 

The yellow border might also indicate that the wrong synapse experiment is opened or that a target 

was identified incorrectly in the control's property settings. 

Stopped but active: 

An active device can modify parameters but does not acquire data from the memory map. If the 

controls are modified this will modify whatever parameter tag or control property they are linked 

to. However, the visualization tools are halted. The example below shows this state. 

 

Control set is stopped but active and 

Synapse is at Idle. 

Stopped and locked: 

In the stopped and locked state the controls are inactive. A hatched line is placed through the 

controls. In this case the controls can not modify any other devices. To set up a control so that it 

locks when stopped go double-click on the grid and select the Behavior parameter group in the 

properties dialog box, then select Lock on Stop. 
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Control set is stopped and locked, mode is at 

Record. 

 

Saving and Loading your Settings 

OpenController uses a save and load state feature which allows you to retain settings such as slider 

switch positions, sort parameters, and more. Configuring automatic or manual save/load states can 

be done using OpenController’s Setup Default Properties dialog box. 

To open the Setup Default Properties dialog box: 

Double-click the empty grid area of OpenController's Design mode. 

 

Save/Load State  

The Save/Load state setting determines whether or not the controller state will be saved 

automatically or manually. OpenController uses controller state data files (*.csf) to store and load 

settings. 

Two settings are available 

for saving and loading state 

behavior in the Setup 

Default Properties dialog 

box:  

Save/Load State 

Multiple Files. 
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Automatic 

With this setting, automatic saving and loading is performed by OpenController.  

When operating in the automatic setting, OpenController will append the status Save/Load Auto 

to the controller title bar when the default save state is saved or loaded. 

 

The NO FILE LOADED status is also appended if a save state has not yet been loaded. 

 

While in Run! mode, OpenController will automatically save and load controller settings. 

If the Multiple Files setting (below) is enabled, controller will prompt you to save to a specified 

*.csf file whenever you change from run to design mode and will also prompt you to specify a 

*.csf file to load whenever you change from design to run mode. With this setting active, the 

currently loaded save state file name will be appended to the title bar. 

 

Manual 

With the Manual setting, saving and loading is performed using the save and load state buttons 

while in Run! Mode.  

 
Saves the current control parameter settings to the default controller state data file. 

 
Loads the last saved control parameter settings from the default controller state data file. 

When operating in the manual setting, OpenController will append the status Save/Load Manual 

to the controller title bar when the default save state is saved or loaded. 

 

The NO FILE LOADED status is also appended if a save state has not yet been loaded. 

 

If the Multiple Files setting (below) is enabled, controller will prompt you to specify a *.csf file 

whenever you save or load the controller state. With this setting active, the currently loaded save 

state file name will be appended to the title bar. 

 

Multiple Files 

The Multiple Files setting allows multiple controller states to be saved, each in a separate 

controller state data file (*.csf ). Saving multiple files allow different states to be saved for 

different experimental subjects or conditions.  
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Control Types 

Control Types and the Controls Menu 

Controls can be added from the Controls menu and are organized into submenus groups by type.  

Group Control Type 

Numeric Displays Value Watch 

7 Segment Display 

Gauges Linear Gauge 

Logarithmic Gauge 

Status Indicators Led Indicator  

Led Caption 

Value Input Input Box 

Switches Switch Button  

Slide Switch 

Sliders/Knobs Knob  

Slider 

Plots/Graphs Scope/Pile Plot  

Chart Plot  

Scrolling Plot  

Feature Plot 

Tables/Scripting Data Table  

VBScript 

Miscellaneous Graphic Frame 

Advanced Controls Master Mode Control  

SigGen Engine  

Biquad Coefficient Generator  

Snippet Sort Control  

Scrolling Threshold Control 

Container 
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Visualization Tools 

About Gauges 

A gauge displays real-time changes to a variable. Gauges provide an excellent way to determine if 

parameter properties are within the experimental bounds. For example, a gauge could show spike 

activity (spikes per second), RMS (root mean square) noise on a channel, or the calibrated 

intensity of a stimulus. The advantage of using a gauge rather than a digital display is that the 

gauge can be color coded to indicate when the parameter is within a reasonable zone. During an 

experiment the precise value may be less important than whether it is below or above a certain 

value. 

  

Linear Gauge 

In this example, the control is configured to show the 

RMS (Root Mean Square) noise of the acquisition 

channel along with color coding to indicate when the 

RMS level has become too high. Green indicates 

good, yellow indicates caution or watch, and red 

indicates that the noise level is too high. 

Before using a gauge the user should determine what variable is to be measured. This variable 

must either be a Store or have a parameter tag associated with it. 

OpenController includes both linear and logarithmic gauges. The user should select the 

appropriate gauge depending on the type of data to be visualized. Both types of gauges are created 

in a similar way. 

Creating a Linear Gauge 

To quickly create a linear gauge: 

1. Click the Controls menu, point to Gauges, and click Linear Gauge. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 
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Settings groups include: 

Common - pg. 179 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Layout - pg. 188 

Scale - pg. 191 

Pointer - pg. 166 

Sections - pg. 167 

4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Using the Select Target dialog browse for and select a target. 

6. If the source target is a Store with multiple channels, enter the channel number in the 

Target Channel box. 

7. In the Scale Minimum box, enter the minimum value for gauge values that will be 

displayed. 

8. In the Scale Maximum box, enter the maximum value for gauge values that will be 

displayed. 

9. Click OK. 

A basic linear gauge is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Logarithmic Gauge 

To quickly create a logarithmic gauge: 

1. Click the Controls menu, point to Gauges, and click Logarithmic Gauge. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 
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The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 180 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Layout - pg. 189 

Scale - pg. 191 

Pointer - pg. 166 

Sections - pg. 167 

 

4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

6. If the source target is a Store with multiple channels, in the Target Channel box, enter 

the channel number. 

7. In the Scale Minimum box, enter the minimum value for gauge values that will be 

displayed. 

8. In the Scale Maximum box, enter the maximum value for gauge values that will be 

displayed. 

9. Click OK. 

A basic logarithmic gauge is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 

 

About Numeric Displays 

Numeric displays show a precise variable value. A common use of a display would be to show the 

filter settings of the signal input, the exact threshold setting for a discriminator, or the sweep 

number of the stimulus. 

Before running the control, the corresponding Synapse experiment  must be running.  

There are two types of numeric displays, the Value Watch and the 7 Segment Display. 
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7 Segment Display Value Watch 

Both displays work similarly and vary mostly in appearance. The 7 Segment Display is styled to 

appear similar to a typical LCD numeric display. There are also two small but perhaps more 

significant differences. The Value Watch allows unit text to be added to the display by the user. 

The 7 segment display allows the display of a positive or negative sign. 

Creating a 7 Segment Display 

To quickly create a 7 segment display: 

1. Click the Controls menu, point to Numeric Displays, and click 7 Segment Display. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 173 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Appearance - pg. 168 

Layout - pg. 188 

 

4. In the Source Target box, click the  button, to display the Select Target dialog box. 

5. Browse for and select a target. 

6. If the source target is a Store with multiple channels, in the Target Channel box, enter 

the channel number. 
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7. In the Number Digits box, enter the number of digits to be displayed. 

 

By default, the leading unused digits will be displayed as spaces. The total number of 

digits should be sufficient to display the desired precision. 

8. In the Precision box, enter the number of digits to be displayed after the decimal point. 

9. Click OK. 

A basic 7 segment display is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Value Watch 

To quickly create a value watch: 

1. Click the Controls menu, point to Numeric Displays, and click Value Watch. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 187 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Appearance - pg. 170 

4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

6. If the source target is a Store with multiple channels, in the Target Channel box, enter 

the channel number. 

7. In the Precision box, enter the number of digits to be displayed after the decimal point. 
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8. Click OK. 

A basic value watch is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 

About Status Indicators 

Status indicators can be used to indicate when the level of a signal is greater than a certain value. 

These indicators flash when the value change exceeds an On/Off threshold set by the user. Similar 

to a gauge, the status indicator allows users to identify a potentially important issue. For example, 

the indicator can be set to flash if the processing power of the system exceeds a certain level. 

There are two types of indicators, the Led Indicator and the Led Caption. 

  

Led Indicator 

  

Led Caption 

The led indicator resembles a typical round LED light with a text caption to the side. With a led 

caption, the caption text is part of the flashing display. 

Creating a Led Indicator 

To quickly create a led indicator: 

1. Click the Controls menu, point to Status Indicators, and click Led Indicator. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 
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Settings groups include: 

Common - pg. 179 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Appearance - pg. 168 

4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

6. In the On/Off Threshold box, type the threshold. If the value change is greater than the 

threshold, the indicator will be toggled off or on. 

7. Click OK.  

A basic led indicator is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Led Caption 

To quickly create a led caption: 

1. Click the Controls menu, point to Status Indicators, and click Led Caption. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 
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Settings groups include: 

Common - pg. 178 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Appearance - pg. 168 

4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

6. In the Threshold box, type the threshold. If the value change is greater than the 

threshold, the indicator will be toggled off or on. 

7. Click OK. 

A basic led caption control is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

Plots and Graphs 

About Plots and Graphs 

OpenController plots and graphs are used to visualize data in real-time. Plots and graphs differ 

from other controls in that the Source Target must be a data Store. Plots and graphs can be used in 

conjunction with controls that modify parameters so that changes in the data that might result from 

modifying a parameter, such as a filter or threshold settings, can be viewed without delays. There 

are four standard types of plots and graphs available in OpenController: Scope/Pile, Chart, 

Scrolling, and Feature. 

Scope and Pile Plots 

The Scope/Pile plot acts like a triggered oscilloscope. When an event such as a set time trigger or 

epoch event occurs the waveform data is displayed in the graph. If the waveform is small (<100 

points) the values can be plotted on top of each other (pile) so that a quick comparison can be 

done. The user can set the depth of the pile. For very large waveforms (>100 points) setting the 

pile depth to one displays a single continuous waveform. 

Chart Plot 

The Chart plot displays time stamped values. The data streams across the graph either 

continuously or synced to an external event. The chart plot is excellent for viewing the distribution 
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of time stamped events such as wave snippets, epoch events (Data Lists), or buffered signals. It 

can be expanded and contracted to show a larger or smaller times. 

Scrolling Plot 

The Scrolling Plot is similar to a chart recorder. The waveform streams across the plot window 

from left to right. This is an excellent tool for visualizing continuous signals such as EEG 

waveforms or the plot decimated signals of an extracellular recording. 

Feature Plot 

The Feature Plot measures two signal properties of a snippet waveform and displays them as a 

scatter plot. This tool is excellent for data mining of multiple unit activity. The feature plot can 

display comparisons of waveform features such as total amplitude, peak amplitudes, the area 

under the curve, and peak-to-peak time differences. 

Creating a Pile Plot 

To quickly create a single channel pile plot: 

1. Click the Controls menu, point to Plots/Graphs, and click Scope/Pile Plot. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 182 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Set - pg. 165 

Behavior - pg. 172 

Channel Selector - pg. 165 

Multi View - pg. 166 

Colors - pg. 165 

Refresh Control - pg. 166 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 

Filtering - pg. 166 

4. In the Data Target box, click the  Browse button, to display the Select Target dialog 

box. 
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5. Browse for and select a target. 

 

The source target should be a data Store. To create a pile plot the source target should be 

a signal snippet. 

 
Tip: look for this icon to identify snippets in the Select Target dialog box. 

6. in the Target Channel box, enter the desired channel. 

7. If the data includes a sort code (uses the Sort Spike component) select the By SortCode 

color-coding method in the Category Coloring box. 

8. Click OK. 

A basic pile plot is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 

At this point a plot of the spikes will appear and the pile plot will look something like this: 

 

Common Modifications 

Multi View 

If the Store has multiple channels, select the Multi View Enabled check box then enter the number 

of channels in the Num Views box. The example below enables the Multi View and selects the 

number of channels (3) for visualization. 

 

Scope Plot 

The Scope/Pile Plot control can also be configured to behave as a Scope plot.  
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Creating a Scope Plot 

To quickly create a single channel scope plot: 

1. Click the Controls menu, point to Plots/Graphs, and click Scope/Pile Plot. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 182 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Set - pg. 165 

Behavior - pg. 172 

Channel Selector - pg. 165 

Multi View - pg. 166 

Colors - pg. 165 

Refresh Control - pg. 166 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 

Filtering - pg. 166 

4. In the Data Target box, click the  Browse button, to display the Select Target dialog 

box. 

5. Browse for and select a target. 

 

The source target should be a data Store. To create a scope plot a continuous data type 

should be selected. 

 
Tip: look for this icon to identify continuous waveform in the Select Target 

dialog box. 

6. In the Target Channel box, enter the desired channel. 

7. Set the Pile Depth to 1. This will cause the screen to update on each block. 

8. Click OK. 

A basic scope plot is created.  

Before running the control, the corresponding Synapse experiment  must be running.  
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To run the control: 

➢ Click Run! on the menu bar. 

At this point the plot will look something like this: 

 

The plot length or number of points is set in the compiled circuit file by the data construct. 

Changing the amount of data viewed requires changing the block size in the oxStream component.  

Creating a Chart Plot 

To quickly create a single chart plot: 

1. Click the Controls menu, point to Plots/Graphs, and click Chart Plot. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 175 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Set - pg. 165 

Behavior - pg. 170 

Channel Selector - pg. 165 

Multi View - pg. 166 

Colors - pg. 165 

Refresh Control - pg. 166 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 
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4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

 

The source target should be a data Store. Chart plots are often used to view snippets. 

 
Tip: look for this icon to identify snippets in the Select Target dialog box. 

6. If the source target is a Store with multiple channels, in the Target Channel box, enter 

the channel number. 

7. Click OK. 

A basic chart plot is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Scrolling Plot 

To quickly create a scrolling channel plot: 

1. Click the Controls menu, point to Plots/Graphs, and click Scrolling Plot. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 



OpenEx Supplement for Synapse Users 

124 

 

Settings groups include: 

Common - pg. 182 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Set - pg. 165 

Behavior - pg. 172 

Channel Selector - pg. 165 

Multi View - pg. 166 

Refresh Control - pg. 166 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 

 

4. In the Data Target box, click the  Browse button, to display the Select Target dialog 

box. 

5. Browse for and select a target. 

6. The source target should be a data Store. Scrolling plots are most commonly used with 

continuous waveforms. 

 
Tip: look for this icon to identify continuous waveform in the Select Target 

dialog box. 

7. Enter the desired channel in the Target Channel box. 

8. Click OK. 

A scrolling plot is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

 

Creating a Feature Plot 

A feature plot is used to display two waveform properties and is an excellent tool for separating 

waveforms. Waveforms that are different will be in separate parts of the feature space. Feature 

space plots use snippet Stores (Type 4, Signal Snippet) or possibly buffer Stores (Type 2, Data 

Buffer) to display differences.  
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The data Store should contain less than 100 samples per waveform. Waveforms that are too large 

will increase the processing time and slow down the system. 

1. Click the Controls menu, point to Plots/Graphs, and click Feature Plot. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 176 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Set - pg. 165 

Behavior - pg. 171 

Channel Selector - pg. 165 

Multi View - pg. 166 

Colors - pg. 165 

Refresh Control - pg. 166 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 

Filtering - pg. 166 

4. In the Source Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

 

The source target should be a data Store. 

6. In the Target Channel box, enter the desired channel. 

7. Set the Cloud Points to 100. This will cause the screen to display the 100 most recent 

points. 

8. Set the X-axis feature (Total Amplitude, Peak 1, Peak 2, Peak to Peak Time, or Area) 

9. Set the Y-axis feature (Total Amplitude, Peak 1, Peak 2, Peak to Peak Time, or Area) 

10. Select the Category Coloring, either by SortCode or by Channel. 

11. Click OK. 

A feature plot is created.  

Before running the control, the corresponding Synapse experiment  must be running.  
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To run the control: 

➢ Click Run! on the menu bar. 

In the example below a sort spike plot generates sort codes based on a time-amplitude windows. 

The feature space of the two plots based on peak 1 and peak 2 is displayed on the feature plot on 

the right. 

 

Modifiers 

About Value Inputs 

Value inputs are used to modify a variable. In the input box, users input the variable and press the 

send arrow to change the value of a parameter tag. Value inputs can be used to set filter values, a 

single frequency or intensity value that will change, or a number such as the number of sweeps 

between stimuli. 

 

Input Box 

Creating an Input Box 

To quickly create an input box: 

1. Click the Controls menu, point to Value Input, and click Input Box. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 
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Settings groups include: 

Common - pg. 177 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Value Control - pg. 193 

Appearance - pg. 168 

Behavior - pg. 171 

4. In the Primary Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

6. Click OK. 

A basic value input is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar.  

About Switches 

Switches are used to toggle a variable between user specified values. There are three types of 

switches, the Switch Slider, the Switch Button and the Momentary Button. Users click a button or 

drag a slider to toggle the value sent to a parameter tag. 

The Switch button and Momentary button have two values while the slider button can have 

multiple values. Clicking a Switch button toggles between the two values. Clicking a Momentary 

button turns the control on for a user specified length of time. 



OpenEx Supplement for Synapse Users 

128 

 

 

Slide Switch Switch/Momentary Button 

Creating a Switch Button 

To quickly create a switch button: 

1. Click the Controls menu, point to Switches, and click Switch Button. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 186 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Value Control - pg. 193 

Appearance - pg. 170 

Behavior - pg. 173 

4. In the Primary Target box, click the  Browse button, to display the Select Target 

dialog box. 
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5. Browse for and select a target. 

6. In the Button Text box, type text to be displayed on the button. 

7. In the Value when On box, specify a value for when the switch is on. 

8. In the Value when Off box, specify a value for when the switch is off.  

9. Click OK. 

A basic switch button is created.  

Before running the control, the corresponding Synapse experiment  must be running.  

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Momentary Button 

To quickly create a momentary button: 

1. Click the Controls menu, point to Switches, and click Momentary Button. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 181 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Value Control - pg. 193  

Appearance - pg. 170 

Behavior - pg. 172 

4. In the Primary Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Using the Select Target dialog browse for and select a target. 
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6. In the Button Text box, type text to be displayed on the button. 

7. In the Value when On box, specify a value for when the button is on. 

8. In the Value when Off box, specify a value for when the button is off.  

9. Click OK. 

A momentary switch button is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Slide Switch 

To quickly create a Slide Switch: 

1. Click the Controls menu, point to Switches, and click Slide Switch. 

2. The pointer changes to indicate that the control can be added. 

3. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

4. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 185 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Value Control - pg. 193 

Appearance - pg. 169 

Layout - pg. 189 

Switch Position - pg. 167 

 

5. Click the Primary Target box, to display the Select Target dialog box. 

6. Browse for and select a target. 

7. In the Position Labels box, enter the desired values. 

 

Labels are separated by a comma and are used as points for selecting labels. 
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8. In the Position Values box, enter the desired values. 

 

Values are separated by a comma and are used as points for selecting values. 

9. Click OK. 

A basic slide switch is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar.  

 

About Sliders and Knobs 

Sliders and knobs are used to modify a variable. Users input the variable valuable by dragging a 

slider or turning a knob. This allows the user to select a value from a range of values and to 

determine the desired value by making small adjustments. Sliders and knobs can be used to set 

values such as frequencies or intensities. Sliders and knobs vary primarily in appearance. 

  

Slider 

  

Knob 

Creating a Slider 

To quickly create a slider: 

1. Click the Controls menu, point to Sliders/Knobs, and click Slider. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 



OpenEx Supplement for Synapse Users 

132 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 184 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Value Control - pg. 193 

Appearance - pg. 169 

Scale - pg. 191 

Behavior - pg. 172 

4. In the Primary Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Using the Select Target dialog browse for and select a target. 

6. In the Position Max box, enter the maximum value to be displayed for the slider. 

7. In the Position Min box, enter the minimum value to be displayed for the slider. 

8. In the Tick Precision box, enter the desired step. 

9. Click OK. 

A basic slider is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 

Creating a Knob 

To quickly create a knob: 

1. Click the Controls menu, point to Sliders/Knobs, and click Knob. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 
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settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 177 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Value Control - pg. 193 

Appearance - pg. 168 

Layout - pg. 188 

Scale - pg. 166 

4. In the Primary Target box, click the  Browse button, to display the Select Target 

dialog box. 

5. Browse for and select a target. 

6. In the Scale Minimum box, enter the minimum value for the knob. 

7. In the Scale Maximum box, enter the maximum value for the knob. 

8. In the Label Precision box, enter the desired precision. 

9. Click OK. 

A basic knob is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 

Spike Discrimination and Sorting 

About Spike Discrimination and Sorting 

With OpenController, users can automatically set spike discrimination thresholds and sort spikes 

in real-time. The automated features of the Snippet Sort controls allow users to quickly assess unit 

activity across multiple channels without resorting to a tedious process of manually setting the 

threshold and then sorting spikes for each channel on a high channel count system. Once the 

system has set the threshold and done spike sorting, users can assess the quality of the process and 

manually modify the threshold and sort windows. 

The Scrolling Threshold control implements control of the threshold level for discriminations and 

Snippet Sort implements time-voltage window sorting.  
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Creating a Scrolling Threshold Control 

To quickly create a scrolling threshold control: 

Note: Before creating the control, start Synapse and open an experiment which includes a Store 

for spike sorting.  

1. Click the Controls menu, point to Advance Controls, and click Scrolling Threshold 

Control. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

4. The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 183 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Select - pg. 165 

Behavior - pg. 172 

Channel Selector - pg. 165 

Refresh Control - pg. 190 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 

Colors - pg. 165 

 

5. Select a valid target for the control and make any other property setting changes as 

needed. 

 

To select the target: 

a. In the Data Target box, click the  Browse button. The Select Target dialog 

box opens 

b. In the target hierarchy, expand the Stores tree and select the correct Store name 

(such as a snippet Store or a plot decimated Store).  
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6. To select the Threshold Target: 

a. In the Threshold Target box, click the  Browse button. The Select Target 

dialog box opens. 

b. In the target hierarchy, expand the Devices tree and select the correct Device 

name (that is, the Device running a circuit which includes the signal snippet with 

spike sorting data construct). 

c. Expand the Scalars tree and select the parameter tag that will serve as the target 

for the threshold. To set the target for all channels select the tag without the 

channel number (for example: aEa~). To set the tag for only one channel, 

expand the hierarchy to display the available channels and select the tag for the 

desired channel (for example: aEA~1). 

 

Note: To set the parameter for multiple devices running the same circuit, modify 

the target name by removing the device component (for example: aEa~ NOT 

Amp1.aEa~). 

7. Click OK. 

Note: If the stream is stored with a different resolution than 32-bit, it will usually be scaled. Be 

sure to set the Threshold Scaling Factor (located in Setup Properties, Parameter Group Behavior) 

to the inverse of the scale factor used by the component performing the data compression.  

For example, if the scale factor (SF) of a PlotDec16 component is set to 1e+006, be sure to set the 

Threshold Scaling Factor to 1e-006. 

A scrolling threshold control is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar. 
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Creating a Snippet Sort Control 

To quickly create a snippet sort control: 

Note: Before creating the control, start Synapse and open a configuration file which includes a 

Store for spike sorting.  

1. Click the Controls menu, point to Advance Controls, and click Snippet Sort Control. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 185 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Data/Source Select - pg. 165  

Behavior - pg. 173 

Channel Selector -  pg. 165 

Refresh Control - pg. 190 

Scaling - pg. 166 

X-Axis Setup - pg. 167 

Appearance - pg. 169 

Colors - pg. 165           

Filtering - pg. 166 

4. Select a valid target for the control and make any other property setting changes as 

needed.  

 

To select the target: 

a. Click the  Browse button in the Data Target box. The Select Target dialog 

box opens. 

b. In the target hierarchy, expand the Stores tree and select the correct Store name 

(that is, the Store which includes the signal snippet with spike sorting data 

construct). 
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c. Click OK. 

A snippet sort control is created.  

Before running the control, the corresponding Synapse experiment  must be running.   

To run the control: 

➢ Click Run! on the menu bar.  

Using the Scrolling Threshold and Snippet Sort Controls 

When a protocol is running, spike discrimination and sorting can be accomplished from 

OpenController using the Scrolling Threshold control and the Snippet Sort control. Typically, 

these controls are used together allowing the user to set the spike threshold while viewing a 

pattern of spike activity in one plot and sort spikes while viewing candidate waveforms in another. 

To use the scrolling threshold and snippet sort control: 

1. Start Synapse and Run the Controller.  

2. Click the  Toggle Mode button or the  Run button on the toolbar to run the 

control 

 

The Scrolling Threshold control is animated with scrolling waveform data and a 

threshold marker (green line) is displayed for spike discrimination.  

To set the threshold automatically: 

➢ Right-click the plot and click Auto Threshold or Auto Threshold All on the shortcut 

menu. 
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Auto Threshold - sets a threshold for the current channel. 

Auto Threshold All - sets a threshold for all channels with the target defined in the control's 

properties. 

The auto-thresholding feature acquires information about the signal to noise ratio of the signal 

and, based on the size of the signal, determines an optimal threshold that will detects any signal 

activity above the noise floor. If the spike size is large then the threshold will be set higher than if 

the spike size is small. A fixed signal to noise level can be set by modifying the control's Behavior 

parameters. 

The direction of the threshold discriminator depends on the specified Threshold Target. Typically 

the target is the Threshold parameter of a SortSpike2 component and, by default, the threshold is 

unidirectional and will be adjusted based on +/- values. A bidirectional threshold can be specified 

by modifying the Use Sign parameter of the SortSpike2 component. 

When needed, the threshold can also be set or adjusted manually. See Using the Scrolling 

Threshold and Snippet Sort Controls Manually, page 139 for more information. 

The Snippet Sort control is animated with snippet waveforms and a threshold marker (green line) 

is displayed for the window discriminator. Because threshold is controlled from the Scrolling 

Threshold control, the user need not adjust this marker. If SortSpike is used, an upper threshold 

(pink line) might appear. This marker is controlled manually.  

 

To sort spikes automatically: 

➢ Right-click the plot and click Auto Sort or Auto Sort All on the shortcut menu. 
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Auto Sort - sorts spikes for the current channel. 

 

Auto Threshold All - sorts spikes for all 

channels in the data target (Store) defined in the 

control's properties. 

 

The auto-sort feature uses a basic system for determining the number of potential units acquired 

on a channel. A simple algorithm is used to separate out candidate spikes. A series of cumulative 

frequency plots of the voltage distribution at each time interval is generated. Distributions that 

have inflection points (i.e. that are bimodal or multimodal) will be used to determine the time 

voltage window. 

While sorting is ongoing a progress bar is displayed. When sorting is complete, time-voltage bars 

are added and positioned automatically. 

 

Note: Gray traces are snippets that will be recorded as unassigned. The sort code value for these 

snippets is set to 0. 

When needed, the spikes can also be sorted manually.  

Using the Scrolling Threshold and Snippet Sort Controls Manually 

When a protocol is running, manual spike discrimination and sorting can be accomplished from 

OpenController using the Scrolling Threshold control and Snippet Sort control. While these two 

controls are designed to be used together they can also be used independently. This section 

provides information about using these controls for manual discrimination and spike sorting. 

Manual operation is most often used to make adjustments to the automated threshold and sorting 

results.  
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Scrolling Threshold Control 

When this control is run a threshold marker is displayed. If the threshold marker is not shown, it 

can be displayed using auto threshold or by pressing and holding down the Shift key and dragging 

the mouse up or down to adjust the plot scale. Ctrl + double-click can sometimes be used to 

display the threshold marker. Dragging a marker across the edge of the plot will remove the 

marker. A confirmation message will be displayed before the marker is removed. 

To set the threshold manually: 

➢ Drag the threshold marker into position. This defines the desired magnitude range of the 

waveforms. The direction of the threshold marker (green bar) depends on the specified 

Threshold Target. Typically the target is the Threshold parameter of a SortSpike2 

component and, by default, the marker is unidirectional and will be adjusted based on +/- 

values. A bidirectional marker can be specified by modifying the Use Sign parameter of 

the SortSpike2 component. If a SortSpike component is used the threshold bar typically 

implements the low threshold.  

 

Note: A pink threshold marker might sometimes be seen. This marker should not be used. 

Snippet Sort Control 

When this control is run one or more threshold markers are displayed for the window 

discriminator. As in the Scrolling Threshold control, the direction of the primary threshold marker 

(bar slightly above the signal waveform in the previous diagram) depends on the specified 

Threshold Target (see Using the Scrolling Threshold and Snippet Sort Controls, page 137  for 

more information).  

Note: the primary threshold marker in the Snippet Sort and scrolling threshold controls should be 

used to control the same target. Moving the marker in one control should move the marker in the 

other control. 

When a SortSpike2 or SortSpike3 component is used only one threshold maker is needed. If a 

SortSpike component is used both low (green bar) and high (pink bar) thresholds can be 

implemented. If two threshold markers are needed and only one marker is displayed, press and 

hold down the Shift key and drag the mouse up or down to adjust the plot scale until the second 

marker is in view. If no threshold markers appear, Ctrl + double-click can be used to add the 

markers. For an alternate method of displaying the upper threshold marker, see Implementing 

Artifact Rejection, page 142. 

To set the window discriminator: 

➢ Drag the threshold markers into position to define the desired magnitude range of the 

waveforms. In the following example, the green marker (lower bar) is the lower threshold 

and the pink marker (topmost bar) is the upper threshold. To acquire only events within a 

range, the pink and green markers are positioned so that a voltage window is created. 
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To add a time-voltage window: 

➢ Hold down the control key and double-click in the center of the sort spike control. 

 

Note: Grey traces are snippets that will be recorded as unassigned. The sort code value for these 

snippets is set to 0. 

To assign sort codes to visually identified spikes: 

➢ Drag the time-voltage window sorter into position and resize the length of the bar as 

needed.  

When the sorter is positioned the color of the snippets that pass through the sorter changes to 

match the color of the bar. Additional time-voltage windows can be added in the same way. 
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To remove a time-voltage window: 

➢ Drag it off the edge of the control until the pointer changes to a small trash can. A 

message will be displayed to request confirmation of the deletion. 

 

Note: The Snippet Sort control can only be used if a SortSpike, SortSpike2, or SortSpike3 

component is included in the data generating construct. In the signal snippet construct the 

Sort_Code flag must be set to YES. The Scrolling Threshold control can be used with all spike 

components.  

If SortSpike or FindSpike are used, only the low threshold is controlled using the Scrolling 

Threshold Control. The high threshold for SortSpike can be controlled in the Snippet Sort Control.  

Determining Sort Codes 

The spike sorting components sort spikes using time/voltage window discriminators.  
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SortSpike and SortSpike2 

For the SortSpike and SortSpike2 components, a distance algorithm (distance from the center of 

the window) is calculated for waveforms that pass through two or more windows to determine 

which sort code value should be assigned. 

For example, in the OpenEx Snippet Sort Control figure below, there are two time/voltage 

window discriminators. All but one spike passes through both of the windows. Since these spikes 

pass closer to the center of window 2, they are all given sort code 2 (coded in red). If any of these 

spikes had passed closer to the center of the yellow window, they would have been given sort code 

1 (yellow). The spike that did not pass through either of the windows is given sort code 0 (white). 

Spikes passing through only Window 1 would be given sort code 1 and spikes passing through 

only window 2 would be given sort code 2. 

 

SortSpike3 

SortSpike3 uses a different method to determine the sort code value. This component generates a 

sort code from ORing together a series of bits based on all of the windows the waveform passes 

through. 

The bit set for a particular window is determined by the following relationship: 

2P

( WindowNum – 1 ) 

where WindowNum is determined by the order in which the windows are added in OpenEx. The 

distance measure discussed earlier is not used in this scheme. 

For example, again in the following figure we have two time/voltage window discriminators. 

Spikes that only pass through Window 1 are given sort code 1 (yellow). Spikes that only pass 

through Window 2 are given sort code 2 (red). Spikes that pass through both Window 1 and 

Window 2 are given sort code 3 (light blue). 
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Since OpenEx will display 16 unique colors for the sort code values, no more than four 

time/voltage window discriminators should be used when using this component with OpenEx. 

Implementing Artifact Rejection through OpenController 

When OpenController's spike detection feature is implemented using the SortSpike component, 

auto thresholding can be used to set the minimum threshold for spike detection (green threshold 

bar). Artifact rejection, however, is implemented by setting a maximum threshold value. The auto 

threshold feature does not set this value and does not display the maximum threshold or artifact 

rejection marker (pink threshold bar). To control the artifact rejection threshold and display the 

marker in the plot, you can set the value of the tag going into the second threshold line of the 

SortSpike component. One way to do this is to control the value using a slider.  

Use the following steps to set the high threshold and display the threshold marker: 

1. In Controller, click the Controls menu, click sliders/knobs, and click slider. 

2. Click the workspace to add a slider, then double-click the new control to open the 

properties dialog box.  

3. In the Primary Target box, click the  Browse button.  

4. Select Devices, Amp1, Scalar, bEA~ and click OK. 

5. Enter a Position Max of 0.005 and a Position Min of 0. 

6. Enter a Tick Precision of 4. 

7. Save the changes and run the experiment and control. 

8. Right-click the Scrolling Threshold plot (not the Snippet Sort Plot) and select Auto 

Threshold. 

9. The green threshold marker will appear in both the scrolling threshold and snippet sort 

plots 

10. Use the slider to set an upper threshold. This also brings the second threshold (pink) 

marker into view in the Snippet Sort plot. Note that you cannot set the artifact rejection in 

the Scrolling Threshold plot. A pink marker might be seen but is not implemented. 

11. After the threshold marker is in view you can continue to set the value using the slider or 

adjust the value in the Snippet Sort control. 
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Master Mode  

About the Master Mode Control 

The master mode control can be used to access the synapse mode controls from OpenController. 

The Run! mode toolbar in OpenController includes Run and Stop buttons. Each of these buttons 

can be linked to Synapse control modes. The Run button can be linked to the Record, Preview, or 

Standby mode. The Stop button can be linked to the Standby or Idle mode. 

For example, the Stop button could be linked to the Standby mode. In Standby mode the 

experiment continues to run but no data is stored to the tank. The Run button could be linked to 

the Record mode so that when adjustments to the control settings are complete and the control is 

run, recording will resume. 

 

Master Mode Control 

Creating a Master Mode Control 

To quickly create a Master Mode control: 

1. Click the Controls menu, point to Advanced Controls, and click Master Mode 

Control. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 181 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Behavior - pg. 171 

4. Click the Mode on Run box and select the protocol mode to be used when the 

OpenController Run button is clicked. 
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5. Click the Mode on Stop box and select the protocol mode to be used when the 

OpenController Stop button is clicked. 

6. Click OK. 

The Master Mode Control is created. Before the control can be used a synapse experiment must be 

open. 

Data Tables 

Creating a Data Table 

To quickly create a data table control: 

1. Click the Controls menu, point to Tables/Scripting, and click Data Table. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

 

 

3. Right-click cell C5 to open the Select Target dialog box. 

4. Using the Select Target dialog, browse for and select a target for the data values that will 

be entered in column C. 
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5. Click OK. 

6. Click cell C6 and enter the desired data value for the target selected in cell C5. 

 

Note: values in the Data Table are displayed with a precision of 1. However, the actual 

value is retained. For example: a value of 0.0001 is displayed as 0.0, but 1.0001 will be 

passed to the target. 

7. To move to cell C7 press the DOWN ARROW key. 

8. Enter the remaining data values in the subsequent cells in column C. 

9. Enter the desired number of repetitions for each value in the corresponding cell in 

column A. 

 

 

A basic data table control is created. The user can add additional targets in subsequent columns. 

By default, the Ordering Scheme is manual, and the user controls the order in which table entries 

are utilized by clicking a row header while the control is running. 
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Synchronizing the Data Table 

The data table may be used to send any type of data to parameter tags within the compiled circuit 

file. Typically, the data table will be used to control some aspect of a stimulus presentation. To 

ensure that the data values are sent at an appropriate time the data table should be synchronized 

with some target, such as the sweep number. The table can be synchronized by modifying the 

control property settings. 

To synchronize the data table with a target: 

1. To display the properties dialog box, double-click the control. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 175 

Target(s) - pg. 192 

Caption/Border - pg. 164 

Polling - pg. 189 

Behavior - pg. 171 

2. Click the Ordering Scheme arrow and choose a scheme from the list. 

3. Select Sequential to send row values sequentially, Random to send row values in the 

same psuedo-random pattern, Manual to select rows manually, Sync Tag to use a tag to 

select the row, or Seeded Random to send row values in a random pattern. 

4. Click the Synchronization Type arrow and choose a type from the list. 

5. Select On Tag Change to send data values when ever the synchronization target changes 

or On Tag True to send data when ever the synchronization target value equals true. 

6. In the Synchronization Target box, click the  Browse button and browse for a 

synchronization target in the Select Target dialog box. 

7. Click OK to return to the properties dialog box. 

8. Click OK to update the control with the modified settings. 

The data table is now synchronized with a target and all rows will be used according to the 

selected ordering scheme. To use only selected rows click the row headers (use SHIFT + click to 

select adjacent rows or CTRL + click to select non adjacent rows) before running the control.  

Using Formulas 

The data table control supports the use of formulas and functions similarly to a Microsoft Excel 

spreadsheet. Formulas can be entered in any cell and may include cell references, such as =B2. 
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Each formula must start with an equals sign and may include standard math operators such as * 

(multiply) and / (divide) or functions such as SUM and AVG (average).  

The first four rows of the table are reserved for comments or reference values. The user can use a 

formula and cell references to multiply table values by some constant. For example, a value in cell 

B1 could be referenced in a formula for the repetition values in column A as in the table below. 

All repetition values can then be changed by changing the constant in cell B1.  

Note: the table displays formula results not formulas as in the example below. 

 

 A B C D 

1 Repeat Constant 20   

2     

3     

4     

5 Repeats Rem RP2(1).Freq ... 

6 =B1  500  

7 =2*B1  900  

8 =B1  1500  

9 =2*B1  1800  

 

VBScriptEx 

About VBScriptEx 

The VBScriptEx control provides a powerful way to add real-time logic to control stimulus 

parameters based on input from multi-channel digital inputs. It comes with a light IDE (Integrated 

Development Environment) for source code editing and debugging. It supports the standard 

VBScript language as well as extended functions providing screen output, flow control and access 

to OpenEx data target or other controls. Only one script control can be added to a single 

OpenController file. 

The script control provides an editor for source code editing, line numbering, and syntax 

highlighting. The tool buttons on top of the editor provide two groups of functions: standard file 

operations and debugging operations. Standard file operations include creating new scripts, 

opening and saving a script files. Debugging operations include running, stopping, debugging and 

stepping through a script, adding and removing breakpoints, and opening the variable watch 

dialog. 
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Creating a VBScriptEx Control 

To quickly create a VBScriptEx control: 

1. Click the Controls menu, point to Tables/Scripting, and click VBScriptEx. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

 

 

3. Double-click the grey area at the top of the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 
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Settings groups include: 

Common - pg. 187 

Target(s) - pg. 193 

Caption/Border - pg. 

164 

Behavior - pg. 173 

 

4. If needed, type the desired Caption Text. This will appear in the upper left corner of the 

control component. 

5. If needed, select from these checkbox options for additional setting configurations. 

 

Auto Caption: when the Auto Caption check box is selected, a caption will be 

automatically generated and applied to the control. The auto caption is based on the target 

value. Clear the Auto Caption check box to use a caption defined in the Caption Text 

box. 

 

Hidden when running: when the controls are run the editor will be hidden from view. 

6. Click OK. 

Click in the editing area of the control and begin typing to write the script. 

Writing VBScriptEx control scripts 

The script control supports the standard VB Script language and TDTs extended functions. 

Extended functions add screen output and system flow controls to the VB Script language, and 

provide access to data targets by the simple read and write commands.  

There are three types of data targets: 

Device Targets 

The script control can communicate with devices running on the server. The server loads multiple 

devices (RPco circuits saved in compiled circuit files) generated by RPvdsEx. Each RPco device 

contains tags for data input and output. The script performs stimulus control by communicating 

with these tags. To specify a device target, use the format DeviceName.TagName. For example, to 

access the "Frequency" tag in the device RP(2), use RP(2).Frequency. 

Control Targets 

The script control can also communicate with other controls within the same OpenController file. 

A script can write a value to other controls, such as a value watch control to display it, or change 

the caption text of the control. To specify a control target, use the control name and the property 

name in the format >ControlName.PropertyName.  

For example, to write to the Value property of a value watch named Watch, use: 

>Watch.Value 
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Default Control Target 

When the script control is used to communicate with other controls within the same 

OpenController file it can also use the default control target. This is a subset of the control target 

using the default target value. Some controls have default target values such as the value watch's 

Value property. The default value comes into play if no value is specified.  

For example:  

>Watch  

is equivalent to: 

>Watch.Value 

The following table lists a description of extended functions: 

Prototype (case insensitive) Returns Description 

Clear() Void Clears the text from the Immediate tab. 

Print_(String text) 

 

 

Void Outputs the value of an expression to the 

Immediate tab. 

Example: 

Dim nVal, sValn 

nVal = 1 

sVal = "Hello " 

Print_(nVal+1) 

Print_(sVal & "World") 

Output: 

2Hello World 

Println(String text) Void Outputs the value of an expression followed by a 

new line to the Immediate tab. 

Example: 

Dim nVal, sValn 

nVal = 1 

sVal = "Hello " 

Println(nVal+1) 

Println(sVal & "World") 

Output: 

2 

Hello World 

Quit() Void Halts execution of the VB Script. 
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Sleep(int msec) Void Suspends the execution for a specified amount of 

time in milliseconds. 

Example: 

Sleep(1000)  'sleep for 1 second 

Read(String target) Variant: value Read a value from a target. 

Example: 

Dim target_dev, target_ctrl, val 

target_dev = "MyDevice.frequency" 

val = Read(target_dev)            

Print_(val) 

target_ctrl = ">knob.Value" 

Print_(Read(target_ctrl)) 

Write_(String target, variant or 

constant) 

 

 

True: 

successful 

False: failed 

Write a value to a target. 

Example: 

Dim target_dev, target_ctrl, val 

target_dev = "MyDevice.frequency" 

Write_(target_dev, val) 

target_ctrl = ">knob.Value" 

Write_(target_ctrl, val) 

GetSystemMode() Long Returns a long that specifies the devices current 

mode: 

0 = Idle 

1 = Standby 

2 = Preview 

3 = Run 

SetSystemMode(int 

newMode) 

True: 

successful 

False: failed 

Sets the devices current mode where newMode is: 

0 = Idle 

1 = Standby 

2 = Preview 

3 = Run 

IssueTrg(long TrgID, long 

TrgMode) 

Note: TrgID corresponds to 

Software trigger 1 – 10. 

Long 

 

At this time, 

IssueTrg 

always returns 

a -1 

Issues Software trigger 1 –10 on all active devices 

connected to the zBUS. The parameter TrgMode 

is reserved at this time and should be set to 0. 

Example: 

IssueTrg(1,0) 
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Running VBScriptEx Control Scripts  

The VBScriptEx control can run only one script at a time. However, multiple OpenController 

applications can be running at the same time with each containing a script control. The script 

control can be run in either hidden or non-hidden mode. 

Hidden when running: the editor will be hidden from view. This mode is normally used when 

the script directs the output to other controls. To run a script, click the Run button on the title tool 

bar. To stop, click the Stop button on the title tool bar. 

Both the compilation and runtime errors are reported. The location of the error is highlighted 

during runtime. Error free VBScript will run automatically whenever the OpenController file is set 

to run. 

Debugging VBScriptEx Control Scripts 

The Interactive mode triggers the script debugger and provides some useful debugging tools.  

Debugging can be performed using the debugging tool buttons, the associated accelerate keys, or 

by right-clicking anywhere on the IDE and selecting the corresponding command from the dialog 

pop-up menu: 

 
Browse Object: Allows you to browse the library’s object list including methods, 

and their parameters/return types. 

 
Start/Resume (F5): runs the script to completion or resumes a paused script. 

 
Pause (Esc): pauses the execution of the script. 

 
End: stops the execution of the script. 

 
Toggle Break (F9): inserts or removes a breakpoint on the line where the cursor is 

positioned. If a breakpoint is inserted on a non-executable statement, the debugger 

will step to the first available executable statement after the breakpoint. 

 
Evaluate Expression (Shift + F9): Shows the value of the cursors currently 

selected expression in the Immediate messages dialog window. 

 
Show Current Statement: Returns the cursor to the currently highlighted line while 

the execution is paused. 

 
Step Into (F8): Execute the current line. If the current line is a subroutine or 

function call, stop on the first line of that subroutine or function. (If the script is not 

active, start it) 

 
Step Over (Shift + F8): Execute to the next line. If the current line is a subroutine 

or function call, execute that subroutine or function completely. 

 
Step Out (Ctrl + F8): steps out of the current subroutine or function. 
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The focus must be on the script control to make the accelerate keys (F5, F8, and F9) function. The 

focus will be lost from the script control when the window area outside the script control is 

clicked. Click the control to set focus on the script control. 

Biquad Coefficient Generators 

About Biquad Coefficient Generators 

The System 3 platform relies primarily on digital filtering, with filters implemented through 

RPvdsEx components within the compiled circuit file. Biquad filters, inherently more stable than 

other IIR filters, are the filter of choice for many OpenEx applications. Their superior stability 

allows users to change filter coefficients on the fly, making them ideal for the OpenEx 

environment.  

The Biquad Coefficient Generator control is one of two ways OpenEx users can modify the 

coefficients of the Biquad filter: 

Note: Filtering macros are available and offer cascaded highpass and lowpass filter sections with 

selectable order and dynamic filter coefficient updating for single and multichannel signals. TDT 

recommends using macros whenever possible. 

➢ Within RPvdsEx there are several components that can be used to generate filter 

coefficients: ButCoef1 (generates Butterworth coefficients for a first order Biquad), 

ButCoef (generates Butterworth coefficients for an n P

th
P-order Biquad), and ParCoef 

(generates a parametric coefficient (equalizer filter) for a first order Biquad). The 

parameters of these components may be controlled from within the circuit or from an 

OpenEx control.  

➢ Within OpenController, Biquad Coefficient Generators generate n P

th
P order Biquad 

coefficients and allow users to set the filter properties of the Biquad (Lowpass, Highpass, 

Bandpass, or Notch). The order of the Biquad filter, or number of Biquads, is 

automatically detected and the correct number of coefficients is generated. 

There are advantages and disadvantages to both methods. Using RPvdsEx components to generate 

the coefficients allows users to control the filtering properties independent of the Microsoft 

Windows operating environment. If precise timing of the filter changes is required then this would 

be the best choice.  

The advantage of generating them through OpenController is two fold. First, you decrease the 

number of components used in the circuit. If the number of components is a limiting factor, this 

can generate a substantial savings in components. Second, removing the coefficient generators 

decreases the cycle usage of the system. In general, TDT recommends using OpenController's 

Biquad Coefficient Generators to change filter settings. However, if you require precise timing for 

these filter changes we recommend using the ButCoef, ButCoef1, or ParCoef RPvdsEx 

components. 

The examples below show the circuit constructs required to implement Biquad filtering either 

through OpenController or directly in the compiled circuit file. A Biquad filtering circuit construct 

is required for each biquad filter that will be implemented through OpenController. 
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Biquad Filtering Using OpenController 
Filter Settings Changed from OpenController 

Biquad Filtering Using ButCoef1 In RPvdsEx 
Filter Settings Changed with RPvdsEx Coefficient Generator 

In this example: 

➢ The FilterCoef parameter tag is used by OpenController to load the coefficient values for 

that filter setting to the Biquad. The FilterDelay parameter tag is used to reset the Biquad 

delay lines. 

➢ If the delay lines are not zeroed it is possible for the filters to crash. 

➢ These parameter tag names are suggested names. The parameter tags must be defined as 

the Coef Target and Delay Line Target in the control's property settings. 

Using the Biquad Coefficient Generator Control 

The control set below includes a filter coefficient generator (on the right) and a slider (on the left) 

to provide dynamic control of filter settings during the experiment. The filter type, Lowpass, 

Highpass, or Bandbass is set along with the default filter settings when the controls are created in 

OpenController. During an experiment the corner frequency (Fc) or bandwidth (BW) can be 

changed by typing a value in the appropriate box then pressing Enter or from a linked controller, 

such as the slider pictured in the following diagram. 

 

Control Set with a Biquad Coefficient Generator  

Creating a Biquad Coefficient Generator 

Two text boxes on the biquad coefficient generator control can be used to change filter settings 

during an experiment. The first is used to select the center, or corner frequency, of the filter and 

Biquad

nBIQ=1

{>Coef}

{>Delay}

[1:2,0]

FilterCoef

FilterDelay

Biquad

nBIQ=1

{>Coef}

{>Delay}

[1:2,0]

ButCoef1

Gain=1

Fc=1000

BW=100

Type=LP

[4:231,0]

Enab=Yes

FilterSetting
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the second selects the bandwidth in octaves (The bandwidth setting only works with the Notch and 

Bandpass filter types).  

The steps provided below create a biquad coefficient generator control and a slider to control the 

filter settings. This is probably the most common use of the biquad coefficient generator.  

1. Click the Controls menu, point to Advanced Controls, and click Biquad Coefficient 

Generator. 

 

The pointer changes to indicate that the control can be added. 

2. Click the grid to position the upper-left corner of the control. 

 

The control is added to the grid area. 

3. Double-click the control to display the properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 

 

Settings groups include: 

Common - pg. 174 

Target(s) - pg. 191 

Caption/Border - pg. 164 

Polling - pg. 189 

Filter Specification - pg. 165 

 

4. In the Coef Target box, enter the parameter tag associated with the >Coef line in the 

Biquad component. To select the target using the Select Target dialog, browse to 

Devices|Name|Buffers|. 

5. In the Delay Line Target box, enter the parameter tag associated with the >Delay line. 

To select the target using the Select Target dialog, browse to Devices|Name|Buffers|. 

6. In the Filter Type box, select Highpass, Lowpass, Bandpass, or Notch. 

7. If Bandpass is selected, in the BW box, specify the bandwidth of the filter in octaves. 
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8. Click OK. 

 

 

9. Add a slider to the control workspace. 

10. In the slider property settings dialog box, select the proper position parameters and 

primary target and click OK. Note: in the Select Target dialog box, the target is located in 

Control|cFilterGen-x|Filter Specification|Filter Frequency. 

At this point you should be able to control the filter settings of the Biquad from the slider. To test 

the control set, toggle to run! mode and move the slider. The filter settings should change in the Fc 

= box. 

 

Other Control Types 

About Containers 

A container can be used to simplify the process of adding and configuring multiple instances of a 

control, using a range of channels for a multichannel target. After the container has been added, 

another control (excluding advanced controls such as script, master mode, and plotting controls) 

can be dropped onto it. The container can then be used to configure a group consisting of 

multiples of the chosen control. 

 
Container with Grouped Controls 
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In this example a container has been used to configure a group of value watches, displaying the 

current RMS value for each of 16 channels. In the circuit (pictured below) an Iterate component 

has been used to simplify the circuit design. A single channel RMS component is applied to each 

of 16 channels iteratively. 

 
Iterative Circuit Segment 

Creating a Container 

To quickly create a container: 

1. Click the Controls menu, point to Advanced Controls, and click Container. 

 

The pointer changes to indicate that the container can be added. 

2. Click the grid to position the upper-left corner of the container. 

 

The container is added to the grid area. 

 

 

3. Click the Controls menu, point to Numeric Displays, and click Value Watch (or the 

desired control). 

 

The pointer changes to indicate that the container can be added. 

4. Click the container to add the control. 

5. Double-click the container to display the Setup Properties dialog box. 

 

The dialog box opens with the most commonly changed settings displayed. Related 

settings are grouped together by color. Other settings are available by clicking the 

Parameter Group box and selecting a settings group. 
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Settings groups include: 

Common - pg. 179 

Target(s) - pg. 193 

Caption/Border - pg. 164 

Polling - pg. 190 

Value Control - pg. 193 

Appearance - pg 

Appearance - pg. 169 

 

6. In the Primary Target box, click the  Browse button, to display the Select Target 

dialog box. 

7. Using the Select Target dialog browse for and select an appropriate target. 

 

 

8. Click OK, to return to the properties dialog box. 

9. In the Primary Target field, append {x} to the target name to indicate multiple channels.  

 

Note: Equations can also be used within the braces, for example:{2*x-1} will select and 

display only the odd channels. 

10. In the Caption Text field, type a label. {x} can be used to indicate the channel number. 

11. Clear the Auto Caption check box. 
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12. In the Size field, select the desired number of controls. 

 

 

13. In the Column field enter the desired number of columns. 

14. If needed, change any other properties of the control. Changes will be applied to all 

controls in the Container. The properties dialog can be accessed and settings for the 

controls with in the container can be modified at any time, including the Size and Column 

count of the container. 

15. Click OK, to complete the container group. 

Before running controls the corresponding Synapse experiment must be open and running.  

To run the controls: 

➢ Click Run! on the menu bar. 

About Graphic Frames 

A frame can be used to create a caption and border for a group of controls. After the frame has 

been added, other controls can be dragged to it. 
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Frame Grouped with Controls 

In this example a frame has been used to group a pile plot with a slider controlling the spike 

threshold and a value watch displaying the current threshold value. 

Creating a Frame 

To quickly create a frame: 

1. Click the Controls menu, point to Misc., and click Graphic Frame. 

 

The pointer changes to indicate that the frame can be added. 

2. Click the grid to position the upper-left corner of the frame. 

 

The frame is added to the grid area. 

3. Double-click the frame to display the properties dialog box. 

4. In the Caption Text box, type the desired caption. 

5. Resize the frame and drag controls to be added to the frame. 

6. Select the frame and related controls. 

7. Click the Edit menu, and click Group. 

A basic frame is created. Before running controls the corresponding Synapse experiment must be 

open and running.  

To run the controls: 

➢ Click Run! on the menu bar. 
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Linking Controls 

About Linking Controls 

Linking Controls allows controls to send data to and receive data from other controls. Data from 

modifier controls can be sent to visualization tool controls, such as status indicators or gauges. For 

example, the value sent from a Slider could be sent both to a parameter tag running on a Device 

and to a setting for a visualization tool, such as an Led Indicator. 

The Advantages of Linking 

Links provide a logical structure to groups of controls and allows users to modify the parameter 

settings of one control based on the source information of another control. For example, a user 

may want to monitor the signal output from a data channel. A modifier control such as a slider 

determines the monitor channel. This output can be sent to a Visualization control so that the 

graph shows the correct monitor channel. 

How It Works 

Controls communicate to each other through Targets. Targets are defined as primary, secondary 

(alternate), source, or data targets. 

➢ Primary Targets: change a parameter tag on the circuit or a parameter of another control 

and occur in modifier controls. A primary target sends a new value each time the system 

is polled. 

➢ Alternate Targets: are similar to primary targets. They allow users to modify multiple 

parameter tags or control parameter settings with a single control. Alternate targets are 

associated with modifier controls. An alternate target may be a parameter tag on a 

different device or a visualization control parameter setting. 

➢ Source Targets: acquire values from parameter tags, and other controls. When a value is 

acquired from a control the Value setting in the Value Control parameter group settings is 

the source. Source targets are associated with visualization controls. 

➢ Data Targets: acquire values from parameter tags and other controllers. Data targets are 

associated with visualization controls. 

Each control has a unique name. When linking controls the control name is used as a part of the 

target path for another control. The control name can be found in the control's property setting 

dialog box, in the My Name box of the Target(s) parameter group. A name will be generated 

automatically or the user can enter a name of their choice. 

Nomenclature for Controls 

> The greater than sign is used with primary or alternate targets and sends a 

value to another control parameter setting. 

< The less than sign is used with source targets or control parameter settings 

and acquires a value from another controller parameter. 

device.Target 

control.Target 

A period separates the device or control from the variable it modifies. For 

example deviceX.Filter would modify the Filter parameter tag on deviceX. 

controlX.Target Channel would modify the Target Channel parameter 

setting in the Target parameter group for controlX. 
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* The asterisk is a wild card designator that can be added to device names or 

parameters. For example, if a compiled circuit file is mirrored (that is, the 

same compiled circuit file is loaded onto multiple devices and the devices 

are named in standard form such as acq1, acq2, ...) then the designation 

acq*.Filter would modify the Filter parameter tag on all Devices whose 

names begin with acq. 

 

Control Settings Reference 

About the Control Settings Reference 

In the Control Settings Reference, each topic corresponds to a parameter group in the properties 

dialog box. Many settings are self explanatory, all other settings are explained here. 

How Topics Are Arranged 

Some settings, such as the settings in the Captions/Borders parameter group, are the same for each 

control that includes these settings. Other settings vary by control. When settings in a parameter 

group vary by control, the topics for each control type have been arranged in a folder for that 

parameter group. Within each folder topics are arranged alphabetically. 

How To Find These Settings 

Settings in this reference are available in the properties dialog boxes. 

To open the properties dialog box for a control: 

➢ Double-click the control in the grid area of OpenController's Design mode. 

Caption/Border Parameter Group 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box must also be selected. 

Caption Align: Select an alignment for the control title. 

Caption Color: Select a color for the caption from a color palette. 

Caption Visible: Select the check box to set the control title area to be visible. Clear the check 

box to hide the control title area. 

Caption Bevel Visible: Select the check box to give the control title area a beveled appearance. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. 

Border Style: Select an appearance style for the border. 

Border Color: Select a color for the border from a color palette. 
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Channel Selector Parameter Group 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot. 

Channel Selector Positions: Enter the number of positions to appear on the channel selector. 

Channel Selector Offset: Enter the number to offset the position values. For example, enter 2 to 

begin position values with channel 3.  

Colors Parameter Group 

Category Coloring: Set how the trace colors will be applied. 

➢ None: The color set in the Trace Color value box will be applied to all traces. 

➢ By Channel: The color of traces will be automatically assigned by channel. 

➢ By Sortcode: The color of traces will be automatically assigned by sortcode. 

Trace (or Dot) Color: Select the trace (or dot) color from a color palette. This selected color is 

only used if Category Coloring is set to None. 

Data/Source Setup Parameter Group 

The settings in this parameter group are automatically set when the Data target is a Store. The 

settings should only be modified when the Data Target is a buffer read directly from a hardware 

device (not a Store). 

Shared Sync: Enabled when a Store acquires data from multiple channels/sources. A sync 

indicates the position of data in a buffer or when a change in data has occurred (these usually 

generate a logical high).  

Plotting Mode: Choices include Tracked and Static. The Plotting Mode affects how plot data is 

updated. When Tracked is selected new data is displayed only when changes occur in Synapse. 

Static displays data based on the polling rate of the control without regard to whether new data has 

been acquired. 

Filter Specification Parameter Group 

Filter Frequency: This setting always reflects the current filter value and can be used as the target 

of another control, allowing the filter frequency to be modified by another control, such as a slider. 

Default Filter Frequency: Enter the default filter frequency to be used if the initialize mode is 

Init On Run or Init On Load.  

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Filter Type: Select the filter type from a drop down list. Choices are: Lowpass, Highpass, 

Bandpass, and Notch. 

Bandwidth: Select the bandwidth of the filter in octaves. This setting is used only if the Filter 

Type is set to Bandpass. 
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Filtering Parameter Group 

Filter On: Select the check box to enable a filter algorithm using FIR parameters provided in 

CoefB0-B4. Clear the check box to disable the filter. 

CoefB0-4: Type a coefficient.  

Multi View Parameter Group 

Multi View Enabled: Select the check box to view each channel, or sort code, of data in an 

individual plot. 

Num Views: Set the number of channels or sorts to view in a multi-view plot. If data contains 

more than 16 channels or sorts the value must be increased to show all data. 

Num Columns: Set the number of columns in which multi-view plots are arranged. 

View By: Channel or Sort Code. Sort Codes are generated in the RPvdsEx circuit. 

View Index Offset: Starting channel or sort is the View Index Offset value +1. 

For example: To begin viewing data with channel 3, set the View Index Offset value at 2. 

Show View Index: Index is Channel or Sort Code and is determined by the View By value. 

Pointer Parameter Group 

Pointer Style: Select the pointer style from a drop down list. Choices are: Arrow-Line, Arrow, 

Line, and Triangle. 

Pointer Color: Select the pointer color from a color palette. 

Pointer Size: Enter the desired size of the pointer in pixels. 

Pointer Margin: Enter the desired size of the margin between the tip of the pointer and the arc 

(that is, the tick marks along the arc). 

Hub Visible: Select the check box to display a hub, or pinion point marker, at the base of the 

pointer. If the Hub Visible check box is be selected, the hub Size can be specified. 

Hub Size: Enter the desired size of the hub in pixels.  

Hub Color: Select the desired color for the hub from a color palette. 

Refresh Control Parameter Group 

Refresh Period: Set a time value for the refresh period in seconds. 

Scaling Parameter Group 

X-Axis Range: The range of the x-axis. 

Y-Axis Symmetry: Select the check box to ensure that a symmetrical Y-axis range will be 

displayed. This is ideal for signals that are expected to be symmetrical. 

Auto Scale: The plot can be set to automatically scale during animation to ensure that the data can 

always be viewed in a convenient scale. 
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➢ None: Auto Scale is turned off. 

➢ Active: The scale of the plot is automatically adjusted to ensure all values can be shown 

on the plot. 

➢ Smart: The scale of the plot is automatically adjusted to ensure values can be shown on 

the plot only during the first 3 seconds. 

Up-Scale Hist.: When Auto Scale is used, this value sets the number of points above the Y-axis 

range that the signal must reach before scaling will occur. 

Down-Scale Hist.: When Auto Scale is used, this value sets the number of points below half of 

the Y-axis range a signal must fall before scaling will occur. 

SigGen Specs Parameter Group 

SigGen File: Select the SigGen file to use with the SigGen control. 

Maximum SGI: Enter the desired maximum SGI. 

Minimum SGI: Enter the desired minimum SGI.  

Switch Positions Parameter Group 

Position Labels: Enter the labels to appear for each switch position, separated by a comma. 

Position Values: Enter the value for each switch position, separated by a comma. 

Key Arrow Step Size: Enter the number of positions to move when pressing the UP ARROW or 

DOWN ARROW keys on the keyboard. 

Key Page Step Size: Enter the number of positions to move when pressing the PAGE UP or 

PAGE DOWN keys on the keyboard.  

Sections Parameter Group 

Section Count: Enter the desired number of section for the arc. Up to five sections can be defined 

and distinguished by color.  

Section Color n, (n=1-5): Select a color for the first section. If the Section Count equals n, then 

the Section Color n will be applied to the entire arc. If the Section Count is greater than n then 

Section End n must be defined before the color can be applied. 

Section End x, (1-4): Enter the value in degrees for the x section's end point along the arc. The 

Section Count must be greater than or equal to x.   

Setup Default Properties Parameter Group 

Grid Size: Select the number of pixels for each square in the design grid. 

Page Color: Select the design page color. 

Save/Load State: Specify the behavior for saving and loading controller states. 

Multiple Files: Check to enable multiple controller state file saving and loading. 

Auto Run on Load: Check to force controller into Run! Mode on load. 

Default Server Name: Specify the default server name for the current controller file. 
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Master Channel: Specify the master channel. 

Master SortCode: Not yet implemented. 

Master Device: Not yet implemented. 

Appearance Parameter Group 

7 Segment Display Appearance Parameters 

LED Color: Select a color for the segments of the numeric display from a color palette. 

Background Color: Select a color for the background of the numeric display from a color palette. 

Show Off Segments: Select the check box to display shadow images of segments that are not in 

use.  

  

Show Off Segments check box selected. Show Off Segments check box 
cleared.  

Input Box Appearance Parameters 

Alignment: Select an alignment type for value and units text to determine the position of text 

within the control's display window. Choices are Center, Left, and Right. 

Font Color: Select a color value and units text from a color palette. 

Background Color: Select a background color from a color palette. 

Max Length: Type a value to set the maximum number of characters that can be input. 

Units Text: Enter the unit’s text to be added to the display. 

Undo On Error: When the check box is selected the control will automatically clear input errors. 

Knob Appearance Parameters 

Knob Style: Select a knob style. Choices are Raised Edge, Raised, Sunken, and Sunken Edge. 

Edge Width: Select a value to adjust the edge width. 

Indicator Style: Select an indicator style. Choices are Dot Lowered, Dot Raised, Dot, Line 

Center, Line Custom, and Triangle. 

Indicator Size: Select a value to adjust the Indicator size. 

Indicator Margin: Select a value to adjust the Indicator margin. 

Led Caption/Indicator Appearance Parameters 

Led Color: Select a color for the led from a color palette. 

Led Bevel Style: Select a bevel style to control the three dimensional appearance of the control. 

Choices are None, Raised, and Lowered. 
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Threshold: Type the threshold. If the value change is greater than the threshold, the indicator will 

be toggled off or on.  

Plots/Graphs Appearance Parameters 

Plot Title: Type a title for the plot. 

Plot Auto Title: When the check box is selected the plot will have an auto generated plot title. 

Plot Title Position: Select a position for the plot title. 

Plot Line Width: Select a numerical value for the plot line width. 

Plot Font Size: Select a numerical value for the plot font size. 

Show MultiChannel Grid: When the check box is selected the plot will display lines separating 

channels when the multi channel view option is enabled. 

Highlight Top Trace: When the check box is selected the plot will highlight the most recent 

event displayed. 

Plot Type: Select between line and dotted plot types. 

Setup Appearance Parameters 

Grid Size: Select the number of pixels for each square in the design grid. 

Page Color: Select the design page color. 

Grid Color: Select the grid color. 

Highlight Color: Select the color used for highlighting. 

Slider Appearance Parameters 

Orientation: Select the orientation off the slider movement. Choices are Vertical and Horizontal. 

Ends Margin: Select a value to adjust the margins from the top and bottom ends of the control. 

Pointer Style: Select the display style of the slider pointer. Choices are Led, Pointer, Bar, and 

Light Bar. 

Pointer Height: Select a value to adjust the pointer height. 

Pointer Width: Select a value to adjust the pointer width. 

Pointer Color: Select a color value from a color palette for the pointer. 

Track Style: Select display styles for the slide switch track. Choices are Box, Line, Bevel Raised, 

and Bevel Lowered. 

Major Tick Style: Select a style for the major tick. Choices are None, Raised, and Lowered. 

Minor Tick Style: Select a style for the minor tick. Choices are None, Raised, and Lowered. 

Major Tick Length: Select a value for the major tick length. 

Minor Tick Length: Select a value for the minor tick length. 

Tick Margin: Type a value to adjust the tick margin left or right. 

Slide Switch Appearance Parameters 

Pointer Style: Select display types for the slide switch pointer. Choices are Led, Pointer, Bar, 

Light Bar. 
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Pointer Led Color: Select a color value from a color palette for the pointer led. 

Pointer Height: Select a value to adjust the pointer height. 

Pointer Width: Select a value to adjust the pointer width. 

Track Style: Select display styles for the slide switch track. Choices are Box, Line, Bevel Raised, 

Bevel Lowered. 

Indicators Visible: When the check box is selected indicators on the slide switch are visible. 

Indicator Size: Select a value to adjust the Indicator size. 

Indicator Color: Select a color value from a color palette for the Indicator color. 

Switch/Momentary Button Appearance Parameters 

Button Text Font Color: Select a color value for the button text from a color palette. 

Auto Led Size: When the check box is selected the button’s LED graphic will adjust to the size of 

the button. 

Button Text: Type text for the button display name. 

Button Text Alignment: Select an alignment type for text to determine the position of the button 

text. Choices are Top and Bottom. 

Button Text Margin: Select a value to adjust the button text margin. 

Indicator Alignment: Select an alignment type for the LED indicator to determine its position. 

Choices are Top and Bottom, Left, Top, and Right 

Indicator Height: Select a value to adjust the LED indicator height. 

Indicator Margin: Select a value to adjust the LED indicator margin. 

Indicator Width: Select a value to adjust the LED indicator width. 

Value Watch Appearance Parameters 

Font Color: Select a color value for the font from a color palette. 

Background Color: Select a background color from a color palette. 

Units Text: Enter the unit’s text to be added to the display. 

Text Alignment: Select an alignment type for value and units text to determine the position of 

text within the control's display window. Choices are Center, Left, and Right. 

Inner Border Style: Select a bevel style to control the three dimensional appearance of interior 

borders of the control. Choices are None, Raised, and Lowered. 

Precision: Enter the number of digits to be displayed after the decimal point. The precision value 

should be less than the Number Digits value to display the desired precision.  

Behavior Parameter Group 

Chart Plot Behavior Parameters 

Time Span: Set the time range, in seconds and according to the time stamp, to be displayed on the 

X-axis.  



OpenController Reference 

171 

Data Table Behavior Parameters 

Ordering Scheme: Select an ordering scheme. Choices are Manual, Sequential, Random, and 

Sync Tag. 

➢ Manual: ordering controlled by clicking row numbers. 

➢ Sequential: if no rows are selected then all rows will be sent sequentially. If rows are 

selected then, selected rows will be sent sequentially. 

➢ Random: if no rows are selected then all rows will be sent randomly. If rows are selected 

then, selected rows will be sent randomly until all selected rows and repeats are done. 

➢ Sync Tag: the value of the synchronization target controls which row is sent. For 

example, if the sync tag equals one then the first data row (row six) will be sent. 

Synchronization Type: Select a synchronization type. Choices are None, On Tag Change, and 

On Tag True. 

➢ None: no synchronization, rows are sent one after another till done 

➢ On Tag Change: the table will be synchronized with the synchronization target and 

values are sent whenever the synchronization target changes. 

➢ On Tag True: the table will be synchronized with the synchronization target and values 

will be sent whenever the synchronization target value equals true. 

Synchronization Target: Select a target to which the data table will be synchronized. Click the 

 Browse button to open the Select Target dialog box. 

Stop Controller: When the check box is selected the control set will be stopped when all table 

entries have been sent.  

Feature Plot Behavior Parameters 

Cloud Points: Set the minimum number of points to display. The maximum number of cloud 

points will be twice the value set. The plot will refresh when the maximum number is reached. 

X-Axis Feature: Select from a drop down list. Choices are Total Amplitude, Peak 1, Peak 2, Peak 

to Peak Time, and Area. 

Y-Axis Feature: Select from a drop down list. Choices are Total Amplitude, Peak 1, Peak 2, Peak 

to Peak Time, and Area. 

Input Box Behavior Parameters 

Precision: Enter the number of digits displayed after the decimal point in the numeric display. 

Value Max: Enter the desired maximum value. If the actual input value is greater than the defined 

maximum, the maximum value will be used. 

Value Min: Enter the desired minimum value. If the actual input value is less than the defined 

minimum, the minimum value will be used.  

Master Mode Behavior Parameters 

Mode on Run: Select the Synapse Mode to enable when the OpenController settings in window 

containing this control are Run. Choices are None, Standby, Preview, and Run. 

Mode on Stop: Select the Synapse Mode to enable when the OpenController settings in window 

containing this control are set to Stop. Choices are None, Idle, and Standby. 
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Delay to run (secs): Enter a value in seconds to delay implementation of Mode on Run setting. 

Delay to stop (secs): Enter a value in seconds to delay implementation of Mode on Stop setting.  

Momentary Button Behavior Parameters 

Value when On: Type value when on. 

Value when Off: Type value when off.  

Value in milliseconds for On time: Type the length of time for the control to stay on when 

clicked. 

Scope/Pile Plot Behavior Parameters 

Pile Depth: Set the number of traces that will be displayed. Set the Pile Depth to 1 to create a 

scope plot. 

Scrolling Plot Behavior Parameters 

Scroll Sections: Set the number of sections to display before scrolling. 

Scrolling Threshold Behavior Parameters  

Threshold Target: The threshold target is used to set the lower threshold for the ae~1parameter 

tag attached to a spike sorting component.  

Threshold Scaling Factor: Enter a voltage value to scale the threshold target to match the voltage 

range of the signal being sent to the spike sorting component. This is usually the inverse of the 

"scale factor" parameter in a PlotDec16, CompTo16, or CompTo8 RPvdsEx component that was 

used to compress the data before display. For example: If the scale factor of a PlotDec16 is set to 

10P

6
P to convert it to microvolts, then the Threshold Scaling Factor should be set to 10 P

6
P. If the scale 

factor of a CompTo16 is set to 32767, then the Threshold Scaling Factor should be set to 

3.052X10P

-5
P. 

Sort/Thresh Mark Persistence: Select Dynamic or Saved to determine if the threshold is saved 

when the control is stopped. Select dynamic to update the threshold each time the control is run. 

Select Saved to use the fixed threshold until Auto-Threshold is run or the scaling is changed 

manually. 

Auto-Threshold S/N Factor: Select a choice from the drop down menu to determine the signal to 

noise factor that will be used to set the threshold when the auto-threshold feature is used. Auto sets 

the threshold based on any spike activity that is above the noise floor. Even if no spikes occur the 

control will calculate a threshold that will acquire some signals above the threshold. 2-1 through 

5-1 selects a fixed ratio that generates a threshold that is x times greater then the noise floor. 

Auto-Threshold Effort: Select low, medium, or high to determine how large a data block will be 

acquired before the threshold is calculated. High uses the largest block (taking the longest time) 

and small uses the smallest block (to calculate the threshold the quickest). 

Auto-Threshold Polarity: Select Either, Positive Only, or Negative Only to determine if the 

threshold will look for positive going signals, negative signals, or signals in either direction. A 

fixed polarity can be use to separate different waveforms. 

Scroll Sections: Selects the number of scroll sections to display. 

Setup Behavior Parameters 

Save/Load State: Specify the behavior for saving and loading controller states. 
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Multiple Files: Check to enable multiple controller state file saving and loading. 

Auto Run on Load: Check to force controller into Run! Mode on load. 

Disable Run Button: Check to disable the Run button. 

Disable Stop Button: Check to disable the Stop button. 

Default Server Name: Specify the default server name for the current controller file. 

Lock on Stop: Check to lock controller when the stop button is pressed. 

Slider Behavior Parameters 

Key Arrow Step Size: Enter a step size for slider movements when using the arrow keys on the 

keyboard to control the slider. 

Key Page Step Size: Enter a step size for slider movements when using the Page Up and Page 

Down keys on the keyboard to control the slider. 

Snippet Sort Behavior Parameters 

Sort/Thresh Mark Persistence: Select Dynamic or Saved to determine if the threshold and sort 

values are saved when the control is stopped. Select dynamic to reset the threshold and sort values 

each time the control is run. Select Saved to retain the settings until the settings are changed 

manually or using the auto-sort feature. 

Training Sample Size: Enter a value to determine the maximum number of samples used to sort 

spikes. Using more spikes (an increased sample size) allows individual units to be separated more 

effectively and rare units are more likely to be detected. However, if unit activity is low using a 

large sample size can take an inordinately long time. 

Maximum Training Time: Enter a value in seconds to set an upper limit on the auto-sort process. 

If the training sample size is not reached in the maximum training time, the sort is based on the 

existing sample size. 

Allow Unsorted Group: Select the check box to allow unsorted spikes. 

Pile Depth: Set the number of traces that will be displayed. 

Switch Button Behavior Parameters 

Value when On: Type value when on. 

Value when Off: Type value when off.  

Shared Behavior Parameters 

Hidden When Running: When the controls are run, the editor will be hidden from view. 

   

Common Parameter Group 

7 Segment Display Common Parameters 

Server Name: Select the server name. The default value Local selects the local server.  
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Source Target: Select or type the name of the source target. When an Synapse experiment is 

open, available targets can be selected using the Select Target dialog box. Click the  Browse 

button  to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift" 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the 7 

segment display. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the source target value. Clear 

the Auto Caption check box to use a caption defined in the Caption Text box. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Led Color: Select a color for the segments of the numeric display from a color palette. 

Number Digits: Enter the number of digits to be displayed. By default, the leading unused digits 

will be displayed as spaces. The total number of digits should be sufficient to display the desired 

precision. 

Precision: Enter the number of digits to be displayed after the decimal point. The precision value 

should be less than the Number Digits value to display the desired precision. 

Biquad Coefficient Generator Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Coef Target: Select the parameter tag associated with the >Coef line in the Biquad component. 

Delay Line Target: Select the parameter tag associated with the >Delay line. 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the coef target value. Clear the 

Auto Caption check box to use a caption defined in the Caption Text box. 

Default Filter Frequency: Enter the default filter frequency to be used if the initialize mode is 

Init On Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Filter Type: Select the filter type from a drop down list. Choices are: Lowpass, Highpass, 

Bandpass, and Notch. 
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Bandwidth: Select the bandwidth of the filter in octaves. This setting is used only if the Filter 

Type is set to Bandpass. 

Chart Plot Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select the data event (Store name) to be plotted. 

Target Channel: Selects the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the Store name. Clear the check box to hide the auto caption. 

The auto caption should be hidden if no caption is desired or if a user-defined caption should be 

used. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot. By default the channel selector options include channels one through 

eight. The user can modify the number of channels or offset value in the Channel Selector 

parameter group. 

Time Span: Set the time range, in seconds and according to the time stamp, to be displayed on the 

X-axis. 

Multi View Enabled: Select the check box to view each channel, or sort code, of data in an 

individual plot. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1.  

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color 

(None), one color per channel (By Channel), or one color per sort code (By SortCode). 

Data Table Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Caption Text: Type caption text to display on the control. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Clear the check box to use a user-defined caption.  

Ordering Scheme: Select an ordering scheme. Choices are Manual, Sequential, Random, and 

Sync Tag. 

➢ Manual: ordering controlled by clicking row numbers. 

➢ Sequential: if no rows are selected then all rows will be sent sequentially. If rows are 

selected then, selected rows will be sent sequentially.  

➢ Random: if no rows are selected then all rows will be sent randomly. If rows are selected 

then, selected rows will be sent randomly until all selected rows and repeats are done. 
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➢ Sync Tag: the value of the synchronization target controls which row is sent. For 

example, if the sync tag equals one then the first data row (row six) will be sent. 

Synchronization Type: Select a synchronization type. Choices are None, On Tag Change, and 

On Tag True. 

➢ None: no synchronization, rows are sent one after another till done 

➢ On Tag Change: the table will be synchronized with the synchronization target and 

values are sent whenever the synchronization target changes. 

➢ On Tag True: the table will be synchronized with the synchronization target and values 

will be sent whenever the synchronization target value equals true. 

Synchronization Target: Select a target to which the data table will be synchronized. Click the 

 Browse button to open the Select Target dialog box. 

Feature Plot Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select the data event (Store name) to be plotted. 

Target Channel: Selects the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the Store name. Clear the check box to hide the auto caption. 

The auto caption should be hidden if no caption is desired or if a user-defined caption should be 

used. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot. By default the channel selector options include channels one through 

eight. The user can modify the number of channels or offset value in the Channel Selector 

parameter group. 

Cloud Points: Set the minimum number of points to display. The maximum number of cloud 

points will be twice the value set. The plot will refresh when the maximum number is reached. 

X-Axis Feature: Select from a drop down list. Choices are Total Amplitude, Peak 1, Peak 2, Peak 

to Peak Time, and Area. 

Y-Axis Feature: Select from a drop down list. Choices are Total Amplitude, Peak 1, Peak 2, Peak 

to Peak Time, and Area. 

Multi View Enabled: Select the check box to view each channel, or sort code, of data in an 

individual plot. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color 

(None), one color per channel (By Channel), or one color per sort code (By SortCode). 
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Input Box Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When an Synapse 

Experiment is open, available targets can be selected using the Select Target dialog box. Click the 

 Browse button  to open the Select Target dialog box. Using the Select Target dialog boxes 

ensures valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift" 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift" 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the input 

box. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. 

Initialize Value: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Units Text: Type text to be added to the value as an indication of units for the value. 

Knob Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When an Synapse 

Experiment is open, available targets can be selected using the Select Target dialog box. Click the 

 Browse button  to open the Select Target dialog box. Using the Select Target dialog boxes 

ensures valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift". 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift". 

Target Channel: Enter the channel number. 
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Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the knob. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. 

Initialize Value: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Position Display Visible: When the Position Display Visible check box is selected the current 

position value is displayed at the center of the knob. 

Scale Max: Enter the maximum value to be displayed for the knob. 

Scale Min: Enter the minimum value to be displayed for the knob. 

Label Precision: Enter the number of digits to be displayed after the decimal point for value 

labels on the knob. 

Led Caption Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select or type the name of the source target. When an Synapse Experiment is 

open, available targets can be selected using the Select Target dialog box. Click the  Browse 

button to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift". 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the led 

caption. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the source target value. Clear 

the Auto Caption check box to use a caption defined in the Caption Text box. The Caption Visible 

check box, in the Caption/Borders parameter group must also be selected. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Led Color: Select a color for the led from a color palette. 

On/Off Threshold: Type the threshold. If the value change is greater than the threshold, the 

indicator will be toggled off or on. 
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Led Indicator Common Parameters  

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select or type the name of the source target. When an Synapse experiment is 

open, available targets can be selected using the Select Target dialog box. Click the  Browse 

button  to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift". 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used.  

The Caption Visible check box, in the Caption/Borders parameter group must also be selected. 

The Caption Visible check box is selected by default for the led indicator. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the source target value. Clear 

the Auto Caption check box to use a caption defined in the Caption Text box. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Led Color: Select a color for the led from a color palette. 

On/Off Threshold: Type the threshold. If the value change is greater than the threshold, the 

indicator will be toggled off or on.  

Linear Gauge Common Parameters  

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select or type the name of the source target. When an Synapse experiment is 

open, available targets can be selected using the Select Target dialog box. Click the  Browse 

button  to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift". 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the linear 

gauge. 
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Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the source target value. Clear 

the Auto Caption check box to use a caption defined in the Caption Text box. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Arc Start: Enter the position in degrees for the starting position of the arc display. 

Arc Range: Enter the range in degrees for the arc display. For example: 90 degrees for a quarter 

circle arc. 

Scale Minimum: Enter the minimum value for gauge values that will be displayed. 

Scale Maximum: Enter the maximum value for gauge values that will be displayed. 

Label Precision: Enter the number of digits to be displayed after the decimal point for value 

labels found on the control. 

Logarithmic Gauge Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select or type the name of the source target. When a Synapse experiment is open, 

available targets can be selected using the Select Target dialog box. Click the  Browse button  

to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift". 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the 

logarithmic gauge. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the source target value. Clear 

the Auto Caption check box to use a caption defined in the Caption Text box. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Arc Start: Enter the position in degrees for the starting position of the arc display. 

Arc Range: Enter the range in degrees for the arc display. For example: 90 degrees for a quarter 

circle arc. 

Scale Minimum: Enter the minimum value for gauge values that will be displayed. 

Scale Maximum: Enter the maximum value for gauge values that will be displayed. 

Tick Label Precision: Enter the number of digits to be displayed after the decimal point for value 

labels found on the control. 
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Master Mode Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Caption Text: Type text for a caption if desired. The Caption Visible check box, in the 

Caption/Borders parameter group must also be selected. The Caption Visible check box is selected 

by default for the Master Mode Control. 

Mode on Run: Select the Synapse Mode to enable when the OpenController settings in window 

containing this control are Run. Choices are None, Standby, Preview, and Run. 

Mode on Stop: Select the Synapse Mode to enable when the OpenController settings in window 

containing this control are set to Stop. Choice are None, Idle, and Standby. 

Delay to run (secs): Enter a value in seconds to delay implementation of Mode on Run setting. 

Delay to stop (secs): Enter a value in seconds to delay implementation of Mode on Stop setting.  

Momentary Button Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When an Synapse 

experiment is open, available targets can be selected using the Select Target dialog box. Click the 

Browse button to open the Select Target dialog box. Using the Select Target dialog boxes ensures 

valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift" . 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift". 

Target Channel: Enter the channel number.  

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. The Caption Visible check 

box, in the Caption/Borders parameter group must also be selected. 

Initialize Value: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Button Text: Type text to be displayed on the button. 

Value when On: Type value when on. 

Value when Off: Type value when off. 

Value in milliseconds for On time: Type the length of time for the control to stay on when 

clicked. 
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Scope/Pile Plot Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Data Target: Select the data event (Store name) to be plotted. 

Target Channel: Selects the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the Store name. Clear the check box to hide the auto caption. 

The auto caption should be hidden if no caption is desired or if a user-defined caption should be 

used. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot. By default the channel selector options include channels one through 

eight. The user can modify the number of channels or offset value in the Channel Selector 

parameter group. 

Pile Depth: Set the number of traces that will be displayed. Set the Pile Depth to 1 to create a 

scope plot. 

Multi View Enabled: Select the check box to view each channel, or sort code, of data in an 

individual plot. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. 

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color 

(None), one color per channel (By Channel), or one color per sort code (By SortCode). 

Scrolling Plot Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Data Target: Select the data event (Store name) to be plotted. 

Target Channel: Selects the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the Store name. Clear the check box to hide the auto caption. 

The auto caption should be hidden if no caption is desired or if a user-defined caption should be 

used. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot.  
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By default the channel selector options include channels one through eight. The user can modify 

the number of channels or offset value in the Channel Selector parameter group. 

Scroll Sections: Selects the number of scroll sections to display. 

Multi View Enabled: Select the check box to view each channel, or sort code, of data in an 

individual plot. 

Num Views: Select the number of channels or sort codes to view. By default, channels will be 

displayed beginning with channel 1. 

Num Columns: Select the number of columns to display. Leave this value set to 1 to see one 

channel per row.  

Scrolling Threshold Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Data Target: Select the data event (Store name) to be plotted. 

Target Channel: Selects the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the Store name. Clear the check box to hide the auto caption. 

The auto caption should be hidden if no caption is desired or if a user-defined caption should be 

used. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Threshold Target: The threshold target takes the threshold based on the scroll plot (which is 

usually a plot decimated signal). The output value is then sent to the threshold low parameter tag 

(ae~1). 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot. By default the channel selector options include channels one through 

eight. The user can modify the number of channels or offset value in the Channel Selector 

parameter group. 

Auto-Threshold S/N Factor: Select a choice from the drop down menu to determine the signal to 

noise factor that will be used to set the threshold when the auto-threshold feature is used. Auto sets 

the threshold based on any spike activity that is above the noise floor. Even if no spikes occur the 

control will calculate a threshold that will acquire some signals above the threshold. 2-1 through 

5-1 selects a fixed ratio that generates a threshold that is x times greater then the noise floor. 

Auto-Threshold Effort: Select low, medium, or high to determine how large a data block will be 

acquired before the threshold is calculated. High uses the largest block (taking the longest time) 

and small uses the smallest block (to calculate the threshold the quickest). 

Auto-Threshold Polarity: Select Either, Positive Only, or Negative Only to determine if the 

threshold will look for positive going signals, negative signals, or signals in either direction. A 

fixed polarity can be use to separate different waveforms. 

Scroll Sections: Selects the number of scroll sections to display. 
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Slider Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When an Synapse 

experiment is open, available targets can be selected using the Select Target dialog box. Click the 

 Browse button  to open the Select Target dialog box. Using the Select Target dialog boxes 

ensures valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift" 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift" 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the slider. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. 

Initialize Value: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Orientation: Select an orientation from a drop down list. Choices are: Vertical or Horizontal. 

Pointer Style: Select a pointer style from a drop down list. Choices are: Led, Pointer, Bar, Light 

Bar. 

Position Max: Enter the maximum value to be displayed for the slider. 

Position Min: Enter the minimum value to be displayed for the slider. 

Tick Precision: Enter the number of digits to be displayed after the decimal point for value labels 

along the slider. 

SigGen Engine Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

SigGen Waveform Target: Select the parameter tag associated with the SigGen waveform 

buffer. 

Buffer Length Target: Select the parameter tag associated with the length of the buffer. 

Target Channel: Selects the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 
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Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the SigGen Waveform Target name.  

Clear the check box to hide the auto caption. The auto caption should be hidden if no caption is 

desired or if a user-defined caption should be used. 

SGI: This setting always reflects the current SGI value and can be used as the target of another 

control, allowing the SGI to be modified by another control, such as a slide switch. 

Initialize SGI: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

SigGen File: Select the SigGen file to use with the SigGen control. 

Slide Switch Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When an Synapse 

experiment is open, available targets can be selected using the Select Target dialog box. Click the 

 Browse button  to open the Select Target dialog box. Using the Select Target dialog boxes 

ensures valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift" 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift" 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. The Caption Visible check 

box, in the Caption/Borders parameter group must also be selected. 

Initialize Value: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Orientation: Select Vertical or Horizontal orientation. 

Position Labels: Type position labels separated by a comma. 

Position Values: Type values separated by a comma. 

Snippet Sort Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  
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Data Target: Select the data event (Store name) to be plotted. 

Target Channel: Select the channel for viewing. To view a single channel of data enter the 

desired channel number. 

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Select the check box to display an automatically generated caption for the plot. 

The auto caption is generated using the Store name. Clear the check box to hide the auto caption. 

The auto caption should be hidden if no caption is desired or if a user-defined caption should be 

used. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Channel Selector Visible: Select the check box to display a channel selector as part of the 

control. The channel selector is a slider that can be used to control which channel of data is used to 

animate a single view plot. By default the channel selector options include channels one through 

eight. The user can modify the number of channels or offset value in the Channel Selector 

parameter group. 

Training Sample Size: Enter a value to determine the maximum number of samples used to sort 

spikes using more spikes (an increased sample size) allows individual units to be separated more 

effectively and rare units are more likely to be detected. However, if unit activity is low using a 

large sample size can take an inordinately long time. 

Maximum Training Time: Enter a value in seconds to set an upper limit on the auto-sort process. 

If the training sample size is not reached in the maximum training time, the sort is based on the 

existing sample size. 

Allow Unsorted Group: Select the check box to allow unsorted spikes. 

Pile Depth: Set the number of traces that will be displayed.  

Category Coloring: Selects the trace coloring method. Traces can be seen in a single color 

(None), one color per channel (By Channel), or one color per sort code (By SortCode). 

Switch Button Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When a Synapse 

configuration is open, available targets can be selected using the Select Target dialog box. Click 

the  Browse button  to open the Select Target dialog box. Using the Select Target dialog boxes 

ensures valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift" 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift" 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. 
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Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the target value. Clear the Auto 

Caption check box to use a caption defined in the Caption Text box. The Caption Visible check 

box, in the Caption/Borders parameter group must also be selected. 

Initialize Value: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 

Button Text: Type text to be displayed on the button. 

Value when On: Type value when on. 

Value when Off: Type value when off.  

Value Watch Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select or type the name of the source target. When a Synapse experiment is open, 

available targets can be selected using the Select Target dialog box. Click the  Browse button  

to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift" 

Target Channel: Enter the channel number. 

Caption Text: Type text for a caption if desired. The Auto Caption check box must be cleared for 

the caption text to be used. The Caption Visible check box, in the Caption/Borders parameter 

group must also be selected. The Caption Visible check box is selected by default for the value 

watch. 

Auto Caption: When the Auto Caption check box is selected, a caption will be automatically 

generated and applied to the control. The auto caption is based on the source target value. Clear 

the Auto Caption check box to use a caption defined in the Caption Text box. 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Units Text: Enter the units text to be added to the display. 

Precision: Enter the number of digits that to be displayed after the decimal point. The precision 

value should be less than the Number Digits value to display the desired precision. 

Shared Common Parameters 

Server Name: Select the server name. The default value of Local selects the local server.  

Caption Text: Type caption text to display on the plot. The Auto Caption check box must be 

cleared before caption text will be used. 

Auto Caption: Not used. 

Hidden When Running: When the controls are run, the editor will be hidden from view.   
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Layout Parameter Group 

7 Segment Layout Parameters 

Number Digits: Enter the number of digits to be displayed. By default, the leading unused digits 

will be displayed as spaces. The total number of digits should be sufficient to display the desired 

precision. 

Leading Style: Select a style for leading digits. Choices are: None, Zeros, and Spaces. 

Show Sign: 

➢ Checked - show the +/- sign. 

➢ Unchecked - hide the +/- sign. 

Precision: Enter the number of digits to be displayed after the decimal point. The precision value 

should be less than the Number Digits value to display the desired precision.  

Knob Layout Parameters 

Offset-X: X offset of knob from the frame (top left). 

Offset-Y: X offset of knob from the frame (top left). 

Rotation Start: Enter a value in degrees for the starting point of the rotation. 

Rotation Max: Enter a value in degrees for the ending point of the rotation. 

Pos Display Visible: 

➢ Checked - show the current value on the knob. 

➢ Unchecked - do not show the current value on the knob. 

Pos Display Unit: Type the unit of the value controlled by the knob. Units are displayed with the 

current value. The Pos Display Visible check box must be selected. 

Pos Display Precision: Enter the number of digits to be displayed after the decimal point for the 

current value.  

Linear Gauge Layout Parameters 

Gauge Size: Enter a value for the gauge size. Auto Size must be cleared for the gauge size to be 

used. 

Auto Size: 

➢ Checked - gauge size is automatically changed with the frame size. 

➢ Unchecked - gauge size is fixed even though the frame size is changed. Gauge size 

should be set in the Gauge Size box. 

Offset-X: Enter a value for the X offset of gauge from the frame (right bottom). 

Offset-Y: Enter a value for the Y offset of gauge from the frame (right bottom). 

Inner Border Style: Select a style for the inner border. Choice include: None, Raised, and 

Lowered. 

Background Color: Select a color for the gauge background from a color palette. 

Arc Start: Enter the position in degrees for the starting position of the arc display. 
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Arc Range: Enter range in degrees for the arc display. For example: 90 degrees for a quarter 

circle arc.  

Logarithmic Gauge Layout Parameters 

Offset-X: Enter a value for the X offset of gauge from the frame (right bottom). 

Offset-Y: Enter a value for the Y offset of gauge from the frame (right bottom). 

Inner Border Style: Select a style for the inner border. Choice include: None, Raised, and 

Lowered. 

Background Color: Select a color for the gauge background from a color palette. 

Arc Start: Enter the position in degrees for the starting position of the arc display. 

Arc Range: Enter range in degrees for the arc display. For example: 90 degrees for a quarter 

circle arc. 

Slide Switch Layout Parameters 

Orientation: Select Vertical or Horizontal orientation. 

Label Position: Select Right/Bottom or Left/Top label position. If the slide switch orientation is 

vertical, Right/Bottom places the value labels at the below the slide track and Left/Top places the 

value labels below the slide track. If the orientation is horizontal, Right/Bottom places the value 

labels at the right of the slide track and Left/Top places the labels at the left of the slide track. 

 

Orientation = Vertical  

Label Position = 
Right/Bottom 

 

Orientation = Horizontal 

Label Position = Left/Top 

Polling Parameter Group 

Modifier Control Polling Parameters 

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. 

Read Back Active: Select the check box to set the control to read back the current value. If the 

control access a value that might be changed (such as another control), selecting this check boxes 

ensures that the appearance of the control reflects the current value.  
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Visualization Control Polling Parameters   

Poll Period: Enter a value in milliseconds to set the poll period. The poll period is a defined 

interval at which OpenController accesses control targets. OpenController does not directly access 

parameter tags or data Stores. Instead OpenController polls Synapse for all parameter tags and 

Stores. The more it polls Synapse the greater the load it places on both applications. 

Plot Updating: Select an updating method from a drop down list. Choices include high load, 

medium load, and low load. This setting determines how plots are updated as it relates to the 

demand on the system.  

High load places the greatest demand on the system. All data acquired since the last update is 

used to update the plot allowing you the best possible visualization but limiting the processing 

power available to the system for other tasks.  

Low load places the least demand on the system by grabbing only a subset of the data (for 

example, 3 of 10 acquired snippets) to update the plot. This leaves more processing power for 

other tasks.  

Regardless of the setting selected here, all data is retained in the tank and can be used for later 

analysis. Typically, users should select the lowest load setting that provides an adequate 

representation of the data for the user’s purposes, such as making real-time decisions and 

modifications or monitoring the experiment.  

Scale Parameter Group 

Knob Scale Parameters 

Show Labels: Show value labels for major tick mark positions. Labels can be shown even if tick 

marks are not shown. The number of labels shown is determined by the Major Ticks Count 

setting. 

Label Precision: Enter the number of digits to be displayed after the decimal point for value 

labels found on the control. 

Label Margin: Enter the number of pixels of space desired between labels and the tick arc. 

Major Ticks Count: Enter the number of major tick marks to display on the control. The Show 

Major Ticks check box must be selected before major tick marks become visible. 

Minor Ticks Count: Enter the number of minor tick marks to display between two major tick 

marks on the control. The Show Minor Ticks check box must be selected before minor tick marks 

become visible. Minor tick marks can be used even if the major tick marks are not shown. 

Key Arrow Step Size: Enter a step size for knob movements when using the arrow keys on the 

keyboard to control the knob. The step size number corresponds to control values according to the 

minimum and maximum scale settings. 

Tip: If the arrow keys do not change the knob position, try moving the knob with the mouse once. 

After the knob position has been changed once the key arrows can be used for subsequent 

movements. 

Key Page Step Size: Enter a step size for knob movements when using the Page Up and Page 

Down keys on the keyboard to control the knob. The step size number corresponds to control 

values according to the minimum and maximum scale settings. 

Tip: If the Page Up and Page Down keys do not change the knob position, try moving the knob 

with the mouse once. After the knob position has been changed once the Page Up and Page Down 

keys can be used for subsequent movements. 
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Gauge Scale Parameters 

Show Labels: Show value labels for major tick mark positions. Labels can be shown even if tick 

marks are not shown. The number of labels shown is determined by the Major Ticks Count 

setting. 

Label Precision: Enter the number of digits to be displayed after the decimal point for value 

labels found on the control. 

Label Margin: Enter the number of pixels of space desired between labels and the tick arc. 

Major Ticks Count: Enter the number of major tick marks to display on the control. The Show 

Major Ticks check box must be selected before major tick marks become visible. 

Minor Ticks Count: Enter the number of minor tick marks to display between two major tick 

marks on the control. The Show Minor Ticks check box must be selected before minor tick marks 

become visible. Minor tick marks can be used even if the major tick marks are not shown.  

Slider Scale Parameters 

Show Minor Ticks: Select the check box to show minor ticks. Minor ticks can only be shown 

when the major ticks are also shown. 

Show Tick Labels: Show value labels for major tick mark positions. Labels can be shown even if 

tick marks are not shown. The number of labels shown is determined by the Major Ticks Count 

setting. 

Tick Precision: Enter the number of digits to be displayed after the decimal point for value labels 

found on the control. 

Major Tick Count: Enter the number of major tick marks to display on the control. The Show 

Major Ticks check box must be selected before major tick marks become visible. 

Minor Tick Count: Enter the number of minor tick marks to display between two major tick 

marks on the control. The Show Major Ticks and Show Minor Ticks check boxes must be selected 

before minor tick marks become visible. 

Tick Label Margin: Enter the number of pixels of space desired between labels and the tick arc. 

Minor Tick Alignment: Select an alignment style for minor tick marks. Choices are: Inside, 

Center, and Outside. Inside positions tick marks closer to the slider bar and Outside positions tick 

marks closer the labels.  

Target Parameter Group 

Biquad Coefficient Generator Control Target Parameters  

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Repaint Target on Update: Not used. 

Server Name: Select the server name. The default value of Local selects the local server.  

Coef Target: Select the parameter tag associated with the >Coef line in the Biquad component. 

Delay Line Target: Select the parameter tag associated with the >Delay line. 

Target Channel: Enter the channel number.  
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Data Table Control Target Parameters  

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path.  

Repaint Target on Update: When the primary or alternate target is a control setting, the target 

control will be repainted (refreshed) when the value is changed. 

Server Name: Select the server name. The default value of Local selects the local server.  

Master Mode Control Target Parameters 

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Server Name: Select the server name. The default value of Local selects the local server.  

Modifier Control Target Parameters 

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Repaint Target on Update: When the primary or alternate target is a control setting, the target 

control will be repainted (refreshed) when the value is changed. 

Server Name: Select the server name. The default value of Local selects the local server.  

Primary Target: Select or type the name of the primary destination target. When an Synapse 

experiment is open, available targets can be selected using the Select Target dialog box. Click the 

 Browse button to open the Select Target dialog box. Using the Select Target dialog boxes 

ensures valid formatting of target name. 

The target should generally be the device name followed by the parameter tag (from the RPvdsEx 

circuit). This should follow the form "dddd.parTag" for device name and parameter tag. 

When linking controls together, and the target is the source, the target name will be a greater than 

symbol followed by the source control's My Name value followed by the setting name. This 

should follow the form "myname.settingname" e.g. ">FreqSlider.Value Shift" 

When the target is the destination, the target name will be a lesser than symbol followed by the 

source control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. "<FreqSlider.Value Shift" 

Alt. Target-1: Select an alternate destination target. See Primary Target above. 

Alt. Target-2: Enter an alternate destination target. See Primary Target above. 

Alt. Target-3: Enter an alternate destination target. See Primary Target above. 

Target Channel: Enter the channel number.  

Plots and Graphs Target Parameters 

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Server Name: Select the server name. The default value of Local selects the local server.  
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Data Target: Enter the Store name. 

Target Channel: Enter the channel number. 

SigGen Engine Control Target Parameters 

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Repaint Target on Update: Not used. 

Server Name: Select the server name. The default value of Local selects the local server.  

SigGen Waveform Target: Select the parameter tag associated with the SigGen waveform 

buffer. 

Buffer Length Target: Select the parameter tag associated with the length of the buffer. 

Target Channel: Enter the channel number.  

Shared Target Parameters 

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Server Name: Select the server name. The default value of Local selects the local server.  

Visualization Control Target Parameters 

My Name: A unique name for the control. A name will be automatically generated or the user can 

enter a name of their choice. When controls are linked, this value can be used as a part of the 

target path. 

Server Name: Select the server name. The default value of Local selects the local server.  

Source Target: Select or type the name of the source target. When a Synapse experiment is open, 

available targets can be selected using the Select Target dialog box. Click the  Browse button  

to open the Select Target dialog box. Using the Select Target dialog boxes ensures valid 

formatting of target name. 

The source target should be either the Store name or the device name followed by the parameter 

tag (from the RPvdsEx circuit). This should follow the form "ssss" for Store name or 

"dddd.partag" for device name and parameter tag. 

When linking controls together, the target will be a greater than symbol followed by the source 

control's My Name value followed by the setting name. This should follow the form 

"myname.settingname" e.g. ">FreqSlider.Value Shift" 

Target Channel: Enter the channel number.  

Value Control Parameter Group 

Visualization/Modifier Control Value Control Parameters 

Value: Type the target(s) value if the initialize mode is None. 

Initialize Value: Type the value to be used for initializing when the initialize mode is Init On Run 

or Init On Load. 



OpenEx Supplement for Synapse Users 

194 

Initialize Mode: Select an initialize mode to determine how the value will be initialized. 

None - sets input value to the Value. 

Init On Run - sets the input value to the Initialize Value when running. 

Init On Load - sets the input value to the Initialize Value when loading. 

Value Scale: Enter a value such that the input value = value * value scale + value shift. 

Value Shift: Enter a value such that the input value = value * value scale + value shift. 

SigGen Engine Control Value Control Parameters 

SGI: This setting always reflects the current SGI value and can be used as the target of another 

control, allowing the SGI to be modified by another control, such as a slide switch. 

Initialize SGI: Type a value to be used as an initial value if the initialize mode is set to Init On 

Run or Init On Load. 

Initialize Mode: Select a mode from the drop down list. The available choices are: None, Init On 

Run or Init On Load. 
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Glossary 

A 
1Tasynchronous:1T describes buffers or events (typically, across multiple recording channels) that are 

NOT coordinated in time. 

B 
1Tblock:1T 1. In OpenEx, a group of data labeled and stored in the tank for the purpose of analysis. 

Typically, a block contains one recording session and may contain many sweeps. There may be one or 

more blocks in each data tank. Blocks are named (automatically or by the user) and can be selected for 

display or export. 2. A specified number of data points handled as a group for downloading from, or 

uploading to, a device. Breaking data into chunks for data transfer increases the efficiency of the 

system. The block size is defined in OpenEx header components such as oxSnippet and oxStream. 

C 
1Tcircuit:1T a configuration of processing components. Each component does a set task, such as generate a 

waveform, store in memory, or send a signal to the DAC outs. Circuits are designed using RPvdsEx 

software and are run on System 3 Real-Time Processors. 

1Tclient:1T the requesting program or user in a client/server relationship. For Example, OpenScope is a 

client application that requests data from the TTank data server in the OpenEx client application. 

1Tcompiled circuit file:1T RP control object, or compiled circuit, designed for use with OpenEx or other 

TDT applications. The System 3 real-time processing modules are controlled using these files, which 

are compiled from circuits designed using TDT's RP visual design studio (RPvdsEx). Users can 

generate their own compiled circuit files for use with OpenEx or select one of the standard compiled 

circuit files provided by TDT. 

1Tconstruct:1T a group of components (in a circuit) that perform a defined task in OpenEx. For example: a 

triggered scalar construct stores single data values for later analysis. Most circuit constructs have a 

minimum or required component structure and secondary or alternate component structures. 

1Tcontinuous decimated data:1T signals that are acquired and filtered, then decimated and stored to a 

buffer. 
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D 
1TData types:1T 1. In OpenEx, standardized construct formats in which data is stored, such as snippet, 

buffer, list, stream, and scalar. 2. A description of data such as: float (32-bit floating-point value), 

integer (32-bit integer value), short (16-bit integer value), byte(8-bit integer value). 

1Tdecimated data: 1T data that has been reduced further than the sampling rate of the device for data 

storage. May refer to continuous decimated or plot decimated data. Data is decimated to reduce the 

amount of data stored to disk or being transferred from the hardware to the PC and in cases where very 

low sample rates are necessary. 

1Tdevice:1T a named group of settings which define the System 3 hardware (such as RP2, RL2, RA16, 

RXn, RZ, or RV8) or attenuators (PA5) used inan experiment and what compiled circuit files will be 

used to control the specified hardware. Also: the hardware component specified in the Device settings. 

E 
1Tepoch:1T an event (or sections of a tank block) that are associated with the tank's timeline. Epoch events 

can be scalar variables including triggered scalars, data lists, and their associated secondary tags. 

Epoch events can be used by other OpenEx applications such as OpenScope and OpenBrowser to sort 

and display tank data. 

1Tevent:1T data that is stored in the data tank, such as a scalar value, snippet waveform, or continuous 

waveform. Note: not all significant occurrences (e.g. spikes) are events. In OpenEx an event refers 

only to stored data. 

H 
1Thand shaking:1T an optional protocol where a flag (sync tag) is set to signify that data is ready for 

downloading. Often used with oxBuffer stores. 

I 
1TIdle:1T a protocol mode in which devices are not loaded and are not running. All values are cleared from 

the hardware including values set in OpenController. 

1Tindex:1T 1. The logical number of a hardware device. The zBUSmon application shows the logical 

number of all programmable devices in the workstation. Multiple devices of the same type, such as two 

RP2s, must have different index values. Devices of different types can have the same index value. 2. A 

number assigned to an RPvdsEx component within a circuit that indicates its position in the processing 

chain that is the order in which components will be executed. 

M 
1Tmaster polling rate:1T the rate at which devices are polled for new data. A high polling rate means that 

data is read more rapidly. However, a high polling rate decreases system efficiency. 

P 
1Tparameter tag:1T a specialized helper component within a circuit that allows users to modify parameter 

values through OpenEx or other software control. By utilizing these tags, users can control the 

experiment in real-time. 

1Tplot decimated data:1T a form of decimation where only the maximum and minimum values are stored 

for each chunk of data (e.g. 64 samples). Data in this format allows users to visualize the maximum 

noise floor and spike activity of an incoming signal; however, it is nota true representation of the 
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acquired signal. It is used to get an approximation for real-time plotting without requiring the transfer 

of a large amount of data. 

1TPreview:1T an Synapse mode in which data is saved to a temporary block in the tank. This mode allows 

the user to view data in OpenController or OpenScope without permanently storing data. 

1Tprotocol:1T the method used to present stimuli and/or acquire data. 

R 
1TRecord:1T a Synapse mode in which devices are loaded and running and data is saved to the tank. 

1TRPvdsEx file:1T a file that contains an uncompiled circuit, designed in a visual drag-and-drop 

environment. 

S 
1Tscalar:1T a single value, or series of values, that may be stored as data. May also be used to refer to the 

Triggered Scalar (oxScalar) data construct. 

1Tsecondary tag:1T a parameter tag that has been defined as such. By configuring a parameter tag as a 

secondary tag, data read from the tag can be saved using the construct and time stamp association with 

an existing Store. Using secondary tags simplifies circuit design by eliminating some components. 

1Tserver:1T a program that awaits and fulfills requests from client programs in the same or other 

computers. An application may function as a client with requests for services from other programs and 

also as a server of requests from other programs. For example: TTank is a server that responds to 

requests for data storage and retrieval. May also refer to the computer where a server program is 

located. 

1TStandby:1T a Synaose protocol in which devices are loaded and running but signals aren’t being 

acquired and saved to disk. This mode allows the user to modify parameter values through 

OpenController. 

1TStore:1T a named group of settings that pull together all the information needed to store data. Each store 

is associated with a data construct within the compiled circuit file running on the Store's Host Device. 

Also, the data construct used by the Store, or the data stored by the Store. 

1TSync:1T a tag that tells OpenEx when data is ready to be downloaded. May be connected to a FlipFlop 

for handshaking stores or an index value that indicates the position of the buffer and tells OpenEx how 

many points are to be downloaded to the tank or if any points at all require downloading. The 

parameter tag associated with a Sync is identified by an s prefix. 

1Tsynchronous:1T describes buffers or events that are coordinated in time, typically across multiple 

recording channels. 

T 
1Ttank:1T a group of data stored by OpenEx's TTank data server or the files used to store the group of data. 

1Ttarget:1T Points to the location of data being read or the location to which a value will be read. This 

location might be a Store, a parameter tag within a compiled circuit file running on a device, or another 

control setting. 

1Ttime stamp:1T the precise time of an event that is recorded to the tank. The precision of the time stamp 

depends upon the sample clock. Parameter tags associated with a time stamp are identified by a t 

prefix. Typically, the time values will be latched periodically when data needs to be stored. Streaming 

data (continuous) does not require time stamping. Time stamps should not be confused with the 

RPvdsEx component "TimeStamp" which is used by the RV8. 
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